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1. Introductio

Living in the Beta
DataGraph has a very active user community that doesn’t
hesitate to suggest new features and point out things that
they feel should be improved. A large part of the
development of the program has been driven by user
feedback. Additional actions and drawing methods are
constantly being added. You can download the DataGraph
beta from the web site, and stay on the bleeding edge

DataGraph is a feature rich drawing and data analysis
environment for numerical data, categorical data, and
analytic functions. The program can be used by anyone,
from a middle school student learning about graphs and
trends, to a researcher analyzing millions of data points
and creating graphs for publications

Getting Hel
DataGraph Highlight

In addition to this document, DataGraph also has an online Community that you can access from the Help menu.
DataGraph also contains many tool tips that are displayed
when then mouse hovers over a menu or eld. When you
open a le, a searchable, on-line collection of examples
opens, with over 100 les

DataGraph is designed to represent two dimensional data
sets. In addition, you can compute statistics and t data
using analytic expressions. DataGraph allows you to
combine plots, scatter plots, ts, analytic functions, bar
graphs, stock charts and box plots in the same graph. You
can attach labels, lines, add graphical elements, highlight
regions and magnify regions to point out details. All of this
is done interactively and updates automatically as you
change data or settings

This Documen
The remaining sections of this document are organized as
follows

DataGraph uses default rules to create a consistent, clean
and professional looking graph. You can adjust every
aspect of the graph and overwrite the default rules as
needed. Using color schemes and font styles, DataGraph
makes it easy to create consistent graphs and change the
look and feel of a graph with a minimal number of clicks

1.

Introduction – You’re here

2.

Overview — An overview of the structure of a
DataGraph le and information on how to navigate the
user interface

3.

Importing Data — How to get data into DataGraph
from various formats

DataGraph is not just a drawing program. It contains a
number of exploratory data analysis functions. You can
map columns by using analytic expressions to combine
columns, compute maxima, accumulate rows, etc. You can
compute statistics and t data using linear and non-linear
functions. You can compute histograms and box plots to
drill into your data set and explore patterns and trends. You
can change variables using sliders

4.

Data Table — How to organize your data and
understanding columns types.

5.

Variables — Explains each type of variable

6.

Layout Settings — Explains the commands that
control the overall layout of a graph

7.

Drawing Command Elements — Describes
commands and options that are common across
drawing commands (e.g., masking) and how to
organize commands

8.

Drawing Commands — This chapter has a section
for each drawing command, several of which have
been added

9.

Export — How to export data, graphs, and movies

Beyond DataGrap
Some things are outside scope of DataGraph, such as the
three dimensional representations of data. This does not t
into the two dimensional focus of DataGraph, and a tool
like DataTank would be better in this case. Faux 3D, such
as extruded bars or shadows, is inconsistent with the focus
on exact data representation and graph cleanliness. Use
KeyNote when this need arises

Appendix — Includes tables of functions and built-in
constants along with a short section on the command line
interface
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Click one of the new icons and a pop-up list appears with a
short description of each command. Click ‘Add’ to create
the command or click the ‘?’ on the right to open the online help for each command

What's new in Version 5.0
A primary goal for Version 5.0 was to make it easier for
new users to get started, while helping existing users to
become power users! The new example le window is a
big part of that effort. Version 5.0 also has a new look with
a new tool bar, providing quick access to all the DataGraph
drawing commands and help documents.
As always, we have many improvements based on user
requests and feedback, including a new Function Library.
We also updated the this manual with new screenshots
and more links to the on-line Community to help you make
the most of both resources. Enjoy

New Function Library.
The new version contains a new Preferences panel
featuring a Function Library. Create your own custom list
of functions that are accessible through the Fit and
Function commands, the Expression column and
Expression variable. Import/Export your function lists to
share with other DataGraph users

New Online Examples Window!
The rst change you will notice when you open
DataGraph 5.0 is a new viewer for the example les. The
les are now divided into a number of categories to make
exploring and navigating much easier. To access the
example les use File > On-line examples (or ⇧⌘N)

Open the new preferences panel using the menu bar
DataGraph > Preferences

More by Request!
Show/Hide Multiple Columns – Added an option to show/
hide multiple selected columns or groups in the table.
Faster than clicking on each box. Select the column in the
Data Table or Data List and use the Gear Menu on the
Data Table to Hide.

New Updated Toolbar!

Share Data & Notes using Excel – If you export your
data into an Excel document (File > Export Data), the
Pop-up Notes are now exported in a separate tab. For
more information, see Exporting Data

Access all the DataGraph drawing commands with two
new pop-up icons: Draw and Label.

Draw an Ellipse with the Region Command: The Region
command now has an ellipse option. For more information,
see Region command

We also reduced the number of command shortcuts on the
default toolbar. To learn how to customize the toolbar, to
add or remove command shortcuts, see Customize the
Toolbar on the Community website.

For the full release notes see:
https://community.visualdatatools.com/datagraph/articlecategories/version-5/
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2. Overview

Each le many contain one or more graphs. For some
les, images are rotate in a carousel. When you click
Open the le is downloaded to your computer and a new
Untitled le is created. When you edit that le, you do not
change original the example le.

DataGraph is a desktop application for graphing and data
analysis. A DataGraph le has the extension *.dgraph.
DataGraph les contain data and instructions for creating
one or more graphs in a single le

To the right of the Open button, the le size is provided.
For most les, these will be relatively small (<50k) but
some of the data sets examples may be much larger

Example File

Use the search bar in the top left to lter the les or nd
speci c graph types. For example, here the word ‘Spider’
is entered in the search bar. This returns examples for
Spider graphs

When you rst open DataGraph, you will see the
DataGraph Examples window. This window gives you
access to an on-line repository of les that you are free to
use and modify. These are also intended as a learning tool.
Many of the les are contain notes and links to help.
The les are organized in the following categories

•

All – Shows all the graphs in the order that they were
uploaded. The most recent graphs will always be at the
top of the list

•

Basic – This section contains basic examples. Exploring
these les is a great way to learning how to create line
plots, bar graphs, pie charts, etc

•

Analysis – These examples use commands for data
analysis and curve tting. Histograms and box plots are
also included

•

Layout – This section highlights aspects of controlling
the graph layout and style. Learn how to create multiple
axes or create panel graphs

•

Custom – This section contains more complicated
examples and custom graph types, such as ternary
graphs and polar plots

•

Data sets – The last section gives examples of analyzing
larger and more complicated data sets. Also, shows how
to connect data and perform tasks that are similar to
databases

NOTE: Similar to Spider graphs, there are many graph
types in the examples les that do not have corresponding
drawing commands. That is because the DataGraph
commands are extremely exible and can be combined to
construct a wide-array of graph types.
There are three more buttons on the window

•

Getting Started – Clicking this button will open the the
DataGraph Community web site. The site has an online version of the manual, tutorials, and a user forum.
You can also access the site the Help menu

•

Recent – This will show you a scrollable list of recently
opened DataGraph les, along with a preview of the
le. You will get the same list using File > Open recent,
where you can also clear this list.

•

New File – This opens a new, blank DataGraph le.
You can also select File > New from the menu bar

The example les window will open every time you open
DataGraph. If you don’t want to see this when you open,
deselect the ‘Open at startup’ check box in the bottom
left. To open the example les window, select File > Online examples.

fi

.


 


:


fi

fi

.


fi

:


.


 


fi

fi

 


.


fi

 


fi

 


.


fi

fi

s


.


fl

fi

fi

.


fi

fi

W	

.


fi

fi

fi

fi

.


.


fi

fi

.


fi

fi

fi

fi

3

fi

fi

fi

2. OVERVIE
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Hover the mouse over the icons or options and tool-tips
will pop-up with the description of that item.

User Interfac
You can create a new DataGraph le by selecting File >
New (⌘-N) or using the New File button on the example
le window. A new le is empty, as it contains no data or
images
There are three general sections of the interface:

•
•
•

Data Table — Left of the scree
Commands — Top right, above the canva
Drawing Canvas — Bottom righ

The Drawing Canvas is where you view and create
graphs using Drawing Commands. Everything you see in
a graph, a line, a label, or legend, is added using a
Drawing Command. An overview of the commands is
presented later in this chapter

The size of these sections can be adjusted by selecting
and dragging the sliding bars between them. The image at
the bottom of this page shows each section and the sliding
bars are highlighted with a blue line
The Data List and Data Table are discussed later in this
chapter and in the following chapter on the Data Table

Each le can contain multiple graphs and each graph will
be shown as a Thumbnail across the top of the le. Click
a thumbnail to toggle between graphs

The Layout settings are the top three sections above the
Drawing canvas. Using the options in these sections, you
can customize overall settings such as the font, image
size, and tic marks. The Layout Settings chapter explains
these entries in more detail.

The user interface has several customization options such
as separating the graph window or swapping the data and
commands. The rest of this chapter goes into more detail
or go to the on-line User Interface documentation
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STEP 3: Select the Data. Click the column header to
select the data column. When you do, you will see the
enter column get selected. This is different from a
spreadsheet where you have to select a range. Here you
chose the enter column

Toolbar Shortcuts
The toolbar contains several useful shortcuts, along with a
smaller toolbar at the top of the Data List. To illustrate,
create a simple plot. Start with a new le, File > New.
STEP 1: Add a number column. You can use Data >
Add Number Column (⌘-1) or click the icon as shown
below. This creates a corresponding object in the Data
List, where you can name the column. Just above the new
column object is an object for a built-in row counter

STEP 4: Add a Plot command. You can use Command
> Add Plot or click the Plot command short-cut in the
toolbar. This creates the plot command object and draws
the data in a graph. The command has a drop-down menu
for the x and y input. In this case, x is set to the row
number ‘#’ and y is the data column.

STEP 2: Enter data in the Data Table. Double click in
Row #1 to start editing. After entering a value, hit return to
move down the column to the next row. The row counter is
populated as you moved to each new row

Now, you can modify the command and layout settings and
see the changes you make in real time. This is just the
beginning of what you can do in DataGraph

Add Plot command

Add Number
column

Column Object
Command Object
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For example in the prior screen shot, there are three
columns de ned, ‘#’, ‘x’, ‘y’, and ‘label’. The ‘label’ column
is a text column. This is primarily used for labeling data
rows but can also be used in drawings

Data List
The data list will open and close when youclick the Data icon in the top right corner of
the toolbar. You can also toggle the list by
using View > Show/Hide De nitions or the
⌘-D shortcut

You can add additional columns by clicking on the buttons
directly above the column de nition list

The top contains objects for columns and column groups.
The bottom section contains variables. Click and drag the
bar shown below to vary the height for each section. There
is also an animation parameter for creating movies

To delete columns, you can select the column in the data
table and hit delete or select the entry in the columns
de nitions list and hit delete. You can also convert columns
between types by using the small gear menu to the right of
the name, as shown below

Click & Drag

For example, if you enter labels into a numerical column all
of the entries will be red. In this case, you should convert
the numerical column to a text column. That also gives you
different sorting options

Data Tabl

The Expression column allows you to evaluate an
expression based on the data in other columns. In this
column, you specify the expression that should be
evaluated for each row. As shown in the following example,
columns are referred to by their name. Thus, the
expression ‘x+y’ means that, for each row of the ‘mapping’
column, the entries in the x and y columns are added
together

The data can be viewed and manipulated in the data table
on the left side of the window. The rst column is simply
called # and contains the row number. This cannot be
removed but you can change its name. The x and y
columns are number columns. You can directly type values
into the Data Table. For example, if you type 4.24
DataGraph will understand it. If the number is not valid
such as 3.3.2, the entry will show up in red
When the column de nitions list is open, you see the
structure of the data table on the left of the screen. Every
column in the data table has an entry in the list. Each
column also has a speci c type, indicated by its icon.

There are several additional column types. For example,
the Date column is for calendar dates. As part of the
column de nition, you can specify what the format should
be for each date entry.
All of the column types are explained in more detail in the
following chapter, Data Table. That chapter also explains
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how to import data, edit individual cells, sort, organize and
more.

By clicking on the small disclosure triangle in the top left
corner, you reveal the remaining settings. This gives you
full control over every aspect of the graphical
representation

Drawing Command

To delete a command, you select it and hit the delete key.
You can select it by clicking on the icon, or click and drag a
selection rectangle to select multiple commands

DataGraph does not present you with a choice of
prede ned graph types but rather gives you a canvas
where you can add drawing elements and combine them.
A plot, a label, or a function curve on a graph all are listed
in the DataGraph window.
Below the axis setting is a list of the drawing commands
that specify what is drawn and how it is drawn. For
example, if you click the Plot icon in the toolbar,
DataGraph adds a plot command to the list. Once you
have selected the data it will immediately appear in the
graph. Clicking on the icon a second time will add a
second command, independent of the rst, but drawn on
the same canvas. DataGraph will adjust the ranges to t
both plots together.

There are a large number of drawing commands. The
chapter entitled Drawing Command Elements explains
aspects of the drawing commands that are common to all
of them (i.e., how to specify a mask). The Drawing
Commands chapter explains each individual drawing
command in more detail.

A drawing command refers to the data by columns. You
select columns using a pop-up menu or by dragging the
column de nition onto the drawing command.

Drawing Canva
The lower right corner shows the result from the drawing
commands. By default the size of the graph changes when
you resize the window or adjust the split views. By default
the size is set to ‘automatic’. This means that the screen
resolution is used to gure out the display scaling; thus,
when you print a graph, it will print out the same size as it
appears on the screen

You can also drag a selection from one menu to another by
holding down the command key when you click on the
menu. When you pick a different data column, or change
values in a column, the graph is updated immediately. You
can rename columns and reorder them without breaking
the connection to your graph. Columns that are invalid for
a given type of graph are listed in red. For example, text
columns cannot be used for an x/y plot. You must select a
numerical column

When you want to create graphs for publication you
typically want to specify the size of the graph exactly. This
is controlled using the canvas. If you switch the size to
‘Speci ed’, as shown here, you get two additional user
interface settings

You can adjust the drawing style, such as line width and
color, marker size and type, inside each drawing
command. Each drawing command shows the most
frequently accessed settings at the top, and they are
always visible.

One sets the size in pixels, the other controls the viewing
resolution. You can use the units in, cm or mm to specify
the size. No units means you are specifying the size in
pixels

Additional Graphs
DataGraph has a single data table, but you can have a
number of graphs in the same le. This is done by clicking
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DATAGRAPH 5.0

on the Add Graph button in the toolbar or through the
New Graph sub-menu in the File menu.

also add URL links or even paste in images or screen
shots.

When you add multiple graphs, DataGraph adds a
thumbnail for each one at the top of the screen. These can
be named as shown below.

Pop-up Note
Another option is to attach a pop-up note. To create, click
the gear menu on an object and select Add Note

Navigate between graphs using the thumbnails. The
currently selected thumbnail is shown as the graph
Click Here

All of the graphs update automatically, so when you
change the data you will see an update in the thumbnai
Pop-up notes can be attached to data columns, variables,
commands, and groups. Simply type some text in the note
and click the top left corner to close

Variable
In the lower left corner of the window, you can de ne
variables. Variables allow you to de ne numbers and text
to which columns and elds can refer. Variables can be
used in columns, including the standard numerical column,
as well as expression columns. Variables can also be used
in text elds, such as legends, titles, labels, etc. For more
detail, see the Variables chapter

When closed, the notes show on the right side as a small
icon next to the object

Notes and Comment
Add a plain text comment blocks in the column list or
variables list by clicking the note icon. These comment
blocks can be moved around freely in the list.

.
You can have multiple pop-up notes open at the same
time. The notes are connected to the objects, so when
you move a column or command object, the note will
remain attached

In the command list, rich text comment blocks can be
added by selecting Command > Add Text Description or
click the note icon in the tool bar

The text can be formatted using the Format menu. For
example, you can change the font size and color. You can
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Other menu selections, such as ‘Angles’ or ‘Labels’, will
have different options. DataGraph compacts the user
interface like this in several places. It is recommended that
you spend some time exploring the menus a bit to get
more and more familiar with the many options that are
available.

Separate the Graph Windo

If you export your data into an Excel document (File >
Export Data), the Pop-up notes are also exported in a
separate tab. See Exporting Data for more details

By default the graph window is embedded in the bottom
right of the user interface. If you have a second or larger
monitor you may want to separate the graph window.
Select View > Separate Graph Window

To delete a pop-up note, open the note and delete the text
in the note. The note will disappear when it is closed

The separated window is not designed for projecting or
remote sharing (e.g., Zoom) and may appear small on
some larger monitors/projectors. Instead, use the
Presentation Mode when sharing with remote users

Menu Option
The layout settings and drawing commands all contains
menus, where you can select from various options. Many
settings are by default set to ‘Nothing’ or ‘Automatic’, but
you can adjust practically every aspect of the visual
representation for a graph.

Alternate Screen Mod
Alternate Screen Mode provides an alternate user
interface that was designed for small screens. You can
active this mode under Window > Alternate Full Screen.
At the top of the window is a narrow bar that allows you to
control what is displayed.

As an example, consider how tick marks are speci ed. The
tick marks are set using the Axis settings. After clicking on
the small disclosure triangle in the top left corner of the
axis command, the tick mark settings are shown (third
entry down). By default X tick marks is set to ‘Automatic’
and DataGraph picks tick marks and formats labels to give
a good visual appearance

You can show either the data or the commands, but not
both. The De nitions checkbox will add a column/variable
de nitions list on the left side of the screen. This will work
for both the Data and the Command option. The
Thumbnails checkbox will show the thumbnail list of all
the graphs in the le at the bottom of the screen.
The Graph checkbox allows you to show/hide the graph
w i n d o w. T h e g r a p h w i n d o w o a t s o n t o p o f
everything. This means that you can cover the data/
commands, de nitions, and thumbnails. You can also have
the graph displayed on a second monitor

The tick mark menu contains several more settings. When
you pick a different X tick marks option (e.g., ‘Categories’),
the options displayed to the right of the menu change
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Presentation Mod

Step 2: Change the Displayed Grap

There are two ways to present graphs directly from
DataGraph. Either present to a window that can be shared
in a video conference, or present to an external monitor

Hover your mouse over a different thumbnail. After a
moment, a representation of the screens will appear. Click
the screen icon in the center of the thumbnail to send the
graph to that monitor

Present to a Window

Step 3: Control Presentatio

To help DataGraph users connect and share their work we
have added a new Presentation Mode for video
conferences, such as through Zoom.

While using Presentation mode, DataGraph will continue to
look and operate in the same way as before. The only
difference is that you will have the small image displayed
on graphs that are shown on external

Select View > Presentation > Present in Window
This creates a presentation window with the selected
graph scaled to that window. Click in the center of a graph
thumbnail to change the displayed graph

Since you control what is displayed using the thumbnails,
you can continue to work in DataGraph and make changes
to other graphs in your le, while a graph is being
displayed on the external monitor
NOTE: You are not limited to one DataGraph le during the
presentation. You can move between DataGraph les to
change the displayed graph. You can also open les or
even create new graphs to display

The icon you see depends on the computer. In the image
above, a mac mini was being used for the presentation

Step 4: End Presentation Mod

Present to an External Monitor

Under View/Presentation, select the same external monitor
to stop displaying OR hit the ESC key

In Presentation Mode, DataGraph will take over an
external monitor to display a selected graph. You control
what is shown on the external monitor using the primary
display (e.g., laptop)

Preferences Pane
Open the preferences panel using the menu bar
DataGraph > Preferences. In this panel, you can modify
the default behavior of the program. For example, you can
hide thumbnails until you add a second graph to a le.

Step 1: Select an External Monito
Under View/Presentation menu, select the external
monitor to control. The options you see listed will depend
on the number of monitors you have connected and the
monitor you are using to set-up the presentation

You can also create a Function Library, accessible from
the Fit and Function commands, the Expression column
and Expression variable. Import/Export your function lists
to share with other DataGraph users

This will show the graph with the current focus on the
external monitor. There will be an icon over the thumbnail
indicating what is displayed

.
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Data Inspector
Quick Graph
Click on any column and hold down the space bar to get a
preview of the data.
The type of graph you see will change depending the data
type of the column. Text columns will result in a count of
each unique entry displayed in a sorted, sideways bar
graph, using the Pivot command. Number columns will
result in a histogram. If you chose more than one number
column the Quick Graph will show the relationship
between the variable (linear regression).

The Hover tool provides different information depending on
the type of plot. In the Box plot example below, the Hover
tool provides the statistics used to generated the plot
based on the underlying dataset

If you have multiple number columns selected the Quick
Graph will show a matrix plot with each variable compared.
Up to four number columns can be selected. You can
change the columns selected with the Quick Graph
window open and the preview will update as needed

Loupe Tool
When a graph gets very busy it is sometimes necessary to
zoom in on the detail. There are several ways to do this in
DataGraph. You can zoom in by changing the axis ranges,
you can use the Magnify command to draw an inset, or
you can use the Loupe tool in the tool bar. You can also
activate the loupe tool by using the keyboard shortcut,
⇧⌘M.

Hover and Loupe together
When both that Hover mode and the Loupe Tool are
activated the Hover information is shown inside the loop
tool instead of over the graph. Another difference is that
multiple hover tags are shown at the same time

When you move the mouse over the graph, you see a
magni ed view, and can change the source and
destination sizes by using the scroll wheel/gesture

Hover mode
DataGraph has a Hover mode that will show the value and
corresponding row in the Data Table for a given point on a
graph as the mouse is moved over that section of the
graph. You can activate the Hover mode by selecting
‘Show Hover Information’ from the View menu or by using
the keyboard shortcut, ⇧⌘H.
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3. Importing Dat
There are several ways to quickly import data into a
DataGraph le, From a high level there are two separate
parts, the data source, and the destination. Source is a le
or clipboard and destination is rows or columns in the data
table. For an overview with short demos, you can also see
the How to Import Data in the on-line Knowledge Base:
https://community.visualdatatools.com/datagraph/
knowledge-base/how-to-import- les/

Note that if you drag in a le it is imported by using the
Import File... option. You can drag the le either onto the
data table or into the list of columns. If you drag it into the
list of columns it creates a group of columns
Data destination: There are two different import
destinations, the data table and the column list. The
column list only accepts a dragged le or columns dragged
from other DataGraph les. This adds the content as
columns or as a group with columns, and is explained at
the end of this chapter. When you import a le, the content
is either appended or overwrites data that is already there.
There are three different ways that data is added

Copy & Past
If the data is copied to the clipboard you can select
between two options - Paste or Paste special… The
Paste option uses default rules to gure out what
separator is used for the columns and to determine the
column type (i.e., number or text). Paste Special... brings
up a sheet where you can control the separator, transpose
the data, and trim the data, as it is pasted in the data table.
Note that if you drag in a text region from Text Edit it is
handled as a Paste

Importing File
If the data is in a le you have three options, as shown
below. Import File... is similar to the standard paste, and
uses the same rules as the paste action to determine what
the separator is used (tab or comma). Import File Portion
is similar, but allows you to select a sub set of the lines in
the le. This is helpful when you want to trim off a header
or footer before importing. The Import Special... option is
a very exible import method, and gives you a tremendous
amount of control over how data is imported

1.

If nothing is selected in the table, the data is
appended as new columns. The exception is that if
there are no rows in the columns that are displayed,
the data overwrites the existing columns

2.

If you select columns (or no rows are displayed), the
selected columns are overwritten with the data, and
additional columns are inserted to the right of the last
selected column. If the data source has column
names. This will also overwrite the column names.
Note that drawing commands that use the selected
columns will still refer to those columns even if the
name changed

3.

If you select rows, the data adds the data to the
columns and overwrites the selected rows. This
means that if you want to add data above the rst row,
you rst create an empty row at the top (menu entry in
the Data menu) and then overwrite that row with the
content. Any additional rows will be added below the
last selected row. No columns will be added, and if
there is a different number of columns in the incoming
data, or the column names don’t match, DataGraph
will ask for a clari cation. This is explained further in a
later section with an example

Interpreting text dat
When data is written as a text, and here it doesn’t matter if
the text is in a le or the clipboard, there are a number of
conventions used. DataGraph tries to understand most of
those conventions without any additional user input. The
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easiest is where each entry is separated by tabs.
Clipboards from spreadsheets are typically stored this way.
But even in that case, sometimes the rst row is just
numbers, sometimes it is column names. Another common
separator is the comma, so called CSV (comma separated
values). Here the problem is that sometimes the commas
are part of a label and in Europe a comma is used as a
decimal separator in numbers. Also, sometimes numbers
are separated by spaces, so '4 2 2.3' are three numbers

If you have these in the clipboard and you select Paste
Special..., you will see the following screen, in which the
data is interpreted as two comma separated columns.

DataGraph tries to handle all of these cases automatically
when you import a le or use the Paste action
If the decimal mark here is the comma, there are two
settings you need to modify in order to import these
numbers correctly. These are illustrated in the following
graphic. First, set the separator to 'Only Tab' so that the
comma (,) will not be used as a separator. Next, click on
the number conversion so that 5.334,5 is converted to the
standard form for DataGraph. Note that you can still
display numbers in the graph using , as a separator. You
just need to adjust the separator setting in the style sheet.

• Separator: If there is a tab character in the text, this is
used as the separator. If there is no tab, DataGraph then
checks for commas, semi colons or pipes (|) and then
nally uses spaces
• Title row: If the rst line has no numbers, the row is
viewed as a title row. Otherwise, the rst line is
considered a data row and the columns don’t have any
name
• Column type: If DataGraph needs to create a table
column to t the input data, the column type is
determined from the rst row. If the rst row is a number,
the column that is created is a standard number column.
Otherwise it is a text column. If this is incorrect, you need
to convert the column. But if you are overwriting columns
or appending rows, the existing types are used

Paste Special... also has additional features such as
being able to paste in a transposed table. So if you have
two rows with a lot of numbers, you can convert them into
two columns. This is important since drawing commands
refer to the columns and use all rows in that column

Paste Specia
The paste and import functions use the rules explained
above along with some automatic substitutions, to convert
text blocks from les or the clipboard into a table of
numbers or text. But sometimes these rules might not
import the data in the way you would like. For example,
what does 4,5 mean? DataGraph assumes that you are
using a comma separator between two columns and would
interpret this as the number 4 and the number 5; however,
in many countries the comma is used to separate the
decimal, and this is the number four and a half.

Import File Portio
The Import File Portion option can be used to select rows
that you want to import from a text le. Select a portion of
the le, then see File Import

Excel Fil

If these rules are not what you want, and that will
unfortunately happen more often in Europe than the US,
the solution is to use the Paste Special... option.

It is of course very easy to copy data from Excel and paste
it into DataGraph, but DataGraph can also import data
directly from an Excel le without requiring you to have
Excel installed

For example, take the following numbers
5,6
5.334,

There are three different ways to import data from Exce
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1. Drag an Excel le onto the table or select Import File…
from the Data menu and select the le. This imports all
of the sheets from the le and appends each sheet as
additional columns. Any rows or columns that you have
selected will get overwritten in the same way as when
you import a text le or paste data in
Select the le using the Finder and hit Open. You will now
have four rows in the table and three columns

2. Drag an Excel le into the column de nition list. This
will create a group for the le and if there more than
one sheet in the Excel le, DataGraph will create a
group for each sheet with the name of the sheet
3. You can import data from a single sheet by using the
Import Excel Sheet… option in the Data menu. Either
import all of that sheet or a rectangular region. This is
in particular useful when the sheet contains a lot of
header text or you don't need all of the values

Next step is to import data from a second le.

Example
The best way to explain the rules that were just described
is to show a few examples of basic input

If you don’t have any columns selected and import the le,
the columns are now appended and you have a total of six
columns

Overwriting columns
Consider a le with three columns and 5 rows. The le
could be comma or tab separated, and the rst row
contains the titles.

If instead you select the rst three columns before
importing the second le, those columns are overwritten

Adding rows: If you need to add rows to columns select
where you want to insert the rows and then either import or
paste in the data. Assume that you have three rows and
you want to add 3 rows to the end

Assume you start with an empty table with no columns.
Without selecting anything in the table, select Data >
Import File or use ⇧⌘I

.
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The rst step is to select the last row in the table, which is
always empty
If you select rows and paste in data where the column
names are not an exact match, DataGraph will ask you to
specify which columns should go where. For example, lets
assume that the original table has three columns x,y and
y2. You want to overwrite rows 2,3,4
Then paste or import the le. Since the column names are
the same, DataGraph will append the content.
If the column names have a different name DataGraph will
ask you to clarify what should be done. For example, if the
column names are A and B, DataGraph gives you a dialog
box, allowing you to specify how to input the data.

You import content either through the clipboard or a le.
This import has different rows, lets say x, x2 and y

DataGraph will ask for a clari cation of what you mean to
do and to do that it brings up a sheet
DataGraph also remembers what you picked, so next time
it will start by guessing the same action
When you want to add rows at the top, the rst thing you
need to do is to add an empty row by either using the Data
menu, or control click (right click) on the rst row and add a
row to the table

Click on the black dot on the left and drag the arrow to the
column on the right. Then when the data is added, the
three selected rows are removed and the two rows are
inserted instead. This shortens the selected columns but
leaves the other columns untouched

Dragging a le: If you drag a le onto a table, the table
gets a blue highlight. If you release the le DataGraph
responds in the same manner as when you select Import...
from the data menu. This is handy when you see the le in
the Finder. You can also drag a le into the column list.

Then select the empty row and paste the data or import a
le. This overwrites the rst row, and any additional rows
are added, as shown below
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• netCDF. DataGraph can import netCDF version 3 les.
Files that contain 2D or 3D arrays will be imported as
“ attened” arrays. All lists are read in as columns
(binary).
• Plot. This is for an earlier version of Plot, another
plotting program on macOS. DataGraph has not been
tested with les from the latest version of this program
which is now called Plot2

This action works in a slightly different way. When you drag
a le into the column list, you will see a drag line. If you
release the mouse, the content of this le is added as a
group, with the columns coming from the data le. The
name of the group comes from the le name

Import Specia
DataGraph can automatically understand les coming from
various platforms and using various separators (tab,
comma, space delimited, etc.). In some cases, you may
have more complicated data to import or you may only
want to import a portion of data from a le. Rather than
depend on other tools to manipulate your data into the
appropriate format, you can use the Import Special method
to de ne rules for how to import records from a le

If you drag a le onto a group, the content will overwrite
the columns inside this group. This is the same as
selecting all of the columns in the group and then dragging
the le onto the table

The DataGraph interface for creating custom import
methods is called Import Special. When you create an
import method, you can save the method to use on other
les of the same format

File format

For examples, on how to use the Import Special interface
please see the following on-line documentation

In addition to Text and Excel les (described in the
previous sections), DataGraph can import other data
types. The le is selected just like the text le. For le
formats with binary data, DataGraph creates binary
columns so no information is lost. The le formats that
DataGraph 3.0 supports are

How to Create a Custom Import Method:
https://community.visualdatatools.com/datagraph/
knowledge-base/import-special/

• Cricket Graph. Cricket Graph was widely used years
ago, but the last OS that supported it was OS9. Intel
machines cannot run the classic compatibility layer, but
DataGraph can import these data les
• Matlab. Matlab is widely used in engineering and
sciences, and you can save data in Matlab and import it
into DataGraph. The key here is that you need to save
the le with the -v4 ag. For example, if you want to save
the workspace so that it can be loaded into DataGraph
type
>>save import.mat -v4
Don’t forget the -v4 ag. See help save in Matlab for
more info about how to save only particular variables. All
row or column vectors are read in as columns (binary)
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4. Data Table

This chapter begins by showing you hot to Organize your
data and introduces you to Columns Types
In general, there are two types of columns, ones that
contain data and columns that are derived from data or
commands. The rest of this chapter discusses each
column type in detail.

The data table gives you access to individual rows in a
column. You can enter in new values, delete rows/
columns, sort data, nd data, and even have DataGraph
read back the numbers to you.

1.
The structure of the data table is de ned in a list on the left
side of the screen. This data list can be toggled from view
using View > Show De nitions (⌘-D). You
can also click on the Data icon in the top right
of the toolbar or the bottom left of the data
table. When the data list is hidden, you can
also double click a column header to open to
that entry

‣ Number — For standard numbers like 3.2 or 1e-5. Also,
for expressions like 3/4

‣ Text — Used for labels, names, etc. You can also
assign numerical values to the labels

‣ Date — Convert calendar dates into numbers that can
be used in a graph or for statistics

‣ Binary — Numerical column type for importing data
from programs like Matlab with no loss due to rounding.

2.

In the data list, each column has an entry. In this entry, you
can see the data type, the name of the column. The four
most frequently used column types are: numbers, text,
expressions, and date. To create an empty column, click
on one of the buttons above the columns de nitions list or
select it from the Other menu
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Organizing your dat
Most of the table adjustments are done in the column list.
What you see displayed in the data table depends
completely on this list.

Selecting

The selected columns are now indented and you can add
a group name

Selecting columns is similar to how you select drawing
commands. If you click on the icon of the column entry, the
border changes to blue to indicate that this entry is
selected. Another way is to click outside the command and
drag a selection rectangle to select multiple entries

You can nest groups within groups. You can also drag
entries in and out of a group.
The organization in the column list is also used to group
the columns when you are selecting data to plot in the
drawing commands. The column selectors in the drawing
commands will show the groups as sub-menus

You can also add to the selection by holding down the shift
key when you select. If you click outside of a column, or
select a command the column is deselected. Now actions
like cut, copy and delete will act on the selection and not
just this column. To delete the selection, just hit the delete
key. If you delete a column accidentally, just select undo

For example, if your data is in two groups, named ‘First
Experiment’ and ‘Second Experiment’ when you create a
new drawing command the drop-down menu for selecting
the data to plot will show the group names. The small right
facing triangle to the right indicate this is a group, as
shown below

Dragging
You can select and drag columns, or groups of columns, to
reorder them in the list. If you hold down the option key
while dragging you can clone (i.e., copy) the current
selection. This is one way to quickly create a column with
the same settings. As a shortcut, you can drag the column
onto a column menu in a drawing command to select that
particular column

Who you move the cursor over one of the group names,
you will see the data columns inside those groups

You can also use drag columns or groups of columns
between DataGraph les. For that you need to drag them
from the column list and drop them into a column list in a
different DataGraph le

Groups/Sub tables
When a table becomes complex, or you have multiple
logically separate clusters of columns, you can use the
group structure to keep them together and make it easier
to select columns in a drawing command

In the example above, the ‘First Experiment’ and ‘Second
Experiment’ both have two entries, named ‘amplitude’ and
‘frequency’. Once you create a drawing command with a
group entry, a small right facing triangle will show to the left
of the column name, as shown below, to indicate the data
is in a group

In order to create a group, select the columns that you
want to group and click on the Group icon

.
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Importing Groups

To reveal the source of the data from any drawing
command, you can

If you drag a data le directly into the column list,
DataGraph will create a group with the name of the le and
create columns in that group

1. Hover over the name to display a pop-up with the
group name displayed.

2. Click on the menu item. The group name is shown
in gray and the column selected has a check mark
next to it.

If you drag an Excel le that contains more than one sheet
each sheet will be put into a separate group

3. If you continue to hold the mouse in place over the
menu item a green arrow will also appear in the
column de nition list pointing to the group or column
name.

Note that if you drag the Excel le onto the table itself no
groups are created and all of the columns from all of the
sheets are imported
By default, a group has a different background in the data
table to separate it visually. In the column de nitions list,
you can change this background color, or specify no color
at all. This is done from the small action menu (gear menu)
to the right of the group name

Text blocks
Allows you to add comments. Create a comment block by
clicking on the icon next to the group icon. You can drag
this comment around, but need to click on one of the four
corners to select the box

Dragging Groups
You can drag groups by clicking on the group icon and
dragging. You can use that to reposition the group or drag
it into a different DataGraph le to copy it. If you hold down
the option key during the drag you will see a small plus
button next to the mouse arrow that indicates that the
group will be cloned when you release the mouse. Thus,
you can replicate the structure of the table and then
overwrite the content

Copying columns
You can select columns in the column de nition list and
copy them. This allows you to select entire groups, which
you can’t do when you select columns in the table and
copy
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One thing to consider is when columns are large. If you
select columns in the data table to copy, DataGraph adds
a text representation of the data to the clipboard. This
means that you can paste the data into a spreadsheet or
different application, and the string representation will be
used. If you have a few million entries, this can take a few
seconds. If you are intending to copy columns within
DataGraph itself, it is faster to select the columns in the
column de nition list and copy from there, since then only
the native DataGraph format is added to the clipboard.
This means that you cannot paste the data into a different
application when copied from the column de nition list

group name. Select the rst option in the gear menu to
paste data directly in that group

Displaying Data
The column list can be thought of as the place where the
data is stored. The place where the data is displayed is the
table. You can choose which columns are displayed in the
table by selecting the Show check box in the column
settings. This does not affect which columns are visible in
the drawing commands. You can also hide an entire
column group by using the Include check box.

When you overwrite columns, the connections that you
have made in drawing commands will not be broken. This
means that you don’t have to repeat any of the steps to
convert data into a graphical/statistical representation

Copy as Text
The clipboard on Mac OS X can have multiple
representations. The application that receives the data
determines which representation it uses. The default copy
operation (⌘-C) copies two representations, One is the
internal DataGraph representation that includes settings
such as the column type. The other is a textual
representation where the column title is in the rst row and
the columns are separated with a tab.

When a column is visible, you can edit the individual
values, but only for the number, text, date or binary
columns. The other columns can be displayed, but you can
only change the rule behind the values and how the values
are displayed

Data Entry

Note, that if the total size for the clipboard is larger than
40MB, DataGraph only copies the internal representation.
This is done because most applications can’t handle that
large of a text block, and the assumption is that you are
not moving the data out of DataGraph. If you want to
export more than 40MB use the Export option to save it to
a le or use the Copy as Text option, which does not copy
the internal representation and has no cap

The data table has slightly different input methods than
what you might be used to from a spreadsheet. To start
editing an entry, double click on it. If you press return
(enter) you close this cell and start editing the cell right
below it. If you hit tab you go to the next editable cell to the
right or to the next line if you are at the end. By holding
down the shift key when you hit the tab key you go to the
next editable cell to the left or up to the previous line.

The Copy as Text option is in the Edit menu, and does
not have a shortcut key. This only copies the textual
representation and is not limited to 40MB. In addition to
allowing you copy large amounts of data into other
programs, this command can be useful when you want to
convert an expression column to text. Copy as text will
effectively convert the result of the expression to a text
column when it is pasted in either DataGraph or other
programs.

DataGraph will always keep the last row empty, and as you
add values to the last row a new and empty row will show
up below it. Pasting in data is explained in the next
chapter

Deleting rows
You can also select a set of rows and hit the delete key.
The main issue here is that when you select rows you
select all of the rows that are displayed in the table. If you
just want to delete the rows of a sub-set of columns, what
you need to do is to hide (uncheck the Show or Include
box) for the columns you don’t want to change and hit the
delete key.

Paste into group
When you copy and paste columns into a DataGraph le
that has groups, you can specify when to paste data into
an existing group. First, copy the data to get it into the
clipboard. Next, select the gear menu to the right of the
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go to the action menu below the table, or the Data menu in
the main menu bar. There you can select the sorting
method

You will get asked which columns should be affected, but
you can decide to only delete the rows from the columns
that are visible, the columns in the same group or all
columns

Reorder rows
Note that the action menu gives you more options, and the
options depend on the particular the column type. For
example, the text column can be sorted according to last
name and natural sort puts 'value 2' before 'value 10'

The simplest way to reorder rows is to drag them around in
the table. This is done as follows
1 - Select the rows
2 - Click and drag the mouse to the left or right.
3 - Drag the selection up/down

The sorting options are also available in the context menu
for a column. You get this menu by either control clicking
(right clicking) on the column header in the table or on the
small action menu icon to the right of the column name in
the column list
When you have groups, or not all of the columns are
displayed, the action menu uses a sub menu for sorting.
Using this sub menu, you can specify exactly which
columns you want to include in the sort. This is important
because sorting only the visible columns might corrupt the
data. For example, say you have a class list of ‘student ID’
and ‘ nal grade’. You can hide ‘student ID’ and then sort
the table according to name or a grade.

When you start dragging, a gray version of the selection
moves with the cursor. A blue line will show where this
block will be moved when you release the mouse. If you
hold down the option key, you clone the selection
If you click and drag the mouse more up/down in step 2,
the system interprets this as a change in the selection and
does not drag the selection around. If you are not
displaying all of the columns, the same window pops up as
when you are deleting rows, since it is not clear from
context which columns you want to be affected

Reorder columns

For example, say you have nested groups. The highest
level is a group for ‘class section’. Inside that, you have a
groups for each midterm. Inside that, you have the grades
for that midterm. If you select sort for the ‘ nal grade’, you
need to specify what you want to sort. Here it makes sense
to sort everyone in the section, since sorting the midterm
group only will certainly corrupt the data

You can reorder columns in the column de nition list or in
the table. To drag columns around in the table, just select
the column and drag them. When you release the mouse,
the column will be moved in the column list

Sorting rows/columns
You can sort data based on a column. The simplest way to
do this is to select the column you want to sort, and then

.
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Editing Shortcuts

Find & Replace

Shortcuts are available through the context menu. You get
to the context menu by either right clicking or control
clicking. If you select rows and control click on the column
header you trigger the context menu for that column. This
allows you to ll the entries with a xed value, or use the
rst two rows to ll out the remainder of the row selection.
This only affects the column that is selected

DataGraph can also be used to nd and replace data as
needed. For example, if you have extra text in a number or
quotes where they shouldn’t be you can easily isolate this
data and update the data table

First, you should select the columns or rows that you want
to modify. To open the nd and replace window, you can
either hit ⇧⌘R or select Find and Replace... from the
data menu. In the example below, Remove non-number
is selected

Find & Filter
DataGraph has a nd action, triggered with ⌘F. This
command provides the user a search bar above the data
table that can be used to lter the display of the current
table based on a search string.

You can simply type in the search string or you can specify
which column to search using the Displayed drop-drop
box. By default, the search returns any rows that contain
the search criteria but you can also specify the type of
search to conduct as shown below

Entries that are changed are displayed in red, unchanged
entries in black. You can pick several lter options, as well
as using a nd-replace string match

Column Type
The number, text, date and expression are by far the most
frequently used column types. The Other menu has
additional types, which will come in handy as you start
using DataGraph for more advanced actions such as
extracting residual from function ts, etc.
Using Find action, does not affect any drawing or change
the data, but you can select rows to copy/cut or delete
them. You can also edit individual cells in the selection.
Note that this command works on all the data columns that
are displayed in the data table. To end the search and
restore the data table click the Done button in the search
bar

The small disclosure triangle in the top left corner of each
column type reveals the additional settings. For some like
the number column, the settings are for optional
formatting, for other columns such as date and expression,
these settings are crucial

Converting
Sometimes you have a column that doesn’t have the
proper type. Maybe you pasted in a column, or began with
a standard numerical column and want to convert it into a

.
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label column. Instead of creating a new column, you can
convert the type of the existing column using the gear
menu, as shown below. When you convert a number
column to a label or date, the entries stay exactly the
same

originally entered, as shown below, or you can always
change the Display setting back to Entered Value

By using variables (See the Variables chapter for more
information), you can de ne mm = 0.001, cm = 0.01, m = 1
so you can enter in 5m, 44cm, 22mm and this will be
understood as 5*m = 1, 44*0.01 = 0.44 and 22*0.001 =
0.022

Numbe
The Number column is a standard column for numerical
data. Below is a Numerical column entry as it is shown in
the column de nition list

Tex
The Text column is intended for labels or categorical data.
Below is a Text column entry as it is shown in the column
de nition list

When you create a numerical column, you can enter
numbers in the data table in the form 3.41, 3.51e3 etc, but
you can also type in expressions like 5/2, sqrt(5), 5e, ... If
DataGraph cannot understand the expression it will display
the content in red.

When you import data, DataGraph tries to determine
whether or not the data is text. If you end up with a column
where all the entries are red, this is most likely because
you are using a number column. You can convert this
column to a Text using the gear menu to the right of the
column name

You can change the format of the data shown in the data
table using the Display drop-down box. For example,
three Number columns are shown below that have varying
options for Display

When the Values drop-down box is set to ‘None’, you will
simply see the text entries in the data table. You can also
map the text entries to numerical values. This can be
useful since many drawing commands require a numerical
value. For example, if we try to create a histogram using a
Text column it will show the column name in red (see
below)

Below, the same exact values are entered into each
column, with the ‘Entered value’ column showing exactly
what was entered. The other two columns show the
numerical representation of the same data rounded in
different ways

There are several ways to de ne this mapping, which are
listed in the Values drop-down box

When you change the display, the entered valued is
always stored. You can click on the cell to reveal what was

.
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For example, say you have a table with entries that include
‘A’, ‘B’, and ‘C’. ‘Row’ simply returns the town number, #.
‘Sorted #’ will assign ‘A’ to 1, ‘B’ to 2, and ‘C’ to 3.
‘Sequence #’ means that the value is assigned based on
when the label rst appears. For example, if the rows are
C,A,C,B the values are 1,2,1,3

Dat
The Date column type is intended for calendar dates and
understands a variety of formats. Below is a Date column
entry as it is shown in the column de nition list

Instead of trying to guess that a numerical column is a date
and require you to use a particular format for dates,
DataGraph asks you to make that explicit by converting the
column into a date column and specifying the format

The ‘Map’ option allows you to specify the mapping exactly
by assigning values to each label. For example, take a text
column with the entries C,A,C,B. When you select ‘Map’
from the Values pull down menu, a mapping table
appears. This table is initially empty and you have to
specify the value for each label.

For example, if you have ve numbers in a standard
numerical column of the form month/day year, these
entries are not understood as numbers and will show up in
red

To simplify that task, you can ask DataGraph to populate
the left column in the mapping table with the unique entries
from the data table. First, select ‘Make sure all entries are
mapped’ from the gear menu. After that, all the unique
entries from the data table are automatically populated in
the String column, as shown in the following image

To convert this column to a date, use the gear menu to the
right of the column name

Finally, you can type the numerical Value for each String.
In this example, the label 'A' is mapped to the numerical
value '100'. The gear menu has additional menu items to
simplify this process and automatically assign values, sort
entries , etc. To show the numerical values in the data
table, simply click the Display check-box

When the column is converted, DataGraph makes a best
guess at the date format. If the format is not correct you
can select the gear menu again. Then you will see a list of
possible date formats to choose from that DataGraph has
selected as working with you data.

When a text column has a numerical mapping, it can be
used where ever DataGraph expects a numerical column.
For example, you can use this to map grades into a
numerical score for computing averages

You can also specify the date format manually. There is a
long list of built-in formats in the Day drop-down box. For
expert users, you can specify a format string for formats
that are not already supported. Speci cally, in the Type
drop-down box select ‘ICU Format’. ICU stands for
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International Components for Unicode and provides
standard methods for specifying data and time formats

DataGraph handles this completely differently. Some
actions are done by using drawing commands or columns,
such as the plot action column, but the main workhorse
here is the expression column

Syntax
The expression column uses arguments that are either
columns or variables. An expression like 2x+y, where 2x is
understood as 2*x, has two arguments 'x' and 'y'. If x and y
are names of numerical columns, the expression column
will use the rows where the x and y columns have values

After changing the Type to ‘ICU format’, a Format entry
box appears, as shown above, where you can specify the
date format. If you hover over the Format eld the
following help will appear summarizing the ICU format
string options.

For example, below is an expression column named
'Expression' using x and y

Using the Display drop-down box, you can specify a
different display format. The original data will be saved as
this only changes how the date is shown in the data table.

In the Data Table, the result of the expression is shown

Binary Colum

If one of the arguments is not found as a numerical
column, DataGraph will look for a variable with that name.
If x is a column and y is a constant, the expression is
evaluated wherever x is de ned and y is the same for each
row

This column stores numbers as IEEE binary numbers. This
differs from the number column (discussed previously) that
stores the textual representation entered in a column and
converts that to a number when you open the DataGraph
le. For example, if you enter '1/10' in a binary column it
gets converted to 0.1 immediately

Column names that contain a space must be placed in
parenthesis in order to refer to them as arguments in an
expression. Note that argument names cannot start with a
number, since 3x is understood as 3*x. If you have a
column that is called '3x', you can use this in an
expression, but will need to enclose it in quotes, e.g.,
y-'3x'. This allows you to also include spaces and even
operators, so '3x - 5' + 'another column' will subtract the
two columns named '3x - 5' and 'another column'

When you import a Matlab binary le (saved with the -v4
ag) DataGraph creates binary columns so that the import
is completely loss less. To convert a number column to a
binary column, use the small gear menu to the right of the
column name.

Expression

DataGraph uses the following symbols for standard
operations: plus '+', minus '-', multiply '*', divide '/', and
raise to a power '^'. DataGraph also contains a number of
built-in functions and logical operators. These are listed in
the Function Reference in the Appendix

A standard spreadsheet typically handles expressions by
referring to individual cells of the form A5, A10, B4 where
A,B,C... indicates the column and the number indicates the
row. This gives you a way to reference any cell, but there
are problems when you have a lot of rows and it is
sometimes hard to know what each cell does

The constants π, pi, e, ∞, NaN, inif, Inf are de ned, and
can be used in expression. For example, x*π/180 converts
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from degrees to radians. The keyboard short cut for π is
option-p and for ∞ is option-5

Column References
In the previous example, it was clear that there was one x
column and one y column that were being used in the
expression. However, DataGraph allows you to have
multiple columns with the same name and to nest the
columns using groups. When you use arguments in an
expression, DataGraph searches the columns, groups, and
variables based on a speci c set of rules and picks the rst
one that matches

Now, let’s move the new x column to the top of the list

The search order is as follows
1. At the same level the expression, search through all
columns in the order listed, while also searching
through each group or subgroup

Notice how changing the order in the column de nition list
automatically updated the location of the column in the
Data Table. The expression column will now use the rst x
column listed. As a result, the value of the 'Expression'
column changes

2. If no match is found and the expression is nested
within a group, go up one level the parent group and
search through only the number columns in this group
in the order listed. Do not go into subgroups
3. If no match is found and you are not at the top level,
move up one level and search as explained in step 2.
Continue up until you have checked the top level
4. See if the variable exists as a variable
5. If the variable is not found, the expression is
considered invalid and DataGraph puts a red dot in the
top left corner of the column de nition

As noted in the step one of the search order, DataGraph
will search through groups and subgroups that are at the
same level as the expression. Thus, if we put the rst x
listed in a group, our expression will still use this x, even
though it is in a group

Building upon the example from the previous section, we
can add another column 'x' to the end of our column
de nition list

Based on the search rules discussed above, columns that
are in a different group nested at the same level would not
be found. For example, in the following screenshot, the f
function cannot directly refer to x because f and x belong
to different groups

In the Data Table, we set the new 'x' column equal to all
zeros. Since the expression uses the rst x column listed,
the value of the expression does not change
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In this case, we could use path references to refer to
columns outside of the search path, as discussed in the
following section

Reference

Location

./x

second

/group1/x

second

/group3/x

fourth

/group1/group2/x

third

./group2/x

third

../group3/x

fourth

Path References

The # column

It is possible to refer to columns in a speci c group by
using a syntax similar to path names in unix: ‘.’ refers to
the current level and ‘..’ refers to the parent group, one
level up. You can also refer directly to the top level using
‘/’

The row number column, named # by default, is a special
column. The column gives the row number corresponding
to the data shown in the data table but has no inherent
length of its own

For example, consider the following three groups and four
data columns all named x. An expression column is nested
contained in group1 that returns the value for x

If you use an expression that only has the # column and
variables or constants there is no way to know how many
rows should be in this column. When this happens,
DataGraph adds a eld to the expression column de nition
called # of rows
The number # column can be used to generate a list of
numbers. For example, the following expression would
generate a list of 10 odd numbers: 1, 3, 5, 7, … , 1

If you use the expression '#*x' and x is a column, the # of
rows eld is not displayed since the length can be
deduced from the x column. Putting 10 in the # of rows
eld speci es the length. This eld can use a variable, so
you can specify the length as 'N' as long as one of the
variables is called 'N'

Inside the expression, x alone will refer to the x column
inside group1, the second x. The following table explains
how to refer to any of the x columns using relative or
absolute references
Reference

Location

x

second

../x

rst

/x

rst

The # column can also be used to refer to the column as a
subscript, which is described in the next section

Referring to rows
DataGraph allows you to refer to speci c row in a given
column by using the column name followed by the row
number inside parentheses, what is referred to as a
subscript operator.
For example, the expression column below, named
'Second x' is set the value of x at row 2, or #=2. Since the
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length cannot be deduced from the expression you need to
specify the length

spreadsheets, if x is column A and y is column B, this
means that the rows are evaluated by using A1+B1,
A2+B2, A3+B3,… But what if you want row 1 to be A1+B2,
row 2 to be A2+B3, etc. That is, you want to refer to the
next row in the column, not the same row
In DataGraph, you can specify the row number by using
the subscript operator. To get the row number, use the row
number column #. The following expression adds x(1)+y(2)
and x(2)+y(3)…

If our x data is simply the list 1,2,3,4 the result of this
expression is the number 2
An example result is shown below

The number in the parentheses is referring speci cally to
the row number. Thus, if we sort the x column descending
the value of 'Second x' changes accordingly

Note that for the last row y(#+1) is not valid since it is out
of bounds. That just means that the result there is empty
To refer to a column that has a space in the name or
cannot be understood as a constant for other reasons
(e.g., has a + in the name), put quotes around the name,
but not around the parenthesis

If we wanted our expression column to have the same
length as the x column we could simply add x*0 as shown
below. Since the length of the column can be deduced
from the x column the # of rows eld is not used or
displayed

In DataGraph, a column cannot refer to itself, since that
will lead to an in nite recursion. In spreadsheets, this
approach often used to do an incremental sum. That is,
column B is de ned such that, row 1 is A1, row 2 is A2+B1,
row 3 is A3+B2, etc. In DataGraph, this type of summation
is accomplished using the 'isum' column property,
explained in the next section

If we modi ed our expression to be x(#), that is 'x(#)+x*0',
note how now we just return the value for x at that row
number

Properties
Several built-in properties are de ned for every numerical
column, including expression columns, plot action
columns, or columns coming from drawing commands.
They are referred to by using the 'name.property' syntax,
where name is a column name

Next, consider an example where we want to stagger the
rows that are used in an expression. By default, the
expression x+y uses x and y from the same row. In

.
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Some column properties are single values or constants for
a given column. For example, x.sum is the sum of all
values in column x. You can use this inside an expression.
For example, the expression shown below uses the x.sum
to calculate the percentage.
This is the incremental/accumulative sum of a column.
You can also use column properties in more complicated
expressions, such as 2*x.isum+1. You can even refer to
particular row values of a property, such as x.isum(#-1)
You can also use column properties as a subscript, or row
reference inside expressions. Consider the sortwith
property, a column property that returns the row number
for sorting. That is, x.sortwith returns the row number of
each entry in x that corresponds to a sorted x. That means
that x(x.sortwidth) will sort the x list, and y(x.sortwith) will
apply the same reordering to the column y

Note that the format in the above table only shows a few of
the digits, but the full resolution is used in any drawing
commands or expressions that use this column. Also, for
percentages, to round percentages in such a way that the
sum of the rounded numbers is 100% use the Pie
command
The following table provides a list of built-in column
properties that return a single number
Name

Description

min

minimum of the column

max

maximum of a column

Name

Description

length

Number of the last non empty row

isum

range

maximum minus the minimum

Incremental sum, e.g., row 4 is the sum
of rows 1,2,3 and 4. Restarts where
there is a gap.

average

Mean of the column

rmax

Maximum so far.

median

Median of the column

rmin

Minimum so far.

sigma

Standard deviation

count

s

Unbiased estimate of the standard
deviation

sem

Standard error of the mean

How many times this row value has
appeared up to this point. So if you have
row values 3.1,1.1,2.1,1.1,1.1,2.1 the
count has the row values 1,1,1,2,3,2. If
you draw the points (x,x.count) you will
get a form of a histogram.

totalcount

How many times this value shows up in
the list. If you have the list
3.1,1.1,2.1,1.1,1.1,2.1 the totalcount
variable is 1,3,2,3,3,2

sortedindex

Where this entry will be in a sorted list. If
you have the list 3.1,1.1,2.1,1.1,1.1,2.1
the property is the list 6,1,4,2,3,5.

rst

Below is a list of column properties that return another
column of numbers

Value of the rst non non-empty row

last

value of the last non empty row

sum

sum of all nite values

There are also a number of column properties that return a
column of numbers. For example, the 'isum' property is the
incremental, or accumulative, sum of a column

.
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Name

Description

rank

Where this entry is in a ranked list.
Repeated values have the same rank. If
you have the list 3.1,1.1,2.1,1.1,1.1,2.1,
the rank is 1,5,2,4,4,2. This is because
3.1 is the highest value (top rank), 2.1
shows up twice so both have rank 2,
and not 2 and 3.

sortwith

If you combine this with the () operator,
you can sort the list by doing
x(x.sortwith), but more importantly you
can reorder a column y with this order
by doing y(x.sortwith).

delta

The difference between two adjacent
rows. The rst row is empty.

unwrap2π

For angles, for example computed with
the angle(x,y) function the value is
mapped onto a whole period such as [π,π]. The issue with that is that when you
wrap around the circle the value jumps
by 2π. This column will make sure that
the gap between adjacent rows is less
than π in absolute value. That means
that if your row entries for x are π/2,π,-π/
2,0,π/2 the output for x.unwrap2π is π/
2,π,3π/2,2π,5π/2.

unwrap1

Similar to the last command, except the
period is 1. So 0,0.5,0,0.5,0 maps to
0,0.5,1,1.5,2

unwrap360

a random number column, the seed itself is created using
a different pseudo random number generator. You can
change the seed to any value you prefer. Once set, the
seed will not change. Thus, the next time you open the le
the seed will be the same so the random sequence will be
the same. This is why it is referred to as a pseudo random
number generator, since it is a repeatable sequence of
numbers that behaves statistically like a random number
sequence
An example use for a random number generator would be
to add a slight change, or jitter to data for plotting
purposes. Consider a case where the x and y values are
integers between 1 and 3. There are only nine different
combinations possible. If you draw the x,y values as points
you will only see these nine points. If you add a random
jitter to x and y and draw the jittered result you will get
point clouds around each point. Thus, you can see where
there are many points close to a certain combination

3

2

Same except the period is 360.

1
1.0

Random Numbers
DataGraph includes support for pseudo random variables.
They are pseudo random because given the same starting
seed they will produce the same sequence every time.
There are two random number functions, rand and nrand.
The function rand creates a uniformly distributed random
number. It takes in two arguments, the minimum and
maximum values that de ne the range. The function nrand
creates normally distributed random numbers. If you use a
single argument, i.e., nrand(a), you get a normally
distributed number with standard deviation ‘a’ and mean 0.
If you use nrand(a,b) you get a normally distributed
random number with mean ‘a’ and standard deviation ‘b’

.
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From Comman
This column type allows you to extract a column of data
from a drawing command. Thus, you can use the output
from one drawing command as the input to another
drawing command
Typically, you create this column by using the gear menu
on the right hand side of the drawing command. There are

30
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The random number generator used is called the
Mersenne Twister, a very widely used pseudorandom
number generator. For more information, see Wikipedia at
https://en.wikipedia.org/wiki/Mersenne_Twister

When you use either of the random number generators, a
new eld is added to the column de nition containing the
seed for the random number generator. Each time you add
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several drawing commands that have extractable data
including: the Pivot, Histogram, Box-plot, and Fit

Note that if you want to only extract a single number from a
drawing command you can do that by using a variable and
use the From Command variable type

In the following graphic, the gear menu is being used to
extract an individual column or row from a Pivot command.

Text Expressio
The Text Expression column can be used to combine
columns and variables into a text column. It is similar to
using tokens in a text eld (See section on Tokens in the
chapter on Drawing Command Elements), except that
you can select other columns as well as variables. This
column type is useful for labels, such as hover labels or
labels for points and bars
This will create a From Command column in the column
de nition list, as shown below. Once the column is created,
you can use the From drop-down box to change the
drawing command from which you are extracting data and
the Name drop-down box to change the speci c column
extracted

In the following example, a Text column ('label') and a
Number column ('value') are combined using a Text
Expression column ('label and value').

By default, the label assigned to the From command
column matches the name from the drawing command, but
the label can be changed in the column de nition list. Note
that if you change the selection in the From drop-down
box to a command that does not have an extractable
column matching the entry in the Name drop-down box,
the entry in the Name drop-down box turns red (to denote
the mismatch) and the column is empty.

An entry in the Text Expression column is created in
every row where both values are de ned. Thus, if any of
the entries in either the 'label' or the 'value' columns are
empty the result in the 'label and value' column is also
empty, as shown below

The column type assigned to the From Command
depends on the type of data extracted. For example the
category names for a Pivot command are text labels. If
you select that data to extract the column changes into a
text column
The content in a From Command column changes
dynamically. Thus, if the input to the drawing command
changes the result in the extracted column changes
accordingly. This allows you to use DataGraph as a
programming environment. For example, you can take a
pair of columns, use the Fit command to compute the
closest t, extract the residual back as a column by using
the From Command column, then pass that residual into
a Histogram command. You could then take the result
from the Histogram command back into the data table and
continue.

Plot Actio
The Plot Action column allows you to compute/derive
other mathematical values from data, using one or two
columns as input. Inside this column, you can specify
computational actions that can be described as taking an
xy plot as input, accepting additional arguments as either
columns or numbers and returning a single column. Rather
than creating different column types for each action, they
are all grouped together into a single column type

.
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Differentiate

To use this action, the rst step is to select columns for the
xy plot. This requires two columns. The next step is to
select the computational action from a menu, as shown in
the following screen shot

Computes the derivative at each x location. There are
several ways to approximate the derivative.

The central derivative approximation uses a second order
polynomial through the current point and the point before
and after and differentiates that approximation. If the x
values are uniform it simpli es into what is typically called
the central derivative approximation, namely for row i the
derivative is computed b

The entries below the Action menu change depending on
what you select. In the following sections, each selection
under the Action menu is explained

Integrate
Fn =

Z

xn

y(i + 1)
x(i + 1)

f (x)dx
x0

y(i + 1)
x(i + 1)

Extrema
To nd the overall maxima or minima for a column, you can
use a Number from Column variable; however, if you
want to nd local minima or maxima you can select the
‘Extrema’ option from the Action menu

The trapezoid method is more accurate when you have a
smooth function, but the left and right options are useful
when you want to use this method to compute an
accumulative sum. In that case you would use the row
column (#) as the x coordinate
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fi

y(i)
x(i)

The least square options are computationally a little bit
more involved. They use three, ve or seven neighboring
rows (one, two or three before and after), compute a least
squares linear t to the (x,y) values at those points and
then return the slope of that line

Note that the rst entry is always 0. For each interval, the
integral changes by what is considered the integral for that
interval. The rst interval in the table is between 0 and 1 in
the x direction. The y values are 1 and 2, so the trapezoid
approximates the integral by computing width times the
average of 1 and 2. The Left option uses the value at the
starting point and multiples the width. The Right option
uses the value at the ending point and multiples by the
width.

 


1)
1)

Forward and backward use one sided derivatives. They
are less accurate for smooth functions. The Forward
difference for row ‘i’ is computed b

The Integrate action computes the accumulative integral.
Speci cally, for a particular row the value is the integral of
the xy plot up to that row. As demonstrated below, there
are three options for how the integral is calculated:
Trapezoid, Left and Right

fi

y(i
x(i
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known. For example, if you are given a sampling of a
function at points x1,…,xn, you can approximate at points
in between those values. There are multiple ways of
interpolating between data points that typically involve
approximating a function by tting a line or polynomial
through neighboring points. The function can then be used
to approximate values at locations were there is no data.
The Interpolate action allows you to choose between a
number of different approximations methods as shown
below

When the window is 0, the action nds every local maxima.
A local maxima is de ned as a row where the previous row
is less than or equal and the next row is strictly less. The
output column has a non-empty row at the maxima, and
you can choose to either return the x or y entry at that
maxima. If the y column has a lot of noise you get a lot of
local maxima as is shown in the next gure. The graph is
created by using the result from the Extrema action in a
Lines command to draw the horizontal lines associated
with each maximum. The top graph is an inset that is
zooming in on a range with a lot of maxima.
0.4

0.6

0.8

1.0

1.2

1.4

1.0
0.9
0.8

You select the x locations where you want to interpolate
the x,y data sets as a column. The linear option means
that the approximation uses the two closest points and
approximates the function with a straight line between the
points.

1
0

1.5

1.6

1.7

1.8

−1
0

2

4

6

8

1.05

10

1.00

The window setting can be used to specify a minimum
distance between the extrema. In this case, the maximum
has to be both a local maximum and no value within the
given window can be larger

0.95
0.90

1.0
0.5

When the window is set to one, the local maxima’s due to
noise are removed, as shown below. The local maxima at
x=1.2 is not included because the value at 0.9 is larger.
0.4

0.6

0.8

1.0

1.2
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1.0

0.5

1.0

1.5
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2.5

3.0

3.5

0.9
0.8

The cubic option uses four points to t a third degree
polynomial through the points and evaluates that
polynomial at the point.

1
0
−1
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Interpolate
The Interpolate action allows you to use known data to
approximate values at locations where the data is not
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1.5

1.6

1.7

1.8

You must have a column set to specify the locations of the
bins and whether these locations de ne the Right, Left, or
Center points of the bins. You must also specify what
should be returned as shown below.

1.05
1.00
0.95
0.90

1.0
0.5
0
0

0.5

1.0

1.5

2.0

2.5

3.0

3.5

Spline uses a cubic polynomial on each interval such
that the second derivative is continuous across the
interval. This is same as the spline option in the Plot
command

Below is an example using the Bin action on the following
x y data to determine counts within each bin and averages
for the y data.

Example
If you have two data sets (x1,y1) and (x2,y2) and want to
subtract the two y values, you can use the expression
column as long as the x1 and x2 values are the same and
aligned. If the values for x1 and x2 are not all the same
locations, you can use the Interpolate action to compute
the y1 values at the x2 locations

Smooth
The Smooth action requires two columns (e.g., x,y), and
generates a single column of data. Smoothing can be used
to reduce noise in a data set as shown below.
100
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−100
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40
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80
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There are three options available for data smoothing

Bin
In order to group data based on either numerical or
categorical groups, DataGraph contains drawing
commands such as a Histograms and the Pivot command.
These drawing commands also allow you to extract the
results of the binning; however, there may be some cases
where you want to bin a set of data without plotting or you
want to use non-uniform bin sizes. In these cases, the Bin
action can be used to analyze data while specifying the bin
locations directly

For a moving average, you specify how many previous
values to use in the average. This functionality will ignore
the x column and just look at the order for the y column.
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For the rst column, it uses an ever larger average, so the
rst value is the same, the second value is the average of
the rst and second, the third is (y(1)+y(2)+y(3))/3. The
fourth is the average (y(2)+y(3)+y(4))/3, etc

Interpolate by Categor
If you have set of data that you would like to interpolate
values between known data points you can use the Plot
Action column as described in the previous section. The
Interpolate by Category column goes a step further as it
allows you to interpolate data using a category to group
data

For more information on these techniques, see: Wikipedia
- Simple Moving Average.

Evaluate

You can add a new Interpolate by Category column using
the Other drop-down menu above the column de nitions
list.

The Evaluate option allows you to evaluate a function,
y=f(x), at discrete x locations. It required requires one
column (x) and either a function from a Fit command or
from a Function command

A new column of this type will look as shown below. The
rst three drop-down boxes de ne the data set that you
want to interpolate. The last two drop-down boxes de ne
the output

For example, let's say we have raw data from two
experiments 'A' and 'B' where the sampling days are not
always the same days

Subtract
The Subtract option allows you to subtract a function,
y=f(x), from discrete y values. It required requires two
columns (x,y) and either a function from a Fit command or
from a Function command

You can use the Interpolate by Category column to
estimate the 'Result' column for missing days using linear
interpolation.

This column can be useful for calculating residuals from a
function t, since the residuals extracted from the Fit
command directly will only provide residuals for the data
used in the t

For this example, you can rst create the Interpolate by
Category column, called 'ResultOut'. Next, specify the
input data, Category equals 'Exp', x equals 'Day' and y
equals 'Result'. We have also de ned two additional
columns 'ExpOut' and 'DayOut' that specify the category of
data to interpolate and the day
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Below is the result of the interpolation is shown in the
column 'ResultOut'

You can do the same type of mapping using the 'From
Columns' method but you must have two columns that
de ne the key-value pairs. The 'Intervals' method is useful
for mapping intervals of numbers to letters. For example,
you could map number intervals to grades

For days that are given in the raw data (Day 1,2,5,6,8), the
DataGraph does not need to interpolate. The value of
'ResultOut' for days not given in the 'Result' column (Day
3,4,7) are interpolated

Ma
The Map column allows you to lookup items in a list based
on a key value. You can add a Map column using the
Other drop-down menu above the column de nitions list.

Note that you can also specify what should be shown
when an entry is missing. Thus, the value entered in
Missing is shown when there is no match.

Mas

There are three methods available for mapping entries:

The Mask column was created to allow you to remove
data from being included at the column level. You can use
a separate column of data to use for the mask

1. Speci ed — map a column by specifying key-value
pairs directly in column de nition
2. From Columns — map a column by using other
columns to specify the key-value pairs
3. Intervals — map a numerical column based on
intervals

For each of these methods, you must specify the column
to map using the Map drop-down box. When you add a
new Map column, the mapping method is set to ‘Speci ed’
by default.
Below is an example using the speci ed
method, where a column named 'Direction' is mapped from
text to text

Redirect
The Redirect column allows you to create a short name
for an existing column
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5.Variable

Organizing variable
When you add variables to the list, you can organize them
by selected and dragging. You can also group variables
and add annotations to help organize and document your
data

Variables allow you to assign a variable name to a number
or text that can be used in other places in DataGraph. For
example, numeric variables can be used within formulas or
to control the line width in a plot. Text variables can be
used in titles or data labels

Grouping
Add a group using the icon to the right of the other dropdown menu. You can add variables to a group by dragging
them into the group or by highlighting the variables before
clicking the group icon, as shown below.

You can also use Variables to create Font, Color
schemes, and Marker schemes, to use across multiple
graphs and commands, and they are easily copied
between les. There is even a way to have the current
date and time set using a Variable
Variables are different from columns in that each variable
must have a unique name. Note that by organizing
variables into groups you can have variables with the
same name, since the group name is used when referring
to the variable in an expression, as described in the next
section

This creates a group containing the selected variables. In
the example below, the group is named 'A' and the
variables are 'T1', 'T2', and 'T3'

The Variables list is located just below the list of column
de nitions. You can create variables using the buttons
above the list. The three main types are shown here:
Slider, Value, and Text. Additional variable types can be
accessed in the Other drop down menu

s


.


 


.


s


.


.


S	

fi

.


.


fi

37

5. VARIABLE

DATAGRAPH 5.0

You can refer to variables in expressions by combining the
group name with the variable name, using a colon to
separate the two. For example, to use the value for 'T1' in
an expression you would use 'A:T1', as shown below. This
will multiply every entry in the column 'Data' by the value of
'A:T1'

Slide
The Slider is a numeric variable that has a default value of
zero. You can create a Slider by clicking the Slider button
and a variable will be added to the Variables list. You must
assign a name to the variable. In the example below, we
have named the Slider variable 'A'

You can also nest groups within groups. Group 'A' and 'B'
can contain the same variables names since the full name
also includes the name of the group
As you move the slider bar back and forth, the value of 'A'
will vary from 0 to 1. Note that the value of the slider is
limited to the speci ed range, but you can modify the
range to any values you choose. You can also select the
Integer check box on the bottom right to limit the numbers
that the slider moves between integers only

If your variable name contains a space you need to place
the entire name in quotes to use it in an expression

You can also minimize the space the Slider requires using
the disclosure triangle

Annotating

Valu

You can also add annotations using a comment block. Add
the comment block using the icon just to the left of the
group icon

Value is another numeric variable. In the example below,
we have a created a Value variable, changed the name to
'B' and assigned a value to '52.65'.

Value also has a toggle bar to the right of the number that
allows you to vary the numeric data. This can be useful
when you are using the variable in a function and want to
understand how the function changes with a given
variable. The range that you have available depends on its
latest value

By default, the comment block will simply have the word
'Text'. You can edit this entry and drag the comment block
to a new location

.
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from a drawing command. The drawing commands that
have extractable parameters include: Fit, Multivariable
Fit, Box plot, and Histogram
In the Number from Command variable, there are two
dropdown boxes. In the From dropdown box, you specify a
drawing command. In the Value dropdown box you specify
what to extract.

Tex

For example, below is a Number from Command variable
called 'D' in which we have yet to specify a drawing
command or the value to extract

The Text variable can be used in titles and labels and can
also be used to mask data. Below we have created a Text
variable called 'C' and changed its value to 'My Title'

You can place variable in an expression, as shown below
for the title eld for a graph. In this case, Title is set equal
to the 'C' variable

When we select the From drop down box, we see a list of
all the graphing commands in the speci c DataGraph le in
which we are working. In the example below, the le has a
Fit, Box plot, and Histogram. If a DataGraph le does not
contain any drawing commands with extractable
parameters, the From drop down menu has nothing to
select.

To select a variable, click the plus symbol to the right of the
Title eld. A drop down list displays the three variables in
this le along with a symbol denoting the variable type,
where 'A' and 'B' are numeric and 'C' is the text variable we
just created

For each type of drawing command, there are different
values that can be extracted. For example, if we select 'Fit
of y vs x' the Value dropdown box contains a list of
variables corresponding to that drawing command.
The graph using this Text variable now has 'My Title' as
the title

Once you select a Value, the red dot int the left hand
corner of the variable goes away and the value of the
parameter is shown

Number from Comman
Additional variable types are listed in the Other drop-down
list. The rst one is called Number from Command. This
variable type allows you to extract a single numeric value
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If you changed the drawing command speci ed in the drop
down box to something that does not have the same list of
extractable values a red dot appears indicating the variable
is no longer valid. Here we have changed the selected
drawing command to a 'Box Plot for y'. Since R2 is not a
parameter generated from box plots, the name changes to
red, indicating that this is no longer a valid choice

When you select a variable in this manner, the variable is
automatically created
You can also extract entire columns of data from a drawing
command such as the residuals in a regression. This is
discussed in more detail in the Data Table chapter. See
the section on the From Command column type

Number from Colum
When we now select the Value dropdown box, we have a
different list of possible values to extract that correspond to
the Box Plot command

The Number from Column variable allows you to extract
various summary statistics about a column of data. When
you create a Number from Column variable, you have to
specify the column of data you want to use and the type of
value you want to display. In the following example, the
Mean value is being calculated based on the 'y' column
and the variable is called 'E'

The values you can extract include

Once you select a valid Value for the speci c drawing
command, 'D' is now set correctly and the red dot
disappears again

You can also use the gear menu on the right hand side of
any drawing command to access the list of variables you
can extract. In the example below, a variable is extracted
from a Fit drawing command
which are described in the table below

From that gear menu, you will see the Extract as Variable
shortcut.

.
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Name

Description

Expressio

sum of ^2

sum of the squares of the values

max

maximum of a column

The Expression variable allows you to create a numeric
variable that uses a formula or expression. You add an
Expression column from the Other drop-down menu

min

minimum of the column

range

maximum minus the minimum

count

Number of the non-empty rows

mean

Mean of the column

median

Median of the column

sigma

Standard deviation

s

Unbiased estimate of the standard
deviation

sem

Standard error of the mean

The numeric value of the expression is shown to the right
of the name, which is set to '1' by default.
As noted at the bottom of the variable, you can use the
gear menu to add local variables, such as extracting
numbers from columns or commands (See the previous
sections on Number from column and Number from
command to learn more about these types)

You can also extract a single numeric value from a row by
specifying the index for the row.

This feature can be useful for animations since you can set
the index to a slider variable like 't' and restrict that to an
integer. Then the slider could be used to scrub through the
rows

When you add an entry using the gear menu, a section is
appended to the bottom of the variable, where you can add
a local variable, in the form of a number or expression

Text from Colum
Text from Column works in a similar manner as Number
from Column discussed in the previous section. You can
use this to select a particular row as well as return the
name of the column

This allows you to handle more complicated expressions
by breaking them down into multiple steps, or intermediate
calculations.
The Expression variable can also be used to integrate a
discrete set of data, given two columns as input, using the
Trapezoidal rule (https://en.wikipedia.org/wiki/
Trapezoidal_rule)
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Example 2: Using Multiple Steps

Once created, you can use this Expression variable in the
same way as any other numeric variables. Expressions
themselves are formatted in the same way as the
Expression column, but the Expression variable is used
to calculate a single number, as opposed to a column of
numbers.

You can add multiple steps to your expressions by using
the gear menu to add sections to the Expression variable.
This can be very useful when you have a complicated
expression that you want to break up into smaller
equations

Example 1: Using Global & Local Variables
An Expression variable can include other variables or
local variables that you create using the gear menu.

To illustrate, let's say that the area is needed to calculate a
cost, using a conversion factor '$PerArea'. You can add
additional expression lines and calculate the area within
the Expression variable

For example, say that you have two variables called
'length' and 'width'. You want to use these existing
variables to calculate 'area'. To do this enter 'length*width'
in the Value eld, as shown below

In the Value eld, the calculated value for 'area' is
multiplied by '$PerArea'.

The result of the calculation is shown to the right of the
variable name (i.e., 50)

You can select an entry by clicking with the mouse. Hit the
delete key to remove. You can also change the order of the
entries by clicking and dragging.

Another way to compute the same value would be to add
two expression lines using the gear menu to create two
local variables, one for length and one of width

Note that the calculations are computed using the order of
the entries. If you move a local variable below an equation
that is using that value, the color of the equation will be
red, to indicate an error.
For example, if we moved 'width' was below the calculation
for 'area', the 'area' eld changes color to red to indicate
that this calculation is missing a variable

Each of these are local variables and would not be
recognized outside of the variable called 'area'
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t-Tes

Fon

The t-Test variable allows you to calculate the p-value from
a three standard types of tests

The Font variable allows you to create a font that is added
to every font selector menu. In the example below, we
have created a variable called 'Fav Font'

1. One-sampl
2. Two-sampl
3. Paire
Create a t-Test using the Other menu. Select t-Tests to get
a menu of the available tests

Now, when we are selecting the Main font in the Style
settings of a graph, 'Fav Font' is listed as an option

After selecting 'Fav Font', the title and axis labels are
updated accordingly.

Once you create a test, an entry will be created in the
variables list to specify the data you want to compare

My Title
8
6

The hypothesis being tested is provided at the top of the
variable. Further options are shown below

4
2
0

tpdf(x,df) the probability density function
(pdf) from the Student’s t distribution, at
speci ed degrees of freedom (df)

To quickly create a color scheme, select Create Color
Scheme from within a command that has the color scheme
option

tinv(p,df) inverse of the cumulative
distribution function from the Student’s t
distribution, at speci ed probability (p)
and degrees of freedom (df)

.
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Color Schemes allow you to have a consistent color pallet
across graphs and can even be easily copy and pasted
between les
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fi

4

Color Schem

tcdf(x,df) the cumulative distribution
function from the Student’s t distribution,
at speci ed degrees of freedom (df)

tinv

3

Note that you can also customize every font in a graph
individually using the style settings. See the Chapter
entitled Layout for more information

There are also three functions related to the t-Test that can
be used to construct your own test as needed

tpdf

2

For any new graphs that are created, the Main font is
automatically set to the font selected from the last graph
created; thus, additional graphs would use the 'Fav Font'
as the Main font until we select another font for a particular
graph

The p-value can then be used as a label. See the Bracket
command

tcdf

1
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For example, we can create a color scheme for the Fill in a
points command

scheme, it only has one condition set. Speci cally, for data
points with a numerical value of 1. You can give it a name,
change the color, and add a title

This will create the scheme based on the selected data
column

To use the example from the previous section, we rst
have to add a Points command to the drawing commands;
the color scheme does not work with the Plot command.
Our graph now has both a Plot and a Points command

The graph will automatically re ect the new color scheme.

We also increased the default point size to 10 in the
Settings for the Points command. Since the points
command is listed last, these points cover the points from
the line command

My Title
8
My Title

6
8

4

6

2

4

0

1

2

3

4

5

2
0

The Color scheme can be used in the Points, Pivot, Pie,
Box, Lines, Connect, Range and the Bar command.

1

2

3

4

5

We can now change the ll for the Points command using
our new color scheme, 'Colors'. First you will need to open
the disclosure triangle for the Points drawing command. In
then Points command, you have several options for
de ning the Size, Color, Fill, and Style of the points.

Using the Color Scheme variable, you can set the color
used in a drawing command based on numerical values or
on text labels

Manually Create a Color Scheme
You can create a global Color Scheme variable manually
under the Other dropdown box. Select Color Scheme
from the Other dropdown box to create a new Color
Scheme variable.

For this example, we will change the Fill of our points to be
based on the value for 'x' and to use the color scheme
'Colors'
Color Scheme variables have a list of conditions and
corresponding colors. When you rst create a color

.
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Notice how the only point that is now drawn from the
Points command is at x=1 because this is the only Value
speci ed in our color scheme.
My Title
8
6
4

We can also create a Custom Legend and add the
variable 'Colors'
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5

Next, we can add more colors to our color scheme by
clicking the right plus symbol to the right of the rst entry

Below, we now see the graph based on the updated Color
scheme and the Custom legend. Note that the color is
assigned to each point based on the rst line item that is a
match in the color scheme
The colors can be set not only based on individual values
but also based on ranges of values. By selecting the drop
down menu for an entry, a list of options is given. As
shown below, hovering over each option, describes the
type of range.

My Title
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6

Low
Middle
High
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In the color scheme, the gear menu allows you to select
between a list of color presets. In this example, we have
three colors so the Matched Colors also has three colors

The color is set by selecting the box to the right of the
speci ed value or range

For this example, we have selected the blue-green color
scheme and our graph updates accordingly
My Title
8

In the example below, we have three possible colors
assigned to data in our graph. The range can also be set
with an upper value of in nity by selecting Option-5. We
have also added a better name for each color as 'Low',
'Med', and 'High'
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Custom Color Schemes

The gear menu can also be used to suggest strides or
unique text values based on the current content in the
graph where the scheme is being used, as shown below.
Note that if the color scheme is not being used by any
drawing command you will not see these selections in the
gear menu

When you have six or more entries in your list you have
the option of creating a custom color scheme based on two
colors, using the 'Current Range' option. Start by creating
a color scheme with the number of entries you require.
You need to have at least six entries for this option to be
available.

After selecting 'Unique text values', the color scheme is
automatically modi ed to correspond to the ve values in
our 'x' variable. The two new colors in our scheme are set
to the default of red. If we want to reset the color scheme,
we can select Matched Colors again.
Next, select the 'Current Range' option from under the
gear menu. You will see a color scheme that is uses the
rst and last colors you speci e

These colors will be populated into your color scheme
variable

In this example, we again select the ‘Blue green’ color
scheme. Now each point is a unique color
My Title
8
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Large Color Schemes

Reverse Colors

The number of color suggestions will vary depending on
number of items in your color scheme, such that you have
fewer options when your list is longer. When you exceed
12 entries only the 'Rainbow' and 'Dark Gray' scheme will
be shown as options.

The 'Reverse Colors' option simply uses the current color
scheme and reverses the order of the colors

The values stay the same but the order of the colors
changes

These options will create a discrete number of colors
based on the number of items in your list with no limit
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If we select this Marker Scheme for our graph the graph
will now contain the three different marker types.
My Title
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Transparency

Current Tim

At the bottom of every color scheme is an option for
changing the transparency for all of the colors. This can
be set to a value of a variable.

The Current Time variable tracks time in a given time
zone. An example is shown below, which has been named
'Time'.

By default, a Current Time variable shows the
year:month:day:hour:min. You can change the Increment
to track either days, hours, mins or seconds, as the
smallest increment

The individual tiles can still have transparency added. The
value at the bottom of the scheme will apply in addition

Marker Schem
The Marker Scheme command allows you to map
markers to values in your data. The way it works is very
similar to the color scheme.

The Time zone will be based on the time zone in which
you reside, known as 'Current'. You can change this to any
of the built-in options or specify exactly the Time zone you
would like

You can specify an existing Marker Scheme or create a
new one in the Style section of the drawing command,
which is directly under the Fill section

You can also create a Marker Scheme directly in the
variable section. Here we have created a Marker Scheme
with three different symbols
When you select Speci ed, an entry box appears to the
right. In this box, you enter the offset from UTM. This can
be either in the form of a time zone abbreviation or the
actual numerical offset from UTM.
In the following example, two time variables are created,
'Time1' and 'Time2'.
Both of these times use the
'Speci ed' option for central European time, but 'Time1' is

.
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speci ed using the abbreviation 'CET' while 'Time2' is
speci ed using the UTM offset of +1

We modi ed our example plot from the last section to
include this data.
My Title
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Let’s say that we only want to display one set of data at a
time. First, we can create a group mask for the drawing
commands. Set the Shared mask to the 'Label' column
and Include if value to 'Text is'. This is telling DataGraph
that we to mask that data based on a text value

Not all abbreviations are coded into DataGraph. If you
want to specify a time zone that does not have the
abbreviation built-in specify it using the numerical UTM
offset. For a list of time zone abbreviations and offsets see:
https://en.wikipedia.org/wiki/List_of_time_zone_abbreviations.

Text Men
The Text Menu variable can be used as any other text
variable. It consists of a drop-down box on the top right
that allows you to change the value based on the entries in
the list below. By default, there is only one entry, the word
'Text'.

Next, we need to select the drop-down menu with 'Nothing'
and select 'Create Text Menu'.

Once selected, DataGraph will create a Text Menu
variable named ‘match’ that contains the two unique values
from the 'Label' column
Using the Text Menu, you can create a variable that allows
you to easily toggle between datasets in a graph. You can
manually set up the Text Menu but it is much easier to use
shortcuts that have been created for this purpose
To illustrate, consider the following data where we have
two x and y sets of points that are labeled either ‘A’ or ‘B.

The Text Menu variable can then also be used as a token
in the title of the graph. As shown below, we replaced the
Text variable that we created earlier in this chapter with
the Text Menu variable.

Now the Text Menu variable is displayed in the title and it
also limiting the data displayed to that data set where
‘label’ is set to ‘A’
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DataSet = A
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3 - Give the set a name.
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If we toggle the Text Menu variable to equal 'B' the data
and the menu are updated in our graph

Now you can use this variable in a Mask. Thus, you can
change the values for a Mask by changing the selected
items in the Text Set

DataSet = B

8
6

The Text Set can also be used in the Masked column
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Text Set from Colum
The Text Set variable allows you to create a menu of
choices for using in a Mask.

The Animation Variabl

Unlike the other variables, the Text Set allows for multiple
selections. The list is also dynamic.

The bottom of the data list are settings for creating
animations. By default the name of the variable is ’t’, but
you can change this in the Animate entry box. You can
also specify the Range and Duration. You can force the
variable to change by integer values and to loop
continuously.

1- Create from the Other menu in the variables

2 - Select a Column using the menu

The animation variable can be used in any location a
number or other variable can be used. To begin the
animation, press the Play button. To export as a movie
(mp4) click the Movie icon above the Play button.
Note: Only text columns will work, all other column types
will show up in red
The set of entries is automatically populated by including
every unique entry. In this example, we have a text column
that contains just two entries "Control" and "Experiment"

.
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Example: Use Variables to Animate a
Function
Variables can be used in a variety of ways to create
animations. For example, you can create a Function
command and specify the function to be sin(2π*b*(xt))*x*(1-x)^a,where ‘a’ and ‘b’ are de ned as Variables.

In the above example, note that one of the variables is
speci ed as an animation parameter (default name is ‘t’).
This is the animation parameter set in the bottom left

You can have DataGraph animate this on the screen or
save it into a movie.
When you click the play button to the right of the slider,
DataGraph runs the animation on the screen. If you click
the Movie button above the play button, you create an mp4
le
Note that if the variables ‘a’ or ‘b’ are not de ned,
DataGraph will not understand the expression and display
it in red
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6. Layout Setting

Below the fonts, you set the color theme. You can use the
built in colors or you can overwrite the colors freely. The
colors that are selected in the style settings are then
accessible to the drawing commands. The drawing

There are three groups of settings that are used to de ne
the overall layout of a graph: the style, the canvas and the
axis settings. These are always located above the drawing
commands and are shown in the following imag

commands can pick those colors from a menu rather than
having to pick every color separately. The intent is to make
it easy to limit the number of colors you use and change
the color of several objects at once. By de ning them here
you can quickly change the color scheme of the entire
graph.

The style settings are used to set overall rules, line
thickness, font, color scheme and look of the axes. The
canvas settings are used to position the drawing area. The
axis settings determine how the data is mapped to the
drawing area de ned in the canvas settings. The axis
setting also allows you to set tick marks and axis labels.
This chapter focuses on these three settings. The content
of a graph is created by using the drawing commands,
which are described in the next chapter.

The style setting is the top entry,
and the icon looks like an artist
palette

Below the color list you specify the drawing style for the
axis as shown below. Note that by default the axis line is
set to be ‘pen’. The pen size is set in the top left corner of
the style settings. This works since the style de nes a
variable ‘pen’ that is accessible from all command entries
in the graph. When you change the pen thickness you
change the pen variable at the same time, and this will
therefore change the axis line. Since pen is a variable, you
can also use it to create expressions. For example, you
can set the axis line to be pen*2 to make it twice as wide
as the pen. You can also set it to '1.0' when you don’t want
it to depend on the pen thickness and always be one pixel.
This approach is used in the drawing commands to make
the default line thickness be the same as the pen
thickness

At the top you select the Main font style, the default pen
color, line thickness, ll for markers and marker size. By
default, drawing commands will refer to these settings but
that can be overwritten.

In the style settings, you set the grid style and the drawing
style for the tick marks. The position of tick marks is
controlled by the axis setting or by using the Extra Axis
drawing command

Styl

Below the axis style is the language and localization
settings. The date tick marks use names such as Jan, Feb,
and date formatters allow you to use week day names as
well. The default option is to use the settings in the system,
but if you want to share a le with someone in a different
country or use a different language for other reasons, you
can select that here. Here you can also specify whether or
not numbers should be formatted with a decimal or a
period

Once you open the detailed portion by clicking on the
disclosure triangle, there are a number of additional
settings you can change. These are grouped together by
function, with small spaces to separate them visually. The
rst group de nes the built in font styles. Some are used
by the axis settings, such as title and axis.

The drawing commands that draw text also refer to these
fonts by default. How to use them and overwrite style and
color is explained in the next chapter. By default, they all
refer back to the Main font de ned in the top line, so if you
change that font everything in your graph gets updated in a
consistent manner

You can save the settings by using the style set and
quickly switch between styles. For example, you can set
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up a grayscale vs color theme or thick presentation theme
vs thin scheme for printing.
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Title

y title

0.5

You can copy a style and paste it into a style setting in a
different graph. You do that by selecting the style setting
entry (thick blue border) and select Copy. Then go to the
graph you want to change and select Paste. You don’t
have to select anything

title

fi

fi

.


.


fi

fi

.


fi

.


A	

.


.


.


fi

.


fi

s


ticks

1.0

The axis range in x and y is computed in three steps as
described below
Step 1: Compute the union of all the drawing commands.
The drawing commands will affect the x and y ranges
based on the data that they are representing
Step 2: Add to that the numbers you specify in the 'Include
in x/y' eld inside the axis settings (see image below). By
default this is empty, which means that the range from step
1 is unchanged.
Step 3: Pad this range so that the drawing commands will
not go right up against the boundary. The default is 'Nice
Values' which uses a number of heuristics to pick the
padding. You can turn this padding off and pick other
methods using a menu
Step 4: Restrict this range, i.e., crop, by using the range
speci ed. By default this is -∞,∞ which means that the
range from step 3 is unchanged
For example, consider the case where you have a plot with
the x range set to [0.2,1.5]. This will be the result from step
1. If you leave the Include eld blank, step 2 is not
changed. If the padding in step 3 is set to 'Nice Values',
DataGraph will change the range to [0.1,1.6] to add space

52

s


x title

0.8

Once the size of the
drawing area has been
determined by the canvas
settings, the axis settings control how the data is mapped
onto the graph. This setting is partly also a drawing
command, in that it will draw the x and y titles when
speci ed and will draw tick marks when the Draw x/y
numbers is checked. This can also be accomplished using
the Extra Axis drawing command

The following gure shows how the margins are computed.
If you leave the margins as automatic in the canvas, the
margin is the sum of the tick mark space and title space.
Otherwise the margin space is exactly what you speci ed,
but this will not affect the tick or title space. Note that the
margins are set in pixels, but DataGraph has de ned
conversion constants so that you can type in 1.1in and it
gets converted to pixels.
Note that the tick spacing is adjusted in the axis settings.
The title space depends on what is drawn there and is not

fi

0.6

Axi

Another common setting you need in the canvas detail is
the margin settings. If you leave them blank, DataGraph
uses automatic rules to determine the space around the
data area. This space depends on the title, font, setting in
the axis, what drawing commands want to draw outside
the data area, etc.

fi

0.4

set directly. If you want to tweak it, you do that by setting
the corresponding margin

In the canvas, you can specify the gure size by using the
'Size' menu. Once you select the size
you can set the working magni cation.
This does not affect the output but
makes it easier to work on small graphs
or on machines that have very high
resolution. The Actual setting in the
magni cation menu makes the graph
appear at the same size as when you
print it. Otherwise a graph will look a lot
smaller on the screen than when you
include it in a text document. It is better to set the size of
the graph to the nal size in DataGraph rather than scale
the gure in another program (e.g., word processor)
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0.2

title

below

0

The canvas sets the drawing area for the graph and the
title of the graph.
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to the left and right. Step 4 is by default set to -in nity to
in nity and will therefore not restrict it at all. Note that this
padding is independent of the graph size.

the current restriction range for the x and y axes. By
moving the mouse horizontally, you only crop the x axis,
and only vertically, and you crop the y axis. If you do this
accidentally, the simplest thing is to move the mouse
towards the starting point to not crop anything or hit undo
after you release the mouse

In this case, you might want to include the origin. Do that
by typing the number 0 into the Include in x eld. This
means that step 2 will make the range [0,1.5] and then the
padding will make it [0,1.7] to keep things symmetric.

Once you have a cropped axes you
can see it by the small icons that
show up in the top part of the axis
settings. This means that the range is restricted, and by
clicking on these buttons you reset the range to -∞,∞

You can also specify the range exactly. Assume for
example that you want the range to be exactly [0,2]
independent of what data you have. Then you set the
Include and Restrict elds to 0,2. Here the padding option
doesn’t matter.

If you then move your mouse over the axis, a oating
window pops up on top of the axis, as shown in the
following image. This window allows you to adjust the
range.

This means that any data outside that range is not visible.
If you are zooming in on data, this is what you want. If you
want to see whether or not there is anything outside, but
still ensure the range includes at least [0,2], then you leave
the Restrict x as is and turn off the padding.

You can remove the crop, click on either end of the white
bar to adjust one of the ends or click and drag the entire
bar to translate the range. You can also use the scroll
functionality to translate the range. Note that if you scroll
up/down for the x axis and left/right for the y axis, you
zoom in or out.

Axis types
The axis type determines how a
coordinate is mapped. The most
common is linear, which means
that each unit on the axis has the
same length in the output. Logarithmic
means that rst DataGraph computes the logarithm of the
data and then draws the result linearly. Logarithmic is
better when you draw stock prices and other data where
relative growth/reduction is more important than absolute
size

Split Axis
By default, the entire drawing region is used by the axis
speci ed in the axis setting. To have more than one graph
in the drawing region, you can split the x or y axis. You can
split either axis using the Split X or Split Y buttons to the
right side of the canvas setting

Crop using the mouse
When determining the region for an axis, and this also
holds for the split axis described below, the last step above
(4) is to crop the range using the Restrict eld. It is
certainly possible to enter in your own numerical value
here, but if you just want to zoom in, this is not a very fast
method. DataGraph has a number of methods to set and
modify the cropping range using the mouse and scrolling.
The most common method is to click in the background of
the axis and drag the mouse. Once you have dragged it a
few pixels, you see a blue
selection interval. As shown
to the right, if you drag the
mouse back towards the
starting point it will vanish.
When you release the mouse, these intervals will overwrite

When you click the Split X or Split Y button you get
additional settings just below the axis
settings. A small axis selector is also
added to the right hand side of each
drawing command that represents the drawing region and
highlights the location for the drawing command. You can
easily move a drawing command by simply clicking a
different axis.

.
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The simplest and a common use for this is to create what
is typically called Double Y graph. For example, consider
the following line plots that have very different y ranges

Joining the Y axis instead gives yo

To overlay them, you rst need to
split the y axis. In the plot
command for the red line, click on
the small axis selector that was
added to the right side. Now the graphs
show up one on top of the other, as shown
below. The nal step is to overlap the two

If you want fully independent graphs, you should create
them as separate graph (explained in a later chapter) and
combine them using the Graphic command
You can adjust how the split axis is joined. In the graphs
above, the Box style in the style setting is set to Axis Box
instead of the standard 'One Box'. You can change that
style, and inside the Split axis entries you can adjust how
the break in between the sub-axes is drawn. For Offset
box style and break separator you get the result shown
below.

y axes. This is done by selecting 'Join Y' on the right hand
side of the canvas (see above image)
If you split the x axis once and the y axis once you get a
2x2 matrix of graphs. Each row shares the same y axis
and each column shares the same x axis. The ranges are
computed independently for each axis so the x axis for the
rst axis applies steps 1-4 listed before but only for the
drawing commands that are in the rst x axis

Split axis spacing
Inside the split axis you can adjust the spacing and layout.
The following gure shows what each eld controls
The main axis settings only has controls for the space for x
and y tick marks. The overall size is controlled by the
canvas setting. The width/height elds are relative to the
main axis. The space between axis can be adjusted in

You can overlap the two x axes by picking Join X.

.
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Axis Labels

several ways. If you set it to Exactly... you can type in the
exact space in pixels/mm/inches, etc

bet

we
en

Height, relative
to main

1

0

If you specify the x or y title, this command will draw them
centered with the y title rotated 90 degrees counter
clockwise. This is the most common way to draw axis
labels, but if you want a more exible method you can
leave the labels here blank and use the Text command to
draw the labels. This command allows you to draw it noncentered, rotated left aligned, etc

Width, relative
to main

The spacing for the x and y tick marks are controlled in the
axis entry. By default the space for the y axis expects the
number to about 3-4 digits. If you only have a single digit,
such as the integers 1,2,3 this is too wide so switch the
space to 'Narrow'. This scales with the font size. This is
used as part of the automatic margin calculation and to
nd how big the tick mark space is, and this will move the
title.
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7. Drawing
Command
Element
One of the main differences between DataGraph and
traditional drawing environments is how settings for
drawing elements are handled. In most other graphing
programs, when you see a line or text in a graph, the way
to change the line thickness, etc. is to click on an element
of the drawing, expect it to highlight in some way, and
then, either use a dialog box (menu entry or double click)
or an inspector window to change the properties behind
that element. This same inspector would be used for each
line, and you change them one at a time. These settings
are stored somewhere behind the scenes for every entry,
and just a sub-set is shown at any given time.

The UI is fairly compressed, and throughout the UI, as you
select menu entries, you can expect additional details to
show up to the right of the menu. As an example, consider
the line options for the Plot command. The default is to
connect the points by straight lines. But there are two other

In DataGraph, every drawing element is visible in the
'drawing command list'. When you click on a drawing
element, the drawing element does not highlight on the
screen. Instead, the applicable drawing command is
selected (highlighted with a blue border). The UI is always
visible, even when the drawing element is not selected.
You can copy settings between commands, compare them
side by side and view all of the settings at the same time.
Every change you make is applied immediately, and if you
didn’t mean to make a change, you can use the undo
mechanism or change it back.

options, Steps and Smooth. If you pick Steps there are
three different step styles, so to the right of the
Connections menu you get a second menu which allows
you to pick which style. The smooth connection is a spline,
and there are two different types of splines that you can
pick from a menu. With very few exceptions, selecting an
entry in a menu will only add or remove user elements to
the right or below the menu

This chapter goes through the common building blocks
used in all of the drawing commands. The next chapter
explains the commands in more detail.

Gear men
The gear menu on the right hand side of the drawing group
also has some very handy short cuts. You can use the
gear menu to copy a shared mask to another drawing
group. If you have a split axis on your graph you will also
be able to move all the drawing commands in the group to
another axis

Level of Detai
There are two levels of detail for each drawing command.
The top is always visible and is typically just two lines.
These are the settings that you frequently adjust and gives
enough information to get a sense of what is drawn. For
example in the case of a Plot command, the top two lines
show the x and y columns that are used, the line style and
point style. When you open the little disclosure triangle you
see the rest of the settings, such as if it should be lled,
how to connect the markers, if you want a label printed at
each data point, set the error bars, etc. In the lower right
corner is a small ? button which will bring up the on-line
help for that drawing command

Several command also have the ability to extract data
from the gear menu. For example, the gear menu in the
Label, Bracket, Region, and Range commands can be
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used extract the locations that de ne these annotation
elements into a variable

Selecting Data Column
For drawing commands that use
data from the table, the way you
refer to the data is by selecting the
column from the column menu.
This shows the column in the order
that they appear in the column list.
Any column groups will show up as a sub-menu. You can
also drag a column from the column list and on top of the

Click Events
For the some commands, you can set up Click Events
using the gear menu, to create interactive graphic and
dashboards

column menu. This selects that column. Once a column
has been selected, you can change the name of the
column and move it around. The column selector keeps
track of it. Columns that cannot be used, such as a Text
column if you need a numerical column, are drawn in red.
You can still select them, but they won’t be used, and
typically nothing will be drawn. When you select the
column, DataGraph pops up an error message that
explains why the entry is red. Many drawing commands
cannot use the # column. This is because # differs from a
normal column in that it has no length

After you select "Enable click action", a pop-up menu is
shown with the options available, which depend on the
type of command.

In the above example, there Click action is set up to
overwrite a text variable called "IsGroup". That variable
can be used as a Mask in other commands. This means a
click on a Pie Chart can be used to select the data that is
drawn in another graphic.

Hide/Exclude

When you move the mouse away, the pop-up menu
vanishes but the small icon remains. Click this icon
anytime to activate the pop-up menu

Each drawing command has a Hide and Exclude check
box in the right hand corner of each drawing command
allows you to remove the command from being drawn
without having to delete the command.
Hide means that even if the graphic is not visible it affects
the bounding ranges for the axes. One common use is to
use the hide check box to toggle a plot or point on and off

You can also deactivate the click events under the gear
menu. Your last selections will be remembered if you
toggle it back on

The Exclude check box means that the range of the lists is
not used to determine the range of the axis. That means
that the content is essentially part of the background.
Thus, if there is a line at x=10 it won’t be visible unless the
range includes the value. If the check box is not selected
then x=10 is considered part of the range and unless it is
explicitly restricted the x axis will include that value

Click Events can be created for the following commands
•
•
•
•

Point
Bar
Pivo
Pi
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Histograms and ts are still computed even if they are
hidden or excluded, so you can use the results in text
elds

Font Styl

Colo
You can tweak the color for every drawing element. For a
good graph you should use color sparingly and
consistently. Often you want to use the same color for a
number of different elements, and rather than having to set
the same color over and over, DataGraph by default sets
up a color theme and you can pick colors from there. You
can still specify colors for a single entry and have
hundreds of colors in the same graph

Font speci cation is set up similar to the color picker in that
by default, DataGraph sets up font styles that make it easy
to use a uniform font, sizes that are consistent and when
you change the main font everything changes with it. At the
very top, the rst line is the main font. In the detail settings
are four more font styles - Title, Axis, Label and Local.
Drawing commands will then refer to those fonts and allow
you overwrite aspects of them.

To explain this mechanism, consider the color picker that
controls the line
color for a plot.
This is a menu, and when you
click on that menu you will see
17 preset colors and at the end
the 'Color Picker'. If you select
the color picker you get a small
When a drawing command uses a font, the rst step is to
select the font style from a menu. There you can pick from
the font styles de ned in the style settings or variables.
You can then overwrite certain aspects of the font. This is
done by the next three menus to the right of the font menu.
There are three things you can overwrite. The rst is the
font style, as in changing it to italic or bold
rectangular color tile. When
you click on the border around
the tile, you bring up the
standard color picker from the
operating system and you can pick the color. Click on the
tile again, or click on a different tile to deselect the color
and stop sending color changes to this color selector. You
can drag the color tile onto another color tile. The problem
with setting each color by using the color picker is that it is
tedious to change a color if you decide that that you want a
slightly different hue of green. You then need to change
several drawing elements. This is why it is better to use
one of the 17 prede ned colors by selecting them from the

The next menu allows you to overwrite the size. This is
relative, so you specify how much the font size should be
changed

menu. The colors are de ned in the style settings. The pen
and point are de ned at the top, and the line, error, ll and
background color are de ned there as well. These are
de ned with the standard color pickers. So consider
referring to those colors, and then set those using the color
picker
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The third menu allows you to overwrite the color. The top
entry just uses the color you de ned in the parent font, but
you can choose a color from the presets de ned in the
style settings or overwrite it using a color picker.

Mas
When you select columns, the drawing command will look
at all of the rows in those columns. As you add/remove
columns the drawing command is immediately updated.
However, in some cases you might want to only use a subset of the data. For example you want to only create a
scatter plot for rows that have a particular label, take
histograms only when a given value lies in a speci ed
range, etc. This is what DataGraph calls a mask.
You can specify which rows to include, and any other rows
are removed for the purposes of that drawing command.
For example in the Points command, which is used for
scatter graphs, by default the mask entry is 'Draw all',
indicating that every row will be used.

The style settings also allows you to overwrite aspects of
the main font when specifying a font style in the same way.
Here 'My font' is de ned in the variable list. Main is the font
de ned in the rst line.

You can select any column here, so you can mask based
on a column that is different from the x or y coordinate.
Once you select the column, new entries will show up on
the right of this menu.
The Main font also has a font selector that allows you pick
from common fonts that are included with the system.
Since the other fonts typically are all based from this font,
everything changes consistently.

The next entry you change is how to determine if a row in
the column should be included or not. The rst two entries
use a range, but for <, > ,... this range changes into a
speci c number. Note that both the number and the range
can use variables, so you can specify variables a,b and set
the range to 'a,b' so that you can easily change a and b
using a slider.

Another option for the main font is the LaTeX font. This is
intended for people that use the LaTeX package to typeset
papers, and this way the graph will have a consistent look.
Using the small + button to the right you can add additional
masking lines. This allows you to limit the mask further.
All font selectors then have a 'Specify...' option that allows
you specify the font by using the standard font picker from
Apple. Just click on the font name to bring up the font
selector.

Pop up slide
There are a lot of numerical elds in DataGraph. They
control point sizes, line widths, offsets, histogram bin
width, etc. When you enter in a new number you have to
close the eld before the change takes effect. You can
close it by either hitting return, tabbing out of it or clicking
with the mouse somewhere to change the focus. Changes
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are made immediately, but to make this even faster and
more immediate DataGraph allows you to change many of
those values by using
a pop up slider. Next to
most of the numerical
elds is a small icon of
a slider, a black slider
with a small blue
button. When you click on that, a small black slider pops
up. The range of this slider is automatically determined
based on the current value and the valid range for that
parameter. For example to change the marker size, just
click and drag the mouse until you get a size that you like.
If the range is not suf cient, move the mouse all the way to
the top/bottom of the slider, release the mouse and click
again. Since the range is determined by the current value,
the slider range has changed the next time you click it

much. But TeX introduces a very compact notation to insert
characters and commands using the \ character. So the
character α is written as \alpha followed by a space.
Similarly \beta, \gamma, \delta, \nu, \mu, etc
This is used for a lot more special characters, and they are
listed in the on-line help. Or you can look for a LaTeX
reference. Some examples are \euro, \pound, \permille,
\leftarrow, \longleftarrow

Super/Subscript
Super and subscripts are
implemented by using the
special characters ^ and
_. This means that if you
want to type x squared
you use x^2, And sub scripts are done with _, so if you
want to create a subscript 0, type a_0. The sub/super
script only works for a single entry. To apply it to a longer
text, enclose it in curly braces, such as a_{10}

Text label
Text labels are used in a number of places including: graph
titles, axis titles, and labeling speci c points within a graph.
You can put labels at individual data points, to mark
connecting lines, inside legends, etc.

Since \, ^, _, {, } have special meaning, you have to use a
workaround if you want to use them in a label. You do that
by putting \ in front, that is \\, \^, \_, \{, \

There are two sources for text, either you specify it in a
text eld inside the drawing command or it comes from a
data column. A text eld allows you a lot of exibility to
build up the text, and you can use variables and properties
from inside drawing commands. For example, you can put
the result of a t command inside a text label, axis title etc
using the token mechanism. When you use a column,
either numerical or text, you can adjust the formatting to
set the number of digits for numbers, append and prepend
text such as currency, etc.

Math symbols
In addition to the greek characters and super/sub scripts,
DataGraph contains some basic equation structures such
as square roots, fractions and sums. If you have very
complicated equations you might want to use a small
LaTeX to PDF utility such as LaTeXiT where you can use
the full power of LaTeX, but in order to use that utility you
need to install the entire TeX package. The subset that
DataGraph implements is completely independent of any
TeX distribution

The text layout is explained in more detail in the on-line
documentation. The next sections explain some of the
most important and frequently used aspects

The main equations structures that are implemented in
DataGraph are \frac for fractions, \sum for sums and \sqrt
for square roots. So for example \frac 14 is the 1/4th
fraction. If you want multiple characters, enclose them in
{ }, for example \frac {17}{19}. \sqrt 2 is the square root of
2, but \sqrt{23} is the square root of 23. For sums you can
for example use \sum_{n=0}^{\infty}. Note that the
expression parser is also fully unicode compliant

Greek/Special Characters
Every text eld as well as the data table supports unicode
characters. That means that in addition to cyrillic, greek,
accented characters etc you have access to a lot of the
symbols such as daggers, copyright signs, etc. The
standard method to insert these characters into text is to
bring up the Font panel and click on the Character...
palette. This is certainly possible in DataGraph as well, but
involves a number of clicks. DataGraph speeds this up by
using notation borrowed from TeX (LaTeX). LaTeX is not
what you would call a WYSIWYG editor, and even though
it is used extensively in math and physics it isn’t used that

Style and color
You specify the font for the text label by using a font. This
means that you can’t use different fonts in the same label.
Where people typically need that is if they want to make a
word bold or change the color of a part of the text.
DataGraph supports this using a different mechanism, and
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one that works better with the token mechanism. To switch
to bold use the \bf or \bold command. Similarly \it (\italic)
and \rm (\plain). This is a switch that is then in effect until
something else is speci ed. You can use {} to limit the
range, for example 'this {\bf box} is bold' is equivalent to
'this \bf box \plain is bold'

If you select the 'X Label' entry from you get a blue token
in the text eld

This token is the name of the column that is selected. So if
you select a different column in the plot command, the x
title will change
Color is speci ed similarly. DataGraph understands \red,
green, \blue, \black, \whit

You can also use tokens to extract a t parameter from a
Fit function or statistic from a Histogram command. The
legend eld inside the plot drawing command uses tokens
to create the 'y vs x' name, as shown below

Multiple Lines
If you paste in multiple lines from a word processor,
DataGraph will draw multiple lines for the label. But typing
in a multiple line text label is not immediately obvious,
since hitting the return key will close the text eld.
DataGraph does not wrap long lines automatically, so you
have to specify where the line break should be. Typing the
line in a different application and pasting it in is tedious, so
DataGraph has a command to insert a line break. This is
the \n command. So 'First line\n Second line' will give you
a two line label. Note that the space after the n in \n is
crucial since there are several commands that start with n.

Formatting
Number tokens, either from a variable or a t parameter
etc need to be converted into text. You can adjust the
format that is used by clicking on the small pop-up menu in
the token. This also previews what the number will look
like formatted

The space after \n is absorbed so if you want a space at
the beginning of the next line you need to put two spaces
after \n
If the parameter is a date, the format options are different

Token
Tokens give you a way to include a dynamic link in a text
label. To the right of the text eld there is a small + menu
where you can create a link. The link points to either a
variable or a property inside a drawing command
For example, the axis settings entry has elds for the x and
y titles. If you click on the + button to the right of the X title,
there is a sub menu for the plot command inside the graph.
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You can control the color and the width of the outline. The
font outline is available in the Text, Label, Points and
Scalar eld commands

Label
Several drawing commands allow you to display values
from the data table or computed results as text labels. For
example, the Plot and Point commands allow you to draw
a label at each x,y coordinate. The Bar command allows
you to draw a label at each bar in a graph. The Pivot
command can draw the underlying value on top of each
bar.

Text

Text

Text

Fill Styl

For each of the above examples, you can set the format
that is used to convert numerical values to text. There are
two types of formatters, one for numbers and another for
dates.

Several drawing commands allow you to ll in a solid
region. The ll settings are similar between drawing
commands. The default is typically no ll, and as you
select the ll method, the view to the right of the menu
contains additional details. For example, the 'Solid color'
setting shows a single color selector

For example, you can adjust the number format and set a
pre x/post x for every label. You can add a currency label
such as \euro , \pound, or $ before or after each number. If
the column is a date column, the formatting options
change so that you can specify the day format from a
preset or your own format string
The pattern allows you to vary the hash pattern,
background color, line color and width. This pattern is done
by drawing lines and not a bitmap

Text Format
When a text column is selected as a label, the Format
menu shows the default option of ‘Automatic’. When this
option is used the character formatting described in the
previous sections will be applied to display the label (e.g.,
math symbols, subscripts, etc.).

The Noise ll option is a ll based on a procedural texture.
This is a fractal noise function, called Perlin Noise. You can
adjust the background and foreground color, the weight
and noise size.

If you do not want to the label text formatting, change the
Format menu to ‘Raw Text’

Background
Perlin noise is a spatially coherent noise function between
0 and 1. If the weight ( eld on the left) is 1, the noise is
used to switch between the colors. If the weight is 0.5, the
noise is scaled by 0.5 and then used to switch between the
colors. The eld on the right is the grain size.

In several commands, labels have a Background option.
By default the background is set to ‘None’, but can be
changed to show a rectangular shape or an outline around
the text, referred to as a stroke in graphic design

For interesting effects you can set the colors to be semitransparent. The noise is computed dynamically and when
you print or export to pdf the noise is computed at a higher
resolution than the screen resolution so it will print
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properly. This is implemented as a bitmap, so the pdf/eps
output le can be large

If you want to exclude a group of drawing commands from
being drawn DataGraph gives you several options: 'Hide
all' hides the drawing commands but will not change the
extent of the axis; 'Exclude all' removes the drawing
command from the graph completely and will not consider
them in determining the extent of the axis; and 'Not in
range' will still draw the drawing commands in the group
but does not consider them when determining the range of
the axis for the graph.

Drawing Group
When you have more than one drawing command for a
graph, you can combine them into a Drawing Group. There
are two ways to create a drawing group. You can rst drag
the cursor over the commands you want to group, as
shown below.

There are also two conditional Hide and Exclude options
that can be useful for animating your graphs
Groups can also be very useful for modifying the data that
is being drawn by your commands. You can drag and drop
a data group onto a drawing group and the column
references will all be replaced, assuming you have
columns in the data group that correspond to the names
used in the drawing commands

Next you add a group using either the icon in the top right
hand corner, as shown below, or by selecting
Command\Add Drawing Group from the le menu

You can also add a mask at the drawing group level that
allows you mask the data used in the drawing commands
without having to add a mask to each drawing command
individually. For example, you can have a categorical
column used to limit the data that is drawn based on a text
value. These can also be tied to variables as described
further in that Chapter.

The highlight drawing commands will now be in the
drawing group. You can also create the group rst and
then drag the commands into the group. Either way, the
group is created as shown below with the discloser triangle
showing so you can see the contents of the group.

Multiple Graph
DataGraph allows you to create multiple graphs from the
same data set, and create composite graphs. To create a
new graph, click on the Add Graph button that is in the
toolbar

You can name the group and close the disclosure triangle
as a way to organize your work space.

You also have the ability to very easily toggle data from
being displayed on your graph. By default the group is set
to 'Show all', meaning that all the drawing commands in
the group are included in the graph. Note that they are also
used to de ne the extent of the axis range, along with any
other drawing commands that may be in the graph

This adds a new empty graph to the DataGraph le.
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If you hold down the option key you get a duplicate of the
current graph. You can also use the New Graph sub menu
in the File menu to create the graph.

Composition' option in the New Graph menu does the
following three steps
Step 1: Set the axis style to 'Only Axis'. This stops you
from drawing the box around the graph

At the top of the window you get a horizontal list of the
current graphs. Each graph is updated in real time so as
you change the data you see the changes in all of the
graphs. For graphs that do not have a speci ed size, the
size is given by the size of the current drawing view. As
you change this view, either by changing the window or
changing the splitters, the other graphs are updated

Step 2: Turn off numbers for the x and y axis in the axis
settings. This removes the remaining two lines

Step 3: Set the margins around the axis to 0. This means
that the underlying axis lls the entire graph region

When you move the mouse over a graph thumbnail you
will notice a few controls. On the top left side you see a
button to delete this graph (undo if you accidentally hit
this). Below that is the clone graph button and the button to
create an empty graph. At the top is a text eld so you can
name the graph. This is partly for organization, but also to
be able to export multiple graphs at the same time
(explained in the next section). If you don’t specify a name
the 'Untitled' tag will vanish when you move your mouse
away. In the top right is the ag check box. This is also
currently only used for exporting graphs

There is still an axis in the graph, and if you draw any plots
it will show up. But for compositing other graphs, all you
need are a number of Graphic commands. The Graphic
command is then set up so that the source is one of the
other Graphs in the le. Use the offset eld to position
them.

You can also drag the thumbnails to reorder the graphs or
drag a command onto a thumbnail to add a copy of the
command to that graph. Note also that you can select the
style, canvas and axis and copy them to the clipboard.
Then you can go to a new graph and paste in the settings.
This is one way to propagate style changes to other
graphs

Combining graphs

It is recommended that you specify the size for all of the
graphs, including the composite graphs so that the
positioning and size of the graphs is more predictable. This
also allows you to align the graphs. You align them along
the boundary of the drawing canvas, but if the margin
computations are the same the axes are aligned as well

The split axis allows you to create multiple axis which
share an x/y range. But in some cases you want to put two
graphs next to each other. To do this in DataGraph, create
each graph as a separate graph page, and then create an
additional graph to combine them
This takes a little bit of tweaking, since by default a new
graph is set up to draw a graph so it has an axis. The 'For

.
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Example: Multiple Graphs on a page
Take as an example a case where you want to draw three
graphs in a table. If they have the same y axis range, you
might want to use the Split axis functionality; however, if
they are truly independent create three separate graphs
and combine as described below
First step is to create the graphs that should be composed
as separate graphs in the same DataGraph le.
Step 5: Now create two more drawing commands. Set the
anchor to lower left but in this case set the offset to '4in,0'
and ‘4in,2in'.

By default a graph lls the lower right corner of the
DataGraph window and will resize as you change the
window size. For compositing graphs this is not helpful, so
specify the graph sizes exactly by using the Speci ed...
option in the canvas.
If the drawing commands have the same font sizes axis
padding the axis will align exactly. If you change the style
in one of the graphs, you will most likely want to copy that
style over to the other graphs. To make this quick, go to
one of the graphs, select the Style settings (top entry),
select Copy and then go to the other graphs and select
paste. You can toggle between the graphs by using the left
and right arrow keys while holding down the command key.

This will set the canvas size exactly. If the result is going to
be printed the graph size will be surprisingly small on the
screen so set the magni cation level so that you can view
things either in actual magni cation (same size as printed)
or in 2x,4x view
In this example, the rst graph has size 4x4 inches, and
the other two are 4x2 inches. This means that the
composite graph will be 4 inches high and 8 inches wide.
Step 1: Create a composite graph from the File menu
Step 2: Set the canvas size to 8in,4i
Step 3: There is one Graphic command already in the list,
and select Source as 'Graph' and click on the graph that
you want to display
Step 4: Set the Anchor to lower left and the offset to 0,0.
The graph command will look like this
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Axis selecto
DataGraph allows you to break down a graph into subaxis
1

0
1

0
0

0.5

1.0

0

0.5

1.0

0

0.5

1.0

Each sub-axis is created by clicking on the Split X or Split
Y buttons in the canvas settings

The standard axis settings is for the axis in the lower left
corner, and each split axis gets it own settings where you
can specify the axis type, ranges etc, just like the axis
settings. To indicate what you are changing, there is a
small schematic drawing on the far right side. You cannot
change anything, it is just to indicate what portion of the
graph you are adjusting

Each drawing command changes a little bit. It gets wider
and on the right you get a user interface that looks similar
to the graphic in the split axis, but this is a controller you
can change.
Each axis is drawn as a tile, and this does not change
even when you join the X and Y axis in the canvas
settings. When you click on the tile, the drawing command
is now drawn in this axis, and the axis ranges are adjusted
accordingl
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8. Drawing
Command

Plot can draw lines between the data points, while Points
only draw the data points. The Points command is more
exible for drawing points since it can vary the size, color
and marker type based data values.

The Drawing Commands are the way to draw, analyze,
and annotate graphs. Every time you add a command a
command object is added below the Layout Settings. The
screen shot on this page outlines a several commands.

The Bars command gives you the standard bar graph,
side by side and stacked. The Bar command allows you to
plot bars on x-axis locations. The Pivot command also
draws bars but is also for binning and analyzing data

The screenshot on this page has the layout swapped.
When you are focused on creating and modifying the
commands, it can be helpful to swap the commands with
the data, using View > Swap Layout, or click the Swap
icon in the bottom left of the data table

The Fit command computes a t function to a x,y data set.
On the graph, the t is drawn, but inside the command you
can view additional statistics to assess the t quality. There
is also a Multivariable Fit command
The Function command allows you to draw an analytic
function, where you specify the function as y = f(x). f(x) can
depend on variables, so you can easily explore how
functions depend on parameters as well as just overlay
them on data

The previous chapter explained the building blocks for
drawing commands and common elements that drawing
command share. This chapter goes through each
command individually to highlight the functionally of the
commands

There are a number of annotation commands. Label and
Text allow you to add text descriptions to a data point.
Range and Region commands can highlight certain parts
of the domain

To get additional on-line help documentation, click the gear
menu in the top right corner of any command, and click
HELP in the menu
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The Extra Axis command allows you to both customize
the look of the axis more than the standard settings and
also specify unit conversion and coordinate shifts

The Plot command connects points in the graph with lines.
The x values don’t have to be increasing, but if there is a
gap in the data or a row that can’t be understood,
DataGraph breaks the line.

Magnify allows you to very quickly include a zoom up of a
part of the graph. This is similar to the Loupe tool, except
becomes part of the graphic

For example, consider the following data

The Graphic command allows you to add images, or even
other graphs from the same le.
Histogram and Box are for statistical analysis of the data.
This allows you to visualize and quantify distributions
Lines and Connect can be used to annotate or as low
level methods to draw data. You can draw a line
connection from values that are typed in as well as coming
from columns

When we plot this data, the gaps in the rows are
represented in our graph
5
4
3
2
1

Plo
The Plot command is one of the main methods for data
visualization
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Expand the command by clicking the top left corner. Then
check Bridge gaps in data to ignore the breaks and
connect all the points.

4
3
2
1
1

2

3

4

5

6

You specify two columns, one for the x coordinates and
one for the y coordinates. You can specify how DataGraph
connects the coordinates and if it draws a marker at each
coordinate. This is all accessible at the top of the Plot
command. The line thickness is by default given by the
pen variable that is de ned in the top entry (style settings).
You can change the default or change the line width for
each plot
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Plot command basics

Connections

Multiple plots in the same graph are done by creating
multiple Plot drawing commands. There is a shortcut
available for drawing a plot. Select two columns in the data
table and hit the Plot command icon. This creates a plot
with those columns

You can adjust how the coordinates are connected by
changing the Connections menu in the command detail
Half
Up-Side
Side-Up
Smooth
Lines
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Using Fill

Note that both data sets are plotted using a smooth line.

Below the Connections option is the Fill settings. By
default these are set to ‘Nothing’, but there are several ll
types
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1
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Mask

This allows you to ll the area below the graph or between
two graphs. Select a type for the ll to appear

Below the ll is the mask option. This allows you to mask
out parts of the rows. This is a gap that is treated just like a
blank row; thus, if Bridge gaps in data is not checked you
might get a very spotty line between the points

Adding Labels
Below the mask is the label option. This allows you to label
each point on the graph. The offset is either a single value
or a coordinate.

The default is to ll in the Y direction between the x,y graph
and the X Axis.
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If the offset is a single value, DataGraph tries to gure out
how to offset the number so that it won’t overlap the line. If
you specify two values, this offset is used at each point.
The default Offset is ‘point’, which is a variable de ned in
the style settings.

The ll style can be changed in several ways. You can
change the direction of the ll or you can select a column.
For example, here is data for x and y along with another y2
column

Error Bars
At the bottom is the error bar selector. By default, it is set
to 'No Error', but there are several entries in that menu
The Fill style is modi ed so the ll goes between the lines
for y and y2. Here the Fill type is ‘Noise’
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Plots Command Basics

When you select one of the entries, the Plot command
gets larger and additional column selectors and options
show up. You can select up to four columns in both the x
and y directions

The Plots command works with numeric data in multiple
columns where you have a single x and multiple y's (as
shown below) OR a single y and multiple x's

3
2
1
0

1

2

3

You can create a Plots command by selecting Add Plots
under the Command menu. This will add you a command
where no data is speci ed.

If you select one column for the error, the error is the same
in the positive and negative direction (symmetric). But if
you select 'Different' for the negative error you get an
additional column selector so that the positive and
negative error can be different. If a row is empty, no error
bar is drawn. For example, in the graph above, the rst row
in the 'neg y error' column is empty

Use the drop-down menu to specify the 'X' column. The
Type is used to toggle between a graph where the y
values are a function of x, 'Y(X)', or x values as a function
of y 'X(Y)'. In other words, you can easily change your
lines to be oriented horizontally or vertically.

Diamond and Ellipsoid are used when you have error
speci ed in both x and y direction

You can add lines by selecting and dragging from the
Column de nitions list and dropping on the Plots
command.
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Plot

Another shortcut is to highlight all the columns in the
DataTable that you want to include with the leftmost
column being your x column.

The Plots command allows you to create line plots with
varying colors for each line more easily than using only the
Plot command. For example, to create the graphic below
you would need to use sixteen different "Plot" commands,
while you only need one "Plots" command
10

y1
y2
y3
y4
y5
y6
y7
y8
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y9
y10
y11
y12
y13
y14
y15
y16

Next, select Add Plots under the Command menu

10

The following command is created, along with the following
graph with a line for each column of data.
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On the Main view, you can customizing the Lines or
Points settings.
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4

5

Example: Using Color Schemes
The real bene t of the Plots command is the ability to
create multicolored line plots very quickly using Color
Schemes

This will change the setting for every line in the graphic.
10

For this example, we will draw smooth lines for sixteen
different columns of data, where each line has a different
color

5
0
1

2

3

4

First, we create the Plots command by selecting all of our
data and selecting Add Plots under the Command menu,
as explained in the Plots Command Basics section.

5

Detail View
If you only want to change one of the lines you need to
open the Detail view. Here you will see a list of each of
the lines being drawn.

For this set of data, we also want to use smoothed lines,
which we can modify in the Connections drop-down box

10
0
−10

To the right, the Style settings are noted for each line.
When the drop-down menu is set to 'Same', the points
style is the same as indicated in the Main view. You can
override these settings to customize the look of a particular
line
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Click on the Gear Menu the right of the drawing command
to reveal the Color Suggestions.
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When you mouse over the Color Suggestions menu a list
of possible color schemes will be provided. Note that this
list will vary depending on the number of items in your data
set, such that there are more options available when you
have less entries.

Combining the two Plots commands along with a Line
command (x=5), we get the following gure.

10

Selecting the Rainbow color scheme causes the custom
icon to re ect the colors and results in the following
graphic.
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Notice how the left and right sides of the graph do not have
a smooth transition, as each line segment is drawn
individually.
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You can also add a mask to each individual entry
0

2
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8

10

You can also create a custom color scheme using the
'Current Range' option. This works the same way as is
described in the Custom Color Schemes section of the
Variables Chapter
In this example, a stepped line is drawn. The rst entry is
draws all the data using a black line. The second entry is
drawing the same data in red but only where x lies inside
-2 to 2.

Example: Using Masks
The Mask in the Plots command can be applied across all
the data or on individual lines

1

In the following example, the two Plots command for
drawing the multiples lines in the previous example are
combined. Speci cally, we use the command where all the
lines are black to draw the data when x is less then 5.

0
−1
−10

The command with the color scheme has a Mask added to
only draw that section of the data when X is greater than or
equal to 5.
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typically referred to as a bubble chart. When you specify a
column, you get an additional controls which set the
scaling from data units to pixels. You can also specify the
size to be scaled by the area or diameter of the marker

Point
The Points command only draws the points at x,y
locations and does not connect the points like the Plot
command does. The Points command differs from drawing
points using the Plot command in that the Points
command has a lot more control over the markers. For
example, The Plot command draws all of the points using
the same color, ll, type and size while the Points
command allows you to vary all of that based on additional
columns

Points command basics
The simplest way to create a scatter graph is to select the
two columns you want to draw and hit the Points
command shortcut.

Using a Color Schemes
The Color and Fill menus allow you to vary the ll color
and the line color based on a column. This functionality
depends on a color scheme variable to set the color. Once
you have selected a column you get a menu for 'Scheme'.
Here you select the color scheme you want to use. The
last entry allows you to create a new color scheme

You can adjust the marker style using the menu in the top
right corner. Below the marker menu is the drawing style.
There are two possible size elds, the size of the marker
and the size of the line. Note that the solid markers don’t
have a line width, so the line width eld is hidden along
with the color of the line.

The icon on the left of the command is a custom icon that
provides a preview of what the marker will look like. The
size is in points, and by default the marker size is 'point'
and line thickness is 'pen' which are values de ned in the
top entry, the Style settings.

When you select 'Create Color Scheme', a new entry is
added to the variable list. Here you can add matching rules
that are very similar to the mask mechanism. You can also
use the small gear menu to the right of the name to ask
DataGraph to suggest matching rules.

Additional settings
By opening the disclosure triangle on the left corner of the
drawing command you access settings to customize the
look of the markers based on the size, color, ll, and style

You can specify the colors manually, or use the gear menu
again to pick from a prede ned color se

Marker Size
The rst block in the detail settings allows you to change
the marker based on additional columns. You can specify
the size of the marker by using a column, and this is
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You can set up multiple coloring schemes and select
between them by using the color scheme menu in the
Points command. You can use a color scheme for the line
color and ll color

Ba

Using a Color Ramp

There are three commands that can be used to create bar
graphs: the Bar command, the Bars command, and the
Pivot command. Each of these commands take a different
approach to handling data and which command will work
better depends on the type of data you want to graph. In
general, the Bars command has more functionally to
handle multiple data sets while the Bar command can be
used to create bars with varying color and size for a single
data set. The Pivot command is for attened data,
organized in a minimal number of columns, and can
calculate summary statics

Color Ramps can be used to apply a continuous color
scheme to points. Color ramps are created in the Variables
section. Below is a Color Ramp variable named 'Ramp'

Once created, the Color Ramp will be shown as an option
in the Scheme drop-down menu from the Points
command

In the following sub-section, the use of the Bar command
is compared further to the Bars command. For more
detailed information on the Pivot or Bars command, refer
to those sections later in this chapter.

Bar vs. Bars
There are two main bene ts of the Bar command over the
Bars command. One is that you can specify the location of
the bars using a numerical column, such as dates and
non-integer values (e.g., 2.5). The Bar command also
allows you to vary the ll and color of the bars for a single
data set. For example, you can vary the color based on a
separate column by using the Color Scheme ll option

2
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−2

−1

0

1
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3

The Bars command is better for creating side-by-side bars
or stacked bars where the x-axis is a text label. A summary
of the main differences between the two commands is
given in the following table

Using a Marker Scheme
For the marker style you can use a marker scheme that
works similarly, but allows you to put a white circle for
negative, half lled between 0 and 3, and solid above
three

.
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This creates a bar graph using our data but the x-axis is
set to the default row location, or # column.

Bar

Bars

Single data column only

Multiple data columns possible

X Locations are speci ed

X Locations are categories

Not easy to make side by side

Side by side or stacked bars are
simple to create

Start is at X=0, can customize

Start location varies depending
on categories

2

Width of each bar can be
speci ed

Width is the same for all bars

Can vary color by bar

Bars from a single column all
have the same color

1
0
0
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2

3

4

5

6

7

8

Row #

Next, we can change the setting for Where to the ‘Day’
column.

Bar command basics
The Bar command allows you to create a bar graph from
one column of numbers, which is speci ed in the Value
drop-down box. The X-axis location is speci ed using the
Where drop-down box. By default, Where is set to the row
number, or # column

The graph now shows our data according to the numerical
value for ‘Day’.
2
1

To add a Bar command to a graph, select Add Bar from the
command menu
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Day

Note that the example shown here uses all integer values
but they do not need to be. The bars will be centered on
the exact number entered

The following drawing command will be created.

Bar Type
The height of the bars, or y-axis, is speci ed using the
Value drop-down box. The x-axis location is speci ed
using the Where drop-down box. By default, Where is set
to the row number, or # column

The top of the drawing command has a setting for Type.
The Type of bar can be modi ed to change from ‘Bars’ to
‘Stairs’. You can also change the orientation to have the
values displayed on the y-axis

Consider the following data where we have values of a
parameter (i.e., inches of precipitation) that occur
intermittently

This creates a graph where adjacent bars are combined as
shown below

We rst need to change the Value column to ‘Inches’.
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Additional Settings

2

Opening the disclosure triangle reveals additional ways
that you can customize the look of the bar graph. This
includes adding an offset, changing the outline of the bar,
adding a ll, and adding data labels.

1
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Bar Width
By default, the width of the bars is set to the smallest
increment between data points multiplied by 0.9. In other
words, the width of the bars is 90% of the distance
between the closest adjacent points
There are three ways to vary the width of the bars:
1.

Use the toggle bar to the left of the Width drop-down
box. The value in the box represents the fraction of
space between points that the bars occupy. It can
vary from zero to 1.

2.

Specify the value of the width to the right of the Width
drop-down box. If you also set the fraction to 1 the bar
width will be exactly this length.

3.

Set the width of each bar based on a column in the
data table. You can even use one of the same
columns as Value.

Specifying X-axis Labels
If you want to change the x-axis to use labels rather than
displaying numbers, you need to adjust the tick-mark
setting in the Axis settings to ‘Categories’ and select the
Label column there.

Note that in most cases, the Bars command is better
suited for creating a graph with categorical data on the xaxis

Bar Fill
The ll can be adjusted using the Fill With drop-down box
In the following graph, the ‘Inches’ column is used for both
the Value and the Width, which has the effect of adding
emphasis to the larger values

2
1

The ll can be set to a solid color as shown in the following
graph. You can also vary the ll based on the data being
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plotted as discussed more in the following section.
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Our graph now has colors that are varying based on the
value in the column named ‘Data’.

Negative/Positive
The Bar command allows you to use a different solid color
for negative and positive values. Do that by choosing the
ll method ‘Neg/Pos’ within the drawing command.

Note that we also added a drawing command to create a
line at Y=0.

An example is given below using the Bar command with
negative and positive set to different colors.
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Note that for the previous graph, the Include bottom
checkbox was selected, as shown below, to create bars
with lines drawn all the way around them.

Bar
Bar graphs are the standard way to represent categorical
data. The Bars command is speci cally designed to work
with this type of data. Note that DataGraph also includes
the Bar command, which is useful for placing bars on a
numerical x-axis. Please refer to the previous section for a
description of the Bar command and more in-depth
comparison between the Bar and Bars command.

Color Scheme
You can use a separate column to vary the color of the bar.
To do that, select ‘Color Scheme’ as the ll method in the
drawing command. Next, select the column you want to
use as input to the color scheme. Lastly, select a color
scheme variable to map the rows from the information
column to a color.

Bars command basics
You can create a Bars command using the command
menu or using the shortcut in the toolbar across the top

For this example, we are using the following color scheme
variable named ‘Colors’. Please see the Variables chapter
for more information on creating a color scheme, and how
you can use the gear menu and +/- buttons to specify the
entries
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The Bars command looks as follows where the default
Type is an ‘X Standard’ graph.

Another way to add data, is to rst highlight a column or
columns on the column de nition list (far left) and drag
them onto a Bars command (as shown below from left to
right)

The Labels setting is used to designate the axis labels.
Below the Labels drop-down box is a single line where
you designate the data to plot. By default, these are both
set to ‘Nothing’.
To create the bar graph, you could manually use the dropdown boxes to specify the columns of data. You can also
drag a column from the column de nition list (far left) onto
the Bars command to add one or more bars.

You can also select a data entry in the Bars command
(click on the small icon) and hit the delete key to remove or
drag it around to reorder the bars. If a legend is added the
order in the legend will be the same as the order in the
drawing command

A short-cut is to have the columns of data selected before
you click the Bars command icon. For example, consider
the following data table where the ‘Label’ column is a text
column and we have two data sets to plot

Bars Type
The type of bar graph drawn is speci ed in the rst line in
the command using the Type drop-down box. By default,
the type is ‘X standard’, which has the bars drawn side by
side. As demonstrated below, you can also select stacked
and stacked area. You can also orient the bars along the y
axis.

You can highlight all three columns and then click on the
Bars command shortcut. The following drawing command
is created where the Labels drop-down box is set to the
rst column, ‘Label’, and two lines are created below the
Labels drop-down box for each column of data, ‘Category
1’ and ‘Category 2’.

Bars Width
The above command produces the following graph.

The graphical representation can be further tweaked by
using the bar width to the right of the Type drop-down box.
This changes the width for all the bars with the same label

80
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0
2014 Fall

2015 Spring

2015 Fall

2016 Spring

By default, bars with the same label are draw without any
space between them. You can offset bars and add space
between bars using commands located in the detailed view
(See the Additional settings section below). The values for

To add or remove data, you can use +/- button pair next to
each line of data in the drawing command

.
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these settings are in grid units.

The graph below indicates what controls the bar width
versus the Between bars setting

width

between

2

0
A

B

More Fill options
The detail in the settings is partially dependent on the Fill
style selected. As shown below, the ‘Solid’ setting gives
you the option of having 24 separate ll colors. These are
shown to the right of the word Colors, going from right to
left and continuing on the second line. By default, these
colors are set to the six colors in the style sheet repeated
four times

Bars Fill
The ll style is set through the Fill menu. There are four
types of ll styles, and for each style you set the details
further inside the drawing command.

Additional settings
There are additional settings for each data entry that you
can access by opening the disclosure triangle to the left of
the color icon, as shown below for ‘Category 2’. Here you
can specify a column to use for error bars or specify a
label.

You can change the colors by using the color picker or
using the color Presets (see the section on Color in the
Drawing Command Elements chapter).
Note that the Presets to the right of the colors work for up
to 9 data entries for the single-color schemes, up to 11
data entries for the double-color schemes, and up to 12
data entries for ‘Paired’ and ‘Set#3’. Thus, when you have
a large number of data entries, you will see a more limited
number of options in the Presets as shown in the example
below. There are currently no Presets for more then 12
data entries

By opening the disclosure triangle, you reveal additional
settings for the graph. At the bottom, you set the drawing
style for settings that are set for each bar. For example
how error bars are drawn, where the label is drawn in each
bar, etc

If you change the Fill setting to ‘Pattern’ the graph the
settings in the drawing command change to re ect the
options available to you for that setting

The screen shot below show the setting that are now
displayed. We no longer see the Colors settings, instead
we now have the Patterns settings displayed
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This section begins with some very basic examples to
illustrate how pivoting is done in DataGraph; however, note
that the Pivot is a powerful tool for analyzing large sets of
data with categorical information

This ll setting has six unique patterns that are preset. If
you exceed six data entries they will repeat. You can set
both the patterns and the background color separately. For
each data entry, a setting for the background color is just
to the right of the pattern setting.

Pivot Command Basics
You can create a Pivot command using the short cut on
the toolbar or by selecting the Command < Add Pivot in
the menu or using one of the toolbar shortcuts

To illustrate, the settings below show the pattern and
background color for the rst two data entries. By default,
all of the background colors are set to white. In this
example we have changed the background color for the
rst data entry to light blue.

The following command will be created where you can
specify the Rows and Columns in the top line of the
command. In the second line, you specify the Value used
in the table and the Calculation you want to display.

This results in the following graphic

Example 1: One or two columns of data
In this rst example, we are only going to change the
Rows and Value drop-down boxes. Technically, neither of
these will 'pivot' the data but we will be able to easily
calculate summary statistics using the Pivot command

Category 1
Category 2

80
60
40
20

The simplest Pivot command you can create only has one
setting. Speci cally, you can create a graph by setting the
Rows drop-down box to a column in the data table to
count the unique entries in that column.

0
2014 Fall

2015 Spring

2015 Fall

2016 Spring

For example, let us consider the following data where we
have an ‘x’ and ‘y’ column

Pivot
The Pivot command is a powerful tool for displaying and
analyzing data. This command can be used to create bar
graphs, while also binning data according to categories,
number ranges, or dates.
Pivot is short for Pivot Table, and is a standard data
analysis technique (see wikipedia). Pivot requires one to
three input columns. One or two columns are used to
specify categories and an optional column can be used to
specify values.

We are going to set Rows to the ‘x’ column. You can use
the drop-down box to specify it manually or you can
highlight the ‘x’ column in the data table and then hit the
Pivot command short-cut. Either approach will create the
following command.

At its core, this command allows you to group data based
on one or two categories and calculate a number of
summary statistics based on the data (e.g., mean,
standard deviation). These calculated values can be
extracted out of the Pivot command to use in other
drawing commands.
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A bar graph is created showing the count for unique entries
of ‘x’. As illustrated in the graph, the numbers 1 and 2 both
appear in the ‘x’ column 4 times and the number 3 appears
in the column 2 times.
Count of 'x'
4
2
0
1

2

In addition to calculating a sum, a long list of options is
available under the Calculation drop-down box shown
below

3

You can also select to display the results as a percentage
of the total

Next, let’s modify the Pivot command to specify the Value
drop-down box as ‘y’. The Calculation drop-down box is
automatically updated to provide the ‘Sum’.

As a result, our graph now displays the sum of y for each
unique entry in x

One convenient option is to select both a Mean value and
a measure of the deviation around the mean. In this case,
the Pivot command automatically provides the errors bars
around the mean, as shown in the example below

Sum of 'y'
15
10

Mean+SEM of 'y'
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To see the exact data used in the calculation, you can
right-click on any of the bars in the graph itself and choose
Select underlying rows
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3

Example 2: Three columns of data
To explain this further, let’s walk through another basic
example. In the table below, there are two text columns,
‘Category’ and ‘Type’, and one numerical column, ’Value’
In the following example, Select underlying rows was
chosen for the bar where x=1. In the data table, the data is
now highlighted where x=1. Thus, the value of 14 comes
from summing up the values of y where x=1 (i.e., 1+4+6+3
= 14)
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If you select all three columns in the data table and then
click the Pivot command short-cut, the following drawing
command is created with the Rows, Columns, and Value
elds lled automatically. Since the Value drop-down box
is speci ed, the Calculation is set to ‘Sum’.

first
second

B

A

0

The above command creates the following graphic where
each bar represents the sum of the values grouped by
both the ‘Category' and ’Type’. Note we also added a
Legend command.
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Additional settings
You can open the disclosure triangle to reveal the detailed
settings for the Pivot drawing command. Not only does
this give you additional options for modifying the display of
the graph, but you will also see a table view of the data
being graphed. The values are displayed in a small table
inside the drawing command

A
B

8
4
2
0
first

second

By default, the Group bars drop-down box is set to ‘By
Row’. If you change this to ‘By Column’ the data is
displayed differently but the sum for each combination of
‘Category' and ’Type’ is the same. Basically, changing this
command swaps what is displayed on the x-axis with what
is displayed in the legend

Pivoted data

Group of bars
first
second

8
6

For several types of calculations, the value is given across
and down the table as is shown in the previous screen
shot. These include: sum, count, min, max, range, and
missing.
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B

Below the pivoted data, you can vary the Fill, Line,
Labels, etc. Note that the Fill options change depending
on the selection in the Fill drop down box in the same way
as in the Bars command. For more information, see More
Fill Options in the Bars command section of this chapter

The last line of the drawing command main view allows
you easily modify the look of the bar chart. In addition to
the Group bars setting, you can change the Type from
‘Standard’ to ‘Stacked’ or ‘Area’, oriented on the x or yaxis. Just to the right of the Type drop-down box is a
toggle button for adjusting the width of the bars
These settings were adjusted for the previous graph as
shown below.
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Mapping and Grouping Data

it is part of the data.

The detailed view of the Pivot command has two dropdown boxes called Map rows and Map Columns that
allow you to further group and map data. The menu
options for these drop-down boxes vary depending on the
type of data speci ed in the Rows and Columns dropdown boxes. Speci cally, these vary for text columns,
numeric columns and date columns. Each of these is
explained in more detail in the following subsections

Map rows will limit the data to the speci ed entries and
create the following bar graph. Essentially, this is working
similar to a mask, where we are limiting the data in the
graph

21°

20
°C

Text columns

15°

10
0

Below are the options shown in the Map drop-down box
when the data we are pivoting is text. The default setting is
‘All labels’, meaning that all of the data in the pivoted data
is included in the resulting bar graph

−3°
Hawaii

California

Alaska

If we have a long list categories we would like to include
the ‘Speci ed’ option will not work well. For example, say
we are also interested in the New England states. You
could create a column that contains the states of interes
Using the ‘Speci ed’ option you can
1.
2.

Change the order of entrie
Limit or add entrie

In addition, using the Columns option you can
3.
4.

Replace an entry with a labe
Group data based on the new labe
First, change the Map rows to ‘Column(s)’. Next, select
‘StateInclude’ as the column we are using to map our
data.For now leave the last drop-down box as ‘Same’

If you change Map rows/columns to ‘Speci ed’ an entry
bar appears where you can manually enter the data
groups you want displayed. To illustrate how this works
consider a data set with the average annual temperature of
the 50 US states. The rst few rows are shown below

This creates a gure with all of the states listed in
‘StateInclude’. Note the axis settings were modi ed to
angle the x-tick mark labels.

21°

°C

20

Create a Pivot command with the Rows set to ‘State’ and
the Value set to ‘Avg Temp C’. This will create a bar graph
with every state included.
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To group all the New England states together, change the
third drop-down box to the right of Map rows to the ‘Label’
column.
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Next, change Map rows to ‘Speci ed’ and enter the states
of interest, as shown below. Note that spaces are included
in the search so do not put a space between entries unless

.
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Date columns

To calculate the average across all the New England
states, you also have to change the Calculation dropdown box to ‘Mean’. This results in the following graph
where all the New England states are now grouped. Note
how the ‘\n’ in the label for the New England states creates
a line break such that we do not have to angle the tick
marks labels

21°

20
°C

Below are the options shown in the Map rows/columns
drop-down box when the column or row data speci ed in
the Pivot command is a date column

15°
7.7°

10
0

−3°
New
England

Hawaii

California

Alaska

If we decided to remove any of the entries we could delete
them from the either ‘State Include’ or ‘Label’ columns. For
example, if you decide you no longer wanted to include
California you could delete the associated entry in ‘Label’

In this case, you can group the data over time by years,
quarters, months, etc., or you can group the data by a
number representing quarters, months, weeks, and days.
For example, let's consider a temperature data set where
we have the average monthly temperatures over several
decades. For this example, monthly average temperature
data was downloaded for Reykjavik, Iceland from
1931-2000. The data are in two columns, ‘Date’ and
‘Temperature’. The date column is in the format monthyear, as shown below for a subset of the data

This removes California from our graph as shown below.
21°

°C

20
7.7°

10
0

−3°
New
England

Hawaii

Alaska

Numeric columns
Below are the options shown in the Map rows/columns
drop-down box when the column or row data speci ed in
the Pivot command is numeric.

To analyze this data using the Pivot command, create a
new blank graph, highlight the ‘Date’ and ‘Temperature'
columns in the data table, and click the Pivot command
shortcut. The following drawing command will be created.

The default setting is ‘Automatic’. In this setting,
DataGraph will bin the numeric data based on the input. If
you want to change how the data are binned several
options are available. You can also specify numeric values
to include using the ‘Speci ed’ or ‘From Column’ options,
which are similar to those described in the previous section
for text columns.

The default settings produce the following graph where the
rows are being mapped to ‘Years’ Calculation is the ‘Sum’
over each year.
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Average Monthly Temperatures
Reykiavik 1931-2000
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Change Map rows to ‘Months’, such that the data each
month of data will be displayed
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Using the Hover Tool
The Hover tool can be very useful for data exploration,
particularly for complex data sets. Turn on the Hover tool
by typing shift-command-H or via the View menu.

Also, uncheck the Categories checkbox. When this box is
checked, each bar is considered its own category and
every label is shown

Now the x-axis shows the years using tic-marks and the
data is for each month.
Now when you move the cursor over a bar, it will display
the value in the bar as shown below for x=1
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1970
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1990
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Next, change the calculation to the ‘Mean’

Extracting data
You can extract data from the pivoted table to the main
data table. When you click on the gear menu on the top
right corner of the command, you will see a list of options
for what you can extract. You can also right click on the
pivoted data

If you change Map rows to ‘Month #’ you get can average
for each month over the entire data set, where January=1,
February=2, etc.

The extracted columns are dynamic, so when the input
data changes, the pivot columns change automatically.
You can then use these columns as input for any other
drawing commands

To the right of the Map rows dropdown box, there are
built-in text labels for the months. Note you must also recheck the Categories check-box to use these labels.

Example 1: One column of data

These changes result in the following graphic where we
have also added titles to describe our data

Let's consider the example from the beginning of the
section on pivoting where we had one column of data
being counted. The resulting calculations in the Pivot
command are as follows
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•

Extract as Column — reveals a list of individual columns
that can be extracted

To illustrate, we will select Extract all pivot columns.

When you have only one column of data speci ed (as in
this example), you can extract individual numbers using
the gear menu by selecting Extract as Variable, or the
entire column by selecting Extract as Column
The following columns are added to the data table, which
are identical to the pivoted data, shown above

Extract as Variable will create a variable. In this case the
variable '1' was extract which has a value of 4

For comparison, if we selected Extract result as attened
columns we would get the following data where the
column headers are now row identi ers. All the numerical
data is in the 'Flat Value' column

Extract as Column will create a new column variable in
the data table containing all the data
The format you choose to extract data depends on how
you intend to use the data. In general, the attened format
often is more exible as we can continue to sort on either
categorical identi er (Row or Column). You can even use
your extracted data from one Pivot command as an input
to another Pivot command.

Example 2: Three columns of data
Next, let's consider the example where we had three
columns of data being counted. The resulting calculations
in the Pivot command are as follows

There are some cases where it makes more sense to
extract the data as pivot columns or pivot rows. For
example, if your Row label is a numerical value you could
use the result in a Plots command to draw multiple lines
plots (one line for each column). In this case you would
want to use Extract all pivot columns to have the data in
the appropriate format

When you click the gear menu, you get the following
options:

•
•

Extract result as attened columns — extracts every
entry in the table as an individual row
Extract all pivot rows or columns — this also extracts all
the pivoted data, either as shown or the transpose of the
data, and
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Scalar Fiel
A scalar eld is a representation of a 2-D array of numbers,
where color are used to represent the numerical values,
sometimes referred to as a heat map.
The values can be represented using a single, discrete
color over a grid or as a continuous, smoothed surface (i.e,
2D interpolation)

Discrete

If columns x and y are converted to text columns the axes
are formatted as categorical

Smoothed

3

4

5

3

4

5

2

3

4

2

3

4

1

2

3

1

2

3

3

2

1

Scalar eld command basics

1

Select Command > Add Scalar Field to add the scalar
eld command

•

Values — must be numeric ( number or date column)

•

X — can be text, number or date

•

Y — can be text, number or date

2

3

You can combine text and numeric axes. When the entries
are alphanumeric characters, they are sorted
alphabetically

The command has three menu selectors

For example, here the y data is changed a text column
‘Group’.

Here are three input columns, where color in the scalar
eld will be based on ‘Amount’

Although the ‘Amount' column did not change, the resulting
graph is different because the y direction is sorted by the
alphanumeric characters (A,B,C)

C

B

Select the data as shown
A
0.5

.
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1.0

1.5

2.0

2.5

3.0

3.5

The distance between x-y locations can vary resulting in
non-uniform grids. In this example, every x or y value that
was 2, has been changed to 2.5, and 3 in the was changed
to 3.5

This creates a simple scalar eld, where the color of each
square is based on the value of ‘Amount’. Toggle on the
hover (Shift-⌘-H) to view the corresponding value for
each square
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Non-uniform
By setting the Layout = ‘Non-uniform’, the x and y
locations are speci ed in a column but you don’t have to
provide the x and y locations for every row
This setting has two types. By default, Type = ‘Two lists’,
where you must input the unique x and y values
Technically, this setting could be used for Uniform grids
also

This results in a non-uniform grid. In the graph below, the
grid locations are shown by plotting the x and y points with
a Points command.

3

2

Specifying x and y locations with uneven distances
between points will result in non-uniform grids

1
1.0

1.5

2.0

2.5

3.0

Note how the edge of each shaded cell is now the midpoint between the nearest grid locations
By setting Layout = ‘Arrays’, you can draw scalar elds
that are not aligned with the x and y axis. To illustrate, rst
let's look at an example that is aligned.

Layout Menu
By default, Layout menu is set to ‘Flattened’, where the
grid locations are speci ed using an input column for x and
y, as in the prior examples. The values of x and y do not
have to be in any particular order, but the program expects
a rectilinear grid, oriented along x and y
Two other Layout menu options are available that allow
the x and y location to be speci ed via settings the
command, instead of in the data table

8

y

6

Uniform

4

By setting the Layout = ‘Uniform’, you can to specify the
grid locations without entering an x or y column. This
option only works for grid with a uniform step size between
points. Here are the input parameters

2
0
0

Origin — starting x,y location

•

Step — distance between point

•

Size — number of points (x,y

•

Order — starts with row or column (across x or up y
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In this case, x and y are in an ordered list similar to the
attened format, but here the list must be ordered and the
dimensions of the grid have to be speci ed.
In this
example, the grid is (n,n) and where n is a variable =10

•

The color is based on the column d which is calculated as
follows

88
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For example, the following settings would work for a 3 by 3
grid, starting at (1,1)
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The x and y locations can then be mapped to other grid
locations to form other shapes (Conformal mapping). In
this case the values u and v are mapped using x and y

Use your own custom Color Ramp variables and a Color
Ramp Legend to display on the graphic
6

y

4

The resulting scalar eld is still rectilinear, but it is no
longer aligned with the x and y axes
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Re ne
In the Color section, there is a check box called ‘Re ne’

150

z2

100

50

By checking this box, the values will be interpolated
between each grid, resulting in a smooth, continuous
representation of the data

0
−50

0
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50

Color, Grid, and Values
The Scalar Field command also has several built-in color
ramps, the option of showing a grid, and the
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Contour lines can also be drawn. The location of the lines
are speci ed in the command or using a column
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Contours

Each of these overlays can be toggled on and off using
check boxes. Expand each section for formatting options
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The following drawing command is created where the
Values drop-down box is the set to the column 'Cost'.

0
0

1

2
x

3

4

By checking Draw values, the numeric values for each
contour are shown.

4

4

3

3

The drawing canvas now contains the following pie chart
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y

You can add labels to a pie chart using the Display dropdown box
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0
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You also can control the distance between each value on
the contour, the font size, the number format, and the
border around each number

Pi
The Pie command is used to draw a single pie or donut
type of graphic using a single numerical column to control
the size of each slice

The Name drop-down box allows you to specify a
corresponding text label for the data. This label can be
displayed directly on the pie or by adding a Legend
command, as shown below.

Pie command basics
The quickest way to create a pie chart is to rst highlight
the column you would like to graph in the table and click
the Pie command shortcut, which is in the tool bar by
default.
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In the example below, we used the ‘Cost’ column
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Percentages

1.

The Display drop-down box can be used to automatically
shown the % or numerical value for each category

'Axis' - The default option positions the pie relative to
the axis box. The following graph shows the pie in the
center of the axis box (the inner white region)
Anchor = 'Axis'

The percent is computed based on the sum of the values
in the column, and rounded to get the total sum to be
100%. This is slightly different from standard rounding to
the nearest integer
2.

For example, if you have the numbers 2,3,4, the
percentages are 22.22…, 33.33…, and 44.44… If you
round to the nearest integer you get 22%, 33%, 44% which
sums up to 99%. Instead, the DataGraph will round up
the largest fractions until the sum reaches 100%. That
means that 44.44… is rounded up to 45, since 0.44… is
larger than 0.22… and 0.33…
33%

'Figure' - Positions the pie relative to the entire
drawing canvas, de ned by the light grey region.
Below the pie is in the center of the gure
Anchor = 'Figure'

22%
45%

3.

In the detail view of the command, you can adjust the
number of digits after the decimal point via the
Percentages drop-down box. This setting is located at the
bottom of the Pie command

'Coordinate' - Positions the pie based on an x and y
location in the axis box. Below the pie is located at
(0,0)
Anchor = 'Coordinate'
1

0

If you want to use these percentages elsewhere you can
extract them as a column back into the data table using the
gear menu

−1
−1

0

1

When the Anchor is set to 'Axis' or 'Figure', the Position
setting allows you to specify an offset in pixels from either
the center or one of the corners.

Positioning
You can modify the position of the pie by clicking and
dragging it around the canvas. You can also specify the
location using the Anchor and Position settings
The Anchor drop-down box has three options

When the Anchor is set to 'Coordinate', you can specify
the exact x and y location of the Pie. You no longer see a
position drop-down box. Instead, you have a single entry

.
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box to the right of Position where you enter the location as
an (x,y) coordinate pair.

The width changes for each wedge as shown in the
following pie chart

Sizing
The size of the pie is determined based on two entry boxes
in the drawing command. The rst box sets the size of the
inner circle such that a value greater than zero results in
an annulus. The second box is added to the rst to
determine the overall size of the pie.

In this case, the Inner drop-down box is set to 'All the
same' but we could also use a column to vary this length

Adding Emphasis

For example, the following graphic has an inner circle set
to 25 and an outer circle set to 50. Thus, the total size is
75

You can change the offset for an individual wedge to add
emphasis. Set the Offset wedge drop-down box to a
column. In this example, we will use the column
'Emphasis'.

C, 15%
B, 13%

A, 8%
D, 26%

Now the data for 'B' is slightly pulled away from the center
of the chart.
C, 15%

B, 13%

E, 38%

A, 8%

D, 26%

The pie chart is now what is sometimes referred to as a
doughnut chart
E, 38%

Custom Wedges
In the detail view of the Pie command, there are settings to
control the size of the inner circle and the width of each
wedge individually using columns in the data table

We could also animate the movement of 'B' by setting the
value of '20' in the data table to a variable that is varied in
an animation

For example, below we have set the Width drop-down box
to a column, also called ‘Width’

Specifying Colors
In the detail view of the command you can control the
colors the pie chart.

Similar to other commands, you can use the default colors,
change individual color tiles, select new colors using
Presets, or use Color Schemes or Color Ramps.

.
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The pie chart is now the only thing drawn in the window.
C, 15%
B, 13%

A, 8%
D, 26%

Default

Color Scheme

To change to a Color Scheme or Color Ramp, select
'From Column' from the Fill colors drop-down menu

E, 38%

Multiple Pie Charts
You can also create multiple pie charts. The gure below
was created by rst creating multiple pie charts and then
dragging them into position
You can either create a new Color scheme or select an
existing Color scheme or Color ramp
Test 1

Test 2

Test 3

Test 4

Single Pie Chart
If you have a single pie chart, it is located in the center of
the axis box by default
C, 15%

A
B
C
D
E

B, 13%

A, 8%
D, 26%

E, 38%

Note that when you drag a pie chart on the drawing
window, the position automatically updates to indicate the
general location of the graphic. Thus, for each of the pie
charts above, the Position was updated as the charts
were dragging across the screen. The coordinate locations
are relative to speci c corners of the graph (e.g., Bottom
Right, Bottom Left, …). To align the locations, these are all
set to the same x,y values of 60,60.

If you want to only show the single pie chart without the
axis lines there are two steps. First, uncheck the Draw x
and y numbers check box from the axis settings. The box
is still drawn but it will no longer leave space to draw the
axis labels

Second, change the Box style to 'Only Axis'. You can
access the Box style setting in the Style settings or by
right-clicking on the graph.
You could also split the x and y axis and have a single pie
chart in each axis. Taking that approach, you need to set
the Anchor drop-down box back to 'Axis'. Using Split axes,
allows you to easily have individual boxes around each
chart, as shown in the following example
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Test 3

Thus, where the weight is larger, relative to other points,
the error is smaller

A
B
C
D
E

Test 2

Fit Command Basics
At the top of the command you select the x and y columns
and what t function to use including: ‘Linear’, ‘Quadratic’
and ‘Cubic’, which are all are polynomials

Test 4

Selecting ‘Polynomial’ allows you to quickly vary the order
for a polynomial t and to t higher-order polynomials. For
hgh-order polynomials, the coef cients themselves don’t
generally have a lot of meaning or predictive capability, but
the approach can be useful for showing trends. To most
accurately evaluate a high-order polynomial, use the Plot
action column 'Evaluate' option
If you add the Fit drawing command to an empty graph the
X and Y selection are not populated and you would have a
manually select the X and Y columns.

Fi
The Fit command is used to compute functional
relationships between x and y variables in a data set.
This is often also referred to as regression. This command
computes the t, draws it and also gives you access to t
parameters and quality measurements. Even if you
exclude the command, and therefore don’t draw it in the
graph, DataGraph still computes the t and allows you to
use the variables in token elds anywhere in that graph, or
extract it as a variable and use it in other graphs,
expression column or numerical elds

A short-cut is to rst create a Points command using the
data you want to t. Next, click the Fit command. The X
and Y columns will automatically be populated and the
equation for the linear t is shown in the Fit command.

The Graph now includes both the points and the tted line

The t works by minimizing a term of the for

P

f (xi ))2

(yi

500

where f depends on the parameters that you want to
optimize.
Area

400

The exception is the exponential and logarithmic t, where
the routine minimizes

P

200
100

log(f (xi )))2

(log(yi )

1

You can specify a weight column, such that each term is
weighted by the corresponding row in the weight column.
In this case, the term that is minimized is

P
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If you open up the disclosure triangle you will be able to
see summary statistics related to the goodness of the t.
You can use the mouse to move the list up and down

f (xi )))2

(wi (yi

300

DATAGRAPH 5.0
nds the best linear combination of those functions. For
example, if you want a quadratic t that goes through the
origin, you can use the functions x and x^2. For a more
general t, use the Arbitrary t option

Con dence and Prediction Intervals
You can easily add con dence and prediction intervals to a
Linear t. The Bounds option will be shown in the detail
view (see below). Select the type of interval to display
along with the statistical level of signi cance
Each of these values can also be extracted as a variable
using the gear menu, allowing you to use them in an
Expression column. Click on the gear menu in the top
right hand corner of the command. Highlight the Extract
as Variable option and list of the variables you can extract
are shown.
waiting

100
80
60
40
2

3
eruptions

4

5

If you want to show both intervals create two commands
with the same data and specify one as 'Predication' and
one as 'Con dence'.

The command also gives you further options to apply
Weights to particular data points or to specify which data
to include in a t. The Display X range option will allow
you to extend or limit the best t lines to any speci ed
range

When you display either interval, the Fill option will ll-in
the region of the interval. The Fill option is also located in
the detail view of the command

Determining Outliers

Other t types can be selected as shown below.

There is an additional disclosure triangle at the bottom left
hand corner of the Fit command that can be used to test
the impact of outliers. When you open this triangle you see
the following, where the points plotted are the residuals
from the t function versus x.

The Sum options allows you to specify a commaseparated list of functions you want to use. DataGraph
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If you click the Outliers check-box a green line appears
corresponds to 1.5*σ, where σ is the standard deviation of
the residual. The points outside this green line are
considered outliers according to this criteria

neighborhood and uses the value of that t as the function
value. You can adjust the interval width, and select if the
local t is linear or quadratic. The smaller the interval, the
noisier the t function and there might not be enough
points to do a local t.

The t is then recomputed with these points excluded from
the t. To identify the outliers in your data, click the 'Select
Outliers' button in the right corner. Any outliers will then be
highlighted in the Data Table

Restricting data to t
By default all the rows are used to compute a t. Rows that
are invalid or empty are ignored. You can select a sub-set
using two methods or a combination. The rst is the 'Fit X
range' option. The default is ‘Everything’, but if you select
‘Speci ed…' you can type in a range for the x values. This
will restrict the t based on a range along the x axis. You
can also use the mask mechanism. This allows you to
base the selection on other columns

Arbitrary t
The Arbitrary t allows you to specify a function with
unknown parameters and DataGraph computes the
parameters to minimize the difference between the
function and the data. Mathematically, this is called
generalized least squares and allows you to specify a nonlinear function. For example, if you specify the function a/
(b+x), and a and b have not been de ned as variables,
DataGraph nds the constants a and b that give the best
t. If a is de ned as a variable, DataGraph will nd the best
value for the variable b.

Displaying t results
It is easy to display the results of the t function in labels,
legends, etc. In any text entry eld, click the plus symbol to
the right of the eld and select a result from any of the t
functions. This adds a token that is updated automatically
when the t changes.

When you have a linear function, there is a unique
solution, but for non-linear functions you can have multiple
solutions. An iterative process is used to nd the t and
might nd one of the solutions, or not converge at all. To
address both of these issues, DataGraph allows you to
specify an initial guess for each parameter. The default
guess is the number ‘one’, but you can vary this guess by
typing in a new value or by using the pop-up slider.

LOESS t

Extracting residuals

The LOESS t is a non-parametrized t. That means that
the tting function is not an analytical function, but is rather
computed by a lower order t at each data point. Use
Wikipedia to get a more detailed description, but the short
explanation is that at each point on the interval, DataGraph
computes a lower order least squares t in that

If you want to view or plot the residuals, or which rows
were used for the t, click the gear menu on the right side
of the Fit command. Select Extract as Column >
Residual
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To add more x variables, click the plus symbol to the right
of the existing x1 variable. Assume x1, x2, and y are
columns in the data table.

This creates a column entry in the data table

Conducting a t of a linear function
One common application for a multivariable t is a linear
function. For example, if you have experiments where the
input is x1 and x2 and you measure y. A similar linear
relationship can be expressed a

y = f (x1 , x2 ) = C + a1 x1 + a2 x2
In this case, the goal is nd the values for a1, a2, and C
that minimize either the square of the residual

Multivariable Fi

X⇣

In addition to the Fit command described in the previous
section, DataGraph also includes a Multivariable Fit
command. The Fit command uses two columns x and y,
and a function f(x) that has one or more unknown
parameters

f x1 (i), x2 (i), . . . , xn (i)

y(i)

⌘2
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.
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⌘2

Since a multivariable t is not a function of one argument,
it is not possible to draw it completely on an xy graph. The
drawing command computes the optimal set of
parameters, but the representation that is drawn on the
screen shows each data point along with the predicted
value based on the t.
For example, consider a data set that is dependent on x1
and x2. Initially, we will determine a linear regression
based only on x1. We can t this equation using either of
the Fit command or the Multivariable Fit command as

97

s


C + a1 x1 (i) + a2 x2 (i)

Viewing t results

The command has a drop-down box to specify the column
that corresponds to y and to one x variable, x1.

fi

⇣
w(i)2 y(i)

In this case, the best t parameters are C=3.13408, a1=
1.9919 and a2 = 3.2842

By default, the Multivariable Fit is not included as a
shortcut in the tool bar. Thus, to conduct a multivariable t,
you rst create a Multivariable Fit drawing command from
the Command menu

.


⌘2

In the Multivariable Fit command, select y as the top
entry, select the x1 column in the top entry and add a
second entry for x2. The result of the t is shown below the
parameter list

Multivariable Fit command Basics

fi

C + a1 x1 (i) + a2 x2 (i)

or the weighted square

X

The Multivariable Fit is very similar, but instead of just
using a single column x, you can have multiple columns.
That is you have n input columns x1,x2,…,xn and a single
output value y. The function depends on n arguments and
is parametrized with one or more unknown parameters.
Multivariable Fit command minimizes the sum of the
residuals as follow

X⇣

y(i)
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Multivariable Equation
2
R = 0.9867

shown below.

Actual data

40
20

Predicted value
0
−20
−10

−5

0

5

10

x1

In the gure below, the result of the Fit command is drawn
in red. The points are the representation of the t as drawn
by the Multivariable Fit command. By default, the actual
data are drawn as a solid points and the predicted values
are drawn as open points. The line between the actual and
predicted corresponds to the residual. In this case, the
predicted points from the Multivariable Fit command fall
on the same line drawn by the Fit command since they
predicted the same equation

To the right of each parameter listed in the drawing
command, there are little radio buttons indicating which
argument is used for the x axis. We can use these to show
the result with x2 on the x-axis
Multivariable Equation
2
R = 0.9867
40

Single parameter model
2
R = 0.8987

20

Actual data

40

0

20

−20
0

0

1

2

3

4

5

6

7

x2

Predicted value

−20
−10

−5

0

5

Different t functions

10

x1

There are three different t function types that can be
speci ed using the Type dropdown box

The Multivariable Fit can determine the dependency on
multiple variables. To further illustrate, we will now add x2
as a parameter in our t equation.

The previous sections used only the Linear t of the form c
+ a1*x1 + … an*xn. In this case, there are n+1 scalars that
are optimized. The ‘Scale’ does not have the initial
constant, c, so it is of the form a1*x1 + … an*xn. Thus,
function ts using the ‘Scale’ type have an intercept that
goes through zero

Since the data depend on both x1 and x2, the difference
between the actual and predicted values are now much
less. The graph below shows the data with x1 on the xaxis

The Arbitrary setting allows you to specify the exact
function form. Any parameter names in the expression that
are not column names or variables are treated as
optimization parameters. This works similarly to the
‘Arbitrary Fit’ option for the Fit command descried in the
previous section
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which does not draw individual bars but instead just the
tops, and approximates the probability density function.
Use the Along drop-down box to draw the histogram along
the x-axis or y-axis

Functio
This allows you to specify an analytic function and a range
where it should be drawn. The function needs to be a
function of x

The Type menu allows you to select how to draw the
histogram. These options are illustrated below. A very
common method is 'Bars', but 'Stairs' is useful when you
have a large number of bins, and is the default setting for
this reason.

If you use additional variable names they have to speci ed
as variables. But doing that allows you to tie these
variables to sliders and change them interactively

50

Smooth

0
10

Left

0
10

Spaced bars

0
10

Bars

0
10
0
−2.0

DataGraph also includes many built-in functions which are
listed in the Appendix.

Histogram Basics
In the default setting, the histogram command requires a
column of numbers or dates that are speci ed in the
Values drop-down box, determines a bin size, and counts
how many values are in each bin.
The data are represented graphically based on what
histogram Type is selected. The default option is 'Stairs',
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0.5

1.0
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2.0

The histogram command also computes a number of basic
statistics for the list such as median, mean, standard
deviation, etc. These numbers are displayed in a table
inside the drawing command, but can also be used in a
label

The Histogram command is used to analyze statistics for
a list of values. You can create a histogram by rst,
selecting a column of data and second, clicking the short
cut on the toolbar or selecting the Add Histogram in the
Command menu

 


−1.0

The 'Smooth' option adds together Gaussians. You can
adjust the width of the Gaussians using a slider or by
specifying the value exactly.

Histogra

.


−1.5

'Left/Right' will allow you to compare two distributions, one
command will draw the histogram on the left side of each
bin, the other on the right side of each bin.

You can also specify a 'From y(x)' function. This allows you
to ll between two analytic functions

fi

Stairs
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Histogram Units

cumulative density option which is selected to the right of
the units menu.

The Units drop-down box is located in the detail view of
the command. 'Count' means that the y values are how
many numbers are in each bin. 'Density' means the value
is count/bin width and probability means count/(width*total
count). This is best understood if you consider the integral
of the curve. For Density the total integral is the number of
values. For Probability the total integral (area) is one

The Clip check box determines that the line should be
clipped by the distribution shape. This is what the lower
graph does in the gure above. The default line style for
these lines is the same as the line for the distribution, but
you can specify a different line style

Mask
If you want to compute a statistic for a sub-set of the rows
you can use the mask command. For example, let's
consider an example where you have values and genders
(M or F). The data consists of two columns 'Value' and
'Gender' and a number of rows. Select the Gender column
as the mask column and include if it matches the string M.
This only computes the histogram of the corresponding
rows in Values.

Bo
The Box command is used to represent data using nonparametric approaches, which do not make any
assumption about the underlying shape of a distribution of
data
Box plots, also called Box and Whiskers (see wikipedia),
are a way to describe a distribution of numbers, and
provide a graphical way to compare two distributions.

Indicate Percentages
It is possible to draw lines at particular points in the
distribution. For example if you want to draw lines where
the median is, or where you have 10% or 90% of the
values to the left, you can use the Lines at eld. By default
this eld is empty, but you can type in a list of numbers
between 0 and 1.

Box Command Basics
In the simplest case, you specify a single column of
numbers when creating the Box command. To create the
command, select Command > Add Box from the menu
bar or use a tool bar shortcut

Given a column named 'Data' (as shown below) the
following command will be created along with the graph
below.

1
0
100

0
−1.5

−1.0

−0.5

0

0.5

1.0

1.5

For convenience the symbol '%' is de ned as a variable
with the value 0.01. Thus, 50% is the same as 50*0.01 =
0.5. So you can enter either 0.1, 0.5, 0.9 or 10%, 50%,
90%. This works for all histogram types, even the

.
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15
10
5
0.8

1.0

1.2

This makes it easy to create multiple boxes with one
command.

Summary statistics are calculated on the data speci ed in
the Values drop-down box. The box plot shows: the
minima, the maxima, the median, and the rst and third
quartile.

6
4

The Position drop-down box on the main view indicates
the location of the box on the X-axis. When the Position is
set to 'Single value', the number to the right indicates the
numerical location on the X-axis.

2
1

3.

As illustrated in the following examples, the Position
setting is used to specify the location of a single box plot,
or to group data, resulting in multiple box plots
1.

2

3

4

In the third example, the Position drop-down is used
to select a text column that is used to bin the data

If your numeric data is in multiple columns, you can
create multiple Box commands and modify the
Position of each plot.

Data

The Box command groups the data and changes the
numeric labels to text labels on the X-axis.

Data2

40

15
10

20

5
1.0

2.

1.5

0

2.0

Treatment A Treatment B Treatment C

If your numeric data is in one column and you also
have a second column that de nes the bin for the
data, you can create multiple box plots with one single
Box command

Outliers
Outliers are drawn as lled in circles. An outlier is a value
that is larger than 1.5 times the Inner Quartile Range (IQR)
from the median. IQR is the difference between the rst
and third quartile. The whiskers are only drawn to the
smallest/largest non-outlier. Extreme outliers that are 3
times the IQR are drawn as open circles
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Type

Specifying Labels

In addition to the standard box plot, the Box command has
several different types of plots that can be selected from
the Type drop-down box, including:

When Position is set to a column, the Labels drop-down
box menu appears beneath it in the main view of the
drawing command.

•
•
•
•
•
•

Whisker — the default setting

By default, Labels is set to 'All,' indicating that all the data
are plotted and the label on the X-axis is taken from the
Position column (i.e., the column called 'Treatment' in the
above example).

Points — a point cloud of the data
Probability — a probability density function (PDF)
Histogram — a sideways histogram, an

Using the Labels drop-down box, you can change the Xaxis labels without modifying the data. First, set up a
column that contains the bins you want to include. When
you also want to change the labels, create a second
column that speci es the name you want to use

Violin — a violin plot that scales either like a PDF
(Violin PDF) or based on the number data points
(Violin Count). When you have multiple violin plots
drawn with the same command, these two options will
give different results when the number of underlying
data points varies
Smooth — a smooth histogram that can be in either
the x or y direction. The smooth type has four general
options, that are used to specify the direction of the
histogram along the chosen direction. The smooth
options with the '#' symbol will scale histograms based
on the number of data points

Next, set the Labels drop-down box to column that
contains the bins you want to include. To the right, a
second drop-down box will appear that allows you to select
a display name for the X-axis

Here is an example using the 'Smooth' option in two
commands at the same location but one is left and one is
right
By default the display name is 'same' but you can specify a
different column, as shown above. These settings results
in the following graph with only two categories included
(i.e., 'Treatment A' and 'Treatment B')

40
0

0.5

1.0

1.5

2.0

20

0
Test 1

Test 2

Note that you can also change the order the boxes by
changing the order in the column speci ed in the Label
drop-down box.
The direction is speci ed in the expanded view

Setting the Stride
When the Position is set to a numerical column, the Bins
drop-down menu appears beneath. From this menu, you
can set the bin stride to specify how to group the data

.
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The data is assigned to a bin such tha

a  x < a+stride
where a is the minimum for each bin, starting with zero. In
the example below, we have 1000 data points, where the
Position is set to x, which starts at 0, increases by 0.1,
and ends at 99.9

Treatment C
Treatment B
Treatment A
0

10

20

30

40

The options available in the detail view will vary slightly
depending on the Type of graph selected.
By setting the Stride to 10, the raw data is divided up into
10 bins, with 100 points in every bin

For the 'Whisker' type, you can specify displaying your
data in various formats such as 'IQR', 'Min/Max', or
'Percentages'. You can also opt not to show outliers by
unchecking Draw outliers

Raw Data
4
2
0
−2
Binned Data
4
2

Summary Statistics

0

In the detail view of the Box command, a scrollable table is
shown that provides a list of summary statistics

−2
0

20

40

60

80

100

If you have a single box, the statistics will be in a single
column

You can con rm the number of points in each bin in the
detail view.

If you have multiple boxes drawn by a command, each box
is listed as a row in the table

Detail View
In the detail view, you can customize your box plot. You
can vary the Width of the box plot. The Direction dropdown box allows you to position the boxes on the Y-axis.
The Fill with drop-down box has options for solid colors,
patterns, and gradients
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Directly below this table, you can specify additional
percentages that you would like to compute. There is also
a check box that will add a label with the numerical value
of the median to the box plot

The Color Scheme can be used within a single box plot
as shown below
Single point color

8

With Color Scheme
A
B

6
4
2
0
0.5

Click on the gear menu to see a list of summary statistics
that can be extracted into variables or into the data table
as columns

1.0

1.5

0.5

1.0

1.5

You can also use the Color Scheme as way to indicate
categories for individual boxes
8
6
4
2
0
A

B

In the graphs above, the Position and Point Color were
set to the same columns.
Postion and Point Color set to the same Column

Example: Using a Points Cloud with a
Color Scheme
When you set the Type to 'Points', a point cloud is created.
This allows you to overlay the box plot with the underlying
data by combining two commands

Example: Bimodal distribution
The standard box plot does not reveal aspects of data
distributions, as well as, some other types. For example,
bimodal data will be represented more completely using
histograms or violin plots.
You can use a Color Scheme or Color Ramp to change
the color of points based on an additional column

For example, the eruption time of Old faithful Geyser in
Yellow Stone National Park, U.S., is a classic example of a
bimodal set of data. In the following gure, the eruption
time is represented using a box plot, a violin plot, and a
sideways histogram.
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Eruption Time

the intervals [0,1], [2,3], [4,5],... without having to use
multiple range commands

5
minutes

4
3
2
Box

Violin

Histogram

Three Box commands are needed to create this gure,
one for each Type (i.e., 'Whisker', 'Violin', 'Histogram'). The
Position is set to 1, 2 and 3 for each command,
respectively. (Source: Old Faithful dataset, faithful.csv

The Dates option allows you to specify alternating
based on dates

lls

Note that the labels on the X-axis were speci ed in the
Axis settings. (See the Axis section of the Layout
Chapter for more information.)
For full exibility use the Columns option. This allows you
to specify columns for the start and end of each interval.
Each row gives you an interval

Rang
Range can be used to highlight a coordinate region in x
and/or y. It is also possible to use it as a basic building
block.

A slightly advanced use, is to use the clipping action to ll
a portion of a plot. This is done by using two drawing
commands. One draws the plot, the other draws the region
but clips the result with the output of the plot command.
This is done by selecting the command from the 'Clip with'
menu at the bottom of the Range command

In the simplest case you specify a single interval in either
the x or y direction.

You can drag the edges of the interval with the mouse. As
with all numerical elds, you can use variables when
specifying the range. You can specify the range in both x
and y directions, so you can use this to draw rectangles,
and semi- or in-de nite rectangles by specifying one or
both ends to be in nity
There are also other ways to specify intervals using the
menu on the left side. Alternates means that you can color
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The Include in range checkbox determines whether or not
the region should be used when computing the bounding
box for the axis. If you drag the shape out of current axis
range, the extent of the axis will increase when this box is
checked. You can uncheck this to use the Region
command to create a background that extends beyond the
boundary of the axis

Regio
The Region command allows you to highlight a region of
space within a graph. You must specify a region in x and y,
and the shape. Note that you can use variables in the
interval de nition
1.0

Oval with gradient

0.8
Rounded rectangle
with noise

0.6
0.4
0.2

Oval with fill

Rectangle

0
0

0.5

1.0

The Clip with axis range checkbox speci es whether or
not to clip the shape when it does go beyond the boundary
of the axis. If you uncheck this, the drawing command can
be moved outside the axis extent. This allows you to use
the Region command as an annotation tool, or to ensure
that the label is not clipped by the axis

You can resize the region by using the mouse. Click
anywhere inside the region to drag it to a new location
without changing the width or height. If you click on the
boundary you can resize the region. For example, for the
‘Rectangle’ option if you click close to the upper left corner
you change start in x and the end in y

At the bottom of the command is a Label text box where
you can type a label or use the + symbol to the right of the
box to select a token. The Position menu lets you specify
the label location around the shape or in the center

The regions are de ned in the x-y coordinate system so
you can use them to outline points

This example shows the “ellipse” option
1.0

Labe

Group 1
Group 2

The Label command allows you to point out a particular
point on a graph. When you create a new Label command,
it defaults to an arrow that points to the center of the axis
region. You can drag the arrow around the screen, and you
can drag the label and keep the same point

0.5

0
0

0.2

0.4

0.6

0.8

1.0

If you signi cantly change your aspect ratio, the region will
still be represented appropriately in the x-y coordinate
system
1.0

Group 1
Group 2

There are three parts to a label. The rst one is the anchor
point. This is the location that the arrow is pointing. There
are several different places to base an anchor. The default
setting is ‘Inside’, which allows you to specify an x and y
coordinate for the location of the arrow
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You can also control the style of the arrow.
For ‘X axis’, ‘Above’, and ‘Below’, you specify the x value
as a coordinate, but the y as an offset. You can drag the
Inside arrow up to the x axis, but the difference is clear
when you resize the graph or the data changes, since the
‘Inside’ point has a y coordinate and that coordinate might
not work for different data or scaling.
1

Left

Y axis
Inside

0
1

Apart from line thickness and color you can specify the line
style. You can for example hide the line, make a straight
line or angular/curved arrows

Right

Above

x axis

Below

0
0

0.5

1.0

0

0.5

1.0

If you want to point to a particular x location it is better to
use the ‘X axis’ option. Below and X axis are the same if
you don’t have multiple y axes. Y axis, Left and Right are
similar, but there you specify the y value as a coordinate
and the x as an offset in pixels.

You can also adjust the arrow head

You can drag these arrows by using the mouse, but arrows
along the x or y axis are restricted to only move in that
coordinate location, and you need to adjust the offset by
entering in a numerical value or using the pop-up slider
If you don’t want an arrow at all select the top entry for the
line style and the last entry for the arrow style
The next step is the arrow going from the anchor point to
the label point. The size of that arrow is speci ed to the
right of the anchor point. You can change this by dragging
the label. Note that if you use the size (0,0) or select At
Start for the Inside label the arrow is not drawn. This part
will depend on which position you are using. For example,
when you select Below as the position, the coordinate is
now the x coordinate and the y pixel offset and the end
offset are given in pixels

Drag and Snap to a Location
At the bottom of the Label command, are options for Drag
and Snap

By default, the label can be dragged on the graph. Turn off
dragging by unchecking Drag
When dragging, the label will also Snap to locations on
functions or data points (e.g., minima, maxima, intersecting
points).
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Text Command Basics

For example, here P and Q are highlighted using Label
commands at the intersection of the lines. The lines are
drawn using Function commands

By default, the Text command is created with the detail
view open

Distance = 8.721
10
Q

P
5

0
0

5

10

15

20

Type the text you want to display at the bottom of the
command

To freely drag the labels, without snapping, uncheck the
Snap check box

Extract X/Y Location

Add or remove lines by clicking the plus or minus buttons
the right of the text

Extract the value of a label location, x or y, into a variable,
directly from the gear menu in the Label command

You can also add variables by clicking the plus symbol
directly the right. Below, a variable named 'Today' was
added as a Token containing the date.

A variable that contains the label location can also be
created using a Number from command variable, either
on its own or as part of an Expression variable.

Tex

(For more on using tokens, see the Tokens section in the
chapter on Drawing Command Elements.

The Text command is an annotation tool that is similar to
the Label command, but has additional functionality that
allows you to enter and align multiple lines.

In a graph, the order of the items corresponds to the order
in the command. You can click and drag entries to reorder
them

150

A Simple Bar Graph
Created January 8

100
50

When you close the detail view of the command, the text
label will be visible from the main view. You must open the
detail view again to edit
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The Offset setting changes where the text is located
relative to the Anchor. In the previous graph, the Offset in
the x direction is '0.5cm' and the y direction is '0.1cm'.
Thus, the label is always the same distance from the top
left corner even as you resize the graph

Positioning
150

The Where menu speci es the region of the graph the text
is positioned. By default, Where is set to 'Inside', but you
have a lot of options for the placement of the text. You can
also change the orientation to clockwise (CW) or counter
clockwise (CCW)

A Simple Bar Graph
Created January 8

100
50
0
0

2

4

6

The Align block menu allows you to change the
alignment

A Simple Bar Graph
Created January 8
150
100

The Anchor speci es where in the region the text is
placed.

50
0
0

2

4

6

The Text command allows you to insert references to
variables and values inside drawing commands. This for
example allows you to create a table of results, where the
values are pulled from t functions or histograms, even if
those commands are excluded from the graph
Another use of the Text command is to create more
exible titles for graphs. The standard axis title will always
center the label for the x or y axis and rotate the y title. If
you want more exibility, create a Text command and use
that to position the text

In the following graph, the Anchor point is the default
location, such that Where is set to 'Inside', and Anchor is
set to 'Upper Left'. The Anchor location is highlighted with
a red point

150

A Simple Bar Graph
Created January 8
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with various orientations and label directions.

150

A Simple Bar Graph
Created January 8

100

2.0
Horizontal Above

1.5

50

Vertical Right

1.0
0.5

0
0
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Horizontal Below

6

0
0

Bracke

0.2

0.4

0.6

Horizontal From bottom
0.8

1.0

1.2

1.4

1.6

1.8

2.0

The Connector drop-down box allows you to modify how
the middle line is anchored on the graph. The options in
this box vary slightly depending on whether or not the line
is horizontal or vertical.

The Bracket command draws several types of brackets
and a text label. The Bracket consists of two lines, or
arms, with a middle line, or connector, between them. The
text label is located in relation to the connector

The location of the bracket is also controlled by the From
and To variables at the bottom of the command. These are
(x,y) coordinate pairs that de ne the beginning and ending
of the bracket.

When you create a new Bracket command, DataGraph
will create a 'Horizontal' bracket with arms of equal length
and place it near the center of the graph. The label is
placed above the connector

1.0

1.0

Bracket
0.5

Bracket

To

0.5
From
0
0

0.5

1.0

0
0

0.5

1.0

You can also think of the bracket as being a connector
between the two points From and To. If you change the
From or To variables to points outside the current axis
range, the range will be expanded. Thus, the range will
consider From and To but not the text label

Bracket Command Basics
The Bracket can either be located within the graph or in
the margins around the graph. The Where drop-down
menu controls the overall location and the orientation of
the connector.

Brackets outside the Axes
When Where is set to any of the bottom four options (i.e.,
left, right, above, or below), the bracket is located outside
of the axis. These brackets are useful for highlighting a
section of the axis and will always have equal arms
1.0

0.5

Brackets in the Graph

0
0

When Where is set to 'Horizontal' or 'Vertical,' the Bracket
is located within the graph and you can create brackets
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Font

When you place a bracket outside of the axes, The
available settings on the drawing command change.
Speci cally, the available settings include: Range, to set
the distance between the arms; Spacing, to set the length
of the arms; and Offset to set the distance to axis.

The font and color of the label is speci ed at the bottom of
the command

Dragging
The location of a bracket can also be modi ed by
dragging. Dragging works differently depending on
whether your bracket is inside or outside of the axes.

Note that if you change Where back to a previous
selection (e.g., horizontal), your settings for that selection
are recalled. Also, for Brackets outside of the axes range,
the graph will expand to accommodate the label

When the bracket is inside the axes range, clicking near
the middle of the bracket drags the entire bracket. Clicking
near the end points of the bracket will move just that end,
modifying either From or To.

Alternate Styles
You can modify the style of the bracket from the default of
'Square' to 'Curly'

When the bracket is outside of the axes range, you can
click and drag an edge to make the bracket wider or
narrower. In this case, you cannot drag the bracket by
clicking in the middle.
You can also turn off dragging by deselecting Allow
dragging in the detail view

2.0
Curly

1.5

Example: Using Box Plots

1.0
Square
0.5

The Bracket command can be used to indicate the
statistical signi cance between two populations using a
Box plot. The p-value is determined using the t-test
variable, and is shown in the label by using token

0
0

0.5

1.0

1.5

2.0

2.5

3.0

Label location
You can modify the label location from the default of 'Along'
to 'Across' the line

6

Location

P = 0.00105

4

2
2.0

0
Along

Control

1.5
Along

1.0

In this example, the values for From and To use
Variables: Max1, Max2, and Offset. The values for Max1
and Max2 are pulled directed from the data (i.e., Number
from column variables). The Offset is a slider to allow the
y location of the ends of the bracket to be adjusted
simultaneously

Across

Across

0.5
0
0

0.5

1.0

1.5

2.0

2.5

3.0
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come from the clipboard. The ‘Graph’ option is for
specifying a graph in the same DataGraph le

Example: Highlighting an Axis Range
The Bracket command can be used to highlight a region
of the axis. Here the Range command was also used to
create the dashed red lines within the graph

If the clipboard contains a gure the paste option is
enabled int the action drop-down box

If you select this option, the clipboard contents overwrites
the current gure content. Note that if you have a gure in
the clipboard and paste it, DataGraph creates a Graphic
command for it. This menu also allows you copy the
graphic back into the clipboard. This is useful since
DataGraph retains any LinkBack (http://
linkbackproject.org) information so for some applications
such as LaTeXiT you can paste it back into the application
and continue to edit it

Peak Season

Sales

800
600
400
Jan

Mar

May

Jul

Sep

Nov

Jan

If you have a graphic le, you can click on the Pick...
button and select it, or drag the le to the command list to
create a Graphic command for that le. If you drag

Graphi
The Graphic command allows you to add a graphic to the
gure. The graphic can either be pasted into a graph
window, or can come from another graph. Once the graph
is inside the command you can position and scale it. Some
examples of what you can use this command for are

Creating multiple graphs is explained in the next chapter,
but the short version is that a single DataGraph le can
have multiple graphs that use the same data set. The
graphs show up at the top of the le window, and if you
select Graph from the Source menu, you see the same list
of miniatures inside the Graphic command. Click on a
graph to select it. You cannot select the current graph or
any graph that directly or indirectly depends on this graph
since that would cause an in nite recursion

• Add a logo in a corner of a grap
• Add an equation that is done in LaTeXiT or some other
equation editor and pasted in. DataGraph does support
expressions, but doesn’t cover as much as TeX does
• Stack graphs into a gure. Each graph can be done in a
separate graph in DataGraph and remain dynamic, or
just pasted
• Scale bitmaps. Applications like TextEdit don’t have a lot
of control over the output size, and DataGraph can be
used to scale a bitmap to an exact size

The graphic can be positioned relative to different parts of
the graph, just like the Label and Text commands. The
Graph command positions the graphic relative to one of
the corners of the current axis. The Coordinate positions
the graph at a particular x,y location and this means that

As shown in the image below, the Source menu provides
two ways to specify a graphic. The ‘Imported’ option
means that the image needs to be copied from a le or
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the graph is positioned at a particular coordinate in space,
and if you crop the axes it might not be visible.

Extra Axi
By default, graphs in DataGraph contain an x and y axis
with tick marks and ranges that are automatically
generated based on the data selected in the drawing
command.
The Extra Axis command allows you to customize the look
and location of the axis, to add a second axis, or to show
the data in different units without having to modify your
data

Extra Axis Basics

You can also position the graph in the title or along the
axes. For example, if you want a graphical label instead of
a text label. The ‘Figure’ option means that the placement
is relative to the overall gure, and therefore not
dependent on an axis.

You can add an extra axis drawing command using the
Command Menu

The option you pick really should depend on what should
happen as the data changes and you resize the graph.
The second line will change depending on what is selected
in the Where menu.

This will add the following command to your list of drawing
commands, where the axis is added to inside the x-axis by
default.

For example, for the ‘Graph’ option you can pick which
corner the graphic should be anchored to and what the
offset should be. When you pick the x title, you can specify
the x coordinate and the offset in the y direction

For example, let’s say we added an extra axis to a graph
containing a points command. Note how the Type dropdown box is set to 'X axis' and the Position is set to
‘Inside’.

The resulting graph is shown below, where we now have
two x-axis, the default axis and the extra axis.
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You can change the location of the axis using the Position
drop-down box
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units based on the Data and Display settings.
2

6
4

1

Gallons

Litters

8

2
0

Now the extra axis is above the graph.
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You can also use the extra axis to replace the default scale
on the x or y axis. In the Axis commands, you can hide the
default axis by unchecking Draw x/y numbers

10
5
0

Then you can move the extra axis to the desired location
as shown below for the y-axis.

You can move the extra axis to the y-axis by using the
Type drop-down box.

Gallons

2

Unit Conversions
You can also use the extra axis as a way to display your
data in different units. DataGraph contains a large number
of built-in units to allow you to convert between units
symbolically. The full list is included in the appendix

1
0

1

2

3

4

5

You can also set up multiple scales on the same axis using
the position offset. In the example below, both y axis are
set up as an extra axis, then the labels can be easily
added above the axis as discussed further in the next
section

For example, say your data is in liters but you also want to
display it in gallons. First, change the Units drop-down box
to ‘Convert’. Next, enter the symbols for the units of
measure in the Data and Display entry boxes that are now
visible. In Data, enter the units of the data as given in the
data table. In Display, enter the units you would like to
shown in the extra axis.

Gal
2

L
8
6

1

In addition, you can also enter your own values directly
into the Data and Display entry boxes. For example, this
combination shown below would also result in a
conversion from liters to gallons since there are 3.78541
liters per gallon. The axis is be scaled by multiplying by
Data/Display, which in this case is 1 divided by 3.78541.
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Note that the labels for the y-axis are added above the axis
as shown in the last example plot from the last section,
where both y-axes are set up using an extra axis
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1

By opening the disclosure triangle on the left of the
drawing command, you can reveal commands to control
almost every aspect of how the extra axis is displayed.
This includes adding labels, specifying the range, and
changing the location of tic marks.

The extra axis can be placed anywhere on the drawing
window. In the example below, the extra axis is on the right
and the axis labels are automatically updated to show the
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Extra Axis Placement

.


4

DATAGRAPH 5.0

Legen
This is the standard way to give a visual key to label lines,
lls, etc. The legend name is actually speci ed in the
drawing command, typically at the bottom. This name
could be speci ed exactly or depend on the column name
or result of t functions, etc. The legend command then
picks up the names from the command and draws them.

Symbolic Constants
DataGraph includes symbolic constants for converting the
units in the Extra Axis command. Some of the constants
have more than one symbol de ned. For example, gallon
can be understood as ‘gal’, ‘gallon’, or ‘gallons’. If you
enter a symbol that is not de ned a warning is displayed,
listing all of the symbolic constants that have been de ned
You can adjust the drawing style, how many rows to use
and where to position the legend. You can for example put
the legend above the graph or to the right. If you have a
second legend it will draw exactly the same entries unless
you use the From axis menu
The Legend is just like other drawing commands, when
you have a split menu, you select which x and y sub-axis it
belongs to

This menu allows you specify that instead of using the
legend strings from all drawing commands. It only uses the
legend strings from the drawing commands that belong to
the same axis. This way for example you can have a split x
axis and two legends, one for the lines on the left, another
for the lines on the right

You can think of each of these constants as built-in
variables that represent a conversion factor based on SI
units. For example, the value for meters 'm' is one since
meters is the SI unit for length. The value for ‘cm’ is 0.01,
one-one hundredth of the meter. The conversion of the
data is done by multiplying by the ratio of Data/Display to
show the requested units

Custom Legen
A legend can easily by added to any plot using the Legend
drawing command. As discussed in the previous section,
the Legend command uses the information from the
drawing commands to automatically create an appropriate
legend. In cases where the automatically created legend
does not produce the desired effect, you can try using the
Custom Legend command.

Note: DataGraph will not warn you if you pick a
combination of units that don’t make physical sense (i.e.,
converting from volume to mass). The full list of constants
is included in the appendix
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The Custom Legend is created from the Command menu

This will add the following command to your graph but the
legend itself will be blank since you haven’t speci ed the
entries.

The following gure shows the graph and legend based on
this Custom Legend command.
You can nd more
information on setting up color/marker scheme variables in
the Variables chapter
My Title

To add entries to the custom legend you must open the
disclosure triangle on the top left corner to reveal
additional settings.

Level
Low
Middle
High

8
6
4

Data Set
Set 1
Set 2
Set 3

2
0
1

2

3

4

5

To further illustrate, you can produce the same effect by
adding each individual entry to the legend. Below, the
example is given by adding Color three times and simply
specifying the color we want to show alone with the label.

There are six different types of entries that you can add to
the custom legend:
1. Command - entries based on a speci ed drawing
comman
2. Point - a point that you can customiz
3. Color - a color that you can customize

This gives you considerable control over the legend. You
can even also easily change the order of entries by clicking
and dragging them in the drawing command. This is the
order that is used when drawing the legend.

4. Variable - the value for a variable including color
scheme variables
5. Pattern - a pattern that you can customiz
6. Text - a label that you can use as a divider between
entries
You add an entry into the custom legend by clicking one of
the buttons on the Add line. Each time you add an entry, a
line is added that represents that item in the legend. In the
example below, ve entries have been added to the
legend: a Text entry that is set to ‘Level’; a Variable that is
set to the variable ‘Colors’; a Text entry that is set blank to
leave a space; a Text entry that is set to ‘Data Set’; and a
Variable that is set to a marker scheme variable called
‘Markers’

My Title
Level
High
Medium
Low
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Data Set
Set 1
Set 2
Set 3
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Color Ramp Legen

Magnif

The Color Ramp Legend command allows you to display
a color ramp on your gure.

The loupe tool allows you to inspect details of the graph
without changing the axis ranges. The Magnify command
allows you to include that type of view in the output

Any command that allows a color scheme can also use a
color ramp. The color ramp allows you to create a
continuous color scheme, rather than specifying discrete
colors for a given value or range of values
Here a Color ramp called 'Ramp A' was selected for the
Fill color in this Points command

There are two uses for this command. The X/Y range
speci es the range for the insert. If this range includes the
current cropping area, you are not really magnifying the
area in the inset, but displaying a larger area and the
current axis is the detailed.

To display the color ramp on the graph, create a Color
Ramp Legend command and select the color ramp you
want to display from the Source menu

To re ect that, DataGraph shows the current cropping area
in the inset. You can drag this area to change the current
cropping rectangle for the axis (x and y coordinates)

By default, the color ramp will be displayed to the right of
the graph, but you can modify the location using the
Where menu

2
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0

Current axis range
20.5

21.0
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22.0

Axis range from X/Y fields

−2
−1
−2

−1

0

1

2

The more common use is where the X/Y range is inside
the current axis bounds. In both cases the range of the
inset axis is given by the X/Y ranges, but now the box is
drawn in the main axis as well. Lines are used to connect
these areas visually. When you are magnifying a region
(case w) you can change the X/Y ranges using the mouse
by dragging the source rectangle

.
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For example, if you plotted the function sin(x) you would
get the owing graph.

X and Y range (top line) in coordinates

3
2
1

sin(x)
1

0
0

5

10

Offset (pixels)

15

20

25

30

35

0

Width and height (pixels)

−1

You change the position and size of the inset by dragging it
around using the mouse or by adjusting the numerical
elds for size. The size is in pixels, but you can use units
such as in, cm, mm. The anchor is one of the four corners
of the axis, just like the Graphic and Text command.
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−10

−5
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You can easy add x and y axis lines with two Lines
commands. The rst Lines command has the default
settings.
The second Lines command has the Type
changed to "Y Lines".

You can adjust the drawing style inside the drawing
command. For example, you can adjust whether or not you
want to draw the box, connecting line, tick marks, etc.
Most commands have a small magnify
selector in the top right corner of the
detailed view. This selects how the
command interacts with the magnify command. The entry
on the far left, where the destination and source are both
solid blue means that this command is drawn both in the
standard view and magni ed view. The next means that it
is not drawn in the magni ed view, i.e., it is not magni ed.
The one on the right where only the magni ed view is solid
blue means that the command is not drawn unless the
area is magni ed

Now you get the following graph.
sin(x)
1
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You can also type in a comma separated list of numbers in
the eld, for example 0,e,pi. Note that this list can be an
expression such as (0,1,2,3,4)/2, etc. In our example, we
addd two additional 'Y lines' and 'X lines' at every 2pi
increment

Line
The Lines command allows you to draw horizontal or
vertical lines.

Lines Command Basics
When you create the command the default is to draw a
vertical line at x=0, extending the full range of the y axis. If
you switch the type to ‘Y lines’ you get a horizontal line
along the x axis. One example where you might want to
use this is to indicate the location of the x=0 or y=0 when
the axis range includes both positive and negative values

sin(x)
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You can also include variables. For example, if the variable
t is the current time and the value is ‘t’ you get is a vertical
line that changes as you vary the time

This results in the following graph with multiple x-lines and
a label that comes from a column.
1
0
−1

If you want to draw a large number of lines you select a
column instead. In that case, you can also specify the
lower and upper ranges for the lines, either as a constant
or separate column. For example, for x lines you can set x
lines to have a lower value of 0 and upper value to come
from a column ‘y’. This will create a collection of thin bars
that start at (x(i),0) and end at (x(i),y(i))
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Color schemes

Detail View

In the detail view, the Line color drop-down menu can be
set to a color scheme.

In the next example, we will draw two functions and y lines
and customize the Lines command using settings in the
detail view.

If we apply the above color scheme to the graph from the
previous section, we get the following graph.

We speci ed the lines from the following 'y' column using
the Values drop-down menu (where opt-p gives us the
symbol for pi)

1
0
−1
1
0
−1
−15

Note that we split the Y-axis to draw to each line
separately. To have our lines cross both axis, we changed
the Extent of the lines to cross 'All axis'
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The color scheme is set to match the colors based on the
text
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Color schemes can also be based on a text eld. In this
example, we set the color scheme based on the column
called 'Text'.

Lastly, we speci ed the 'y' column to be used as a Label
for each line and we also speci ed the Label color

.
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1
0
−1

We can use these variables 'max' and 'min' as the Values
in two Line commands with the Type set to 'Y Lines'.
Simply type the name of the variables in each of the
Values list.
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See the Variables Chapter for more information on creating
color schemes
Finally, we will also set the legend in the detail of the Lines
commands to use a token. For more on using tokens, see
the Tokens section in the chapter on Drawing Command
Elements.

Example: Using Variables
The location of the lines can also be set using variables
Let's take the Old Faithful data set where we have a
column with the time for a number of eruptions, with a total
of 272 rows entries

Along with a Points command and a Legend command
we get the following graphic, where the values in the
legend are dynamically linked to the data.
eruptions
max = 5.1
min = 1.6

mins

5
4
3
2

We can create variables for the maximum and minimum
value using the Number from column shortcut in the gear
menu of the eruptions entry in the column list

0

100

200

number

Connect Comman
The Connect command is a basic drawing command,
similar to the Lines command. There are three parts to the
graphic that gets produced
1. A starting point (x1,y1) and an ending point (x2,y2
2. A line that connects the points and an optional symbol
at the start and en

We will call these variables max and min, which look as
follows in the variables list

3. A label (also optional
When one or more of the x1,y1,x2,y2 values is given by a
column, you create multiple lines

.
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Connect Basics

Custom Options

When you rst create a Connect command, nothing is
drawn as the starting x1,y1 and x2,x2 pairs are all at 0,0.
You can change any of these values and a line will be
drawn between the points.

Opening the disclosure triangle reveals additional options
such as line style, line color, adding labels, and line type.

You can change these values in order to draw a simple
line. Here we draw a line from (1,1) to (2,2).

Label Options

2.0

The label can be a constant for all lines or speci ed with a
column. For curved and step lines, the label is at the start
of the line, and horizontal. For the straight line there are
other options, namely that the label can be in the middle of
the line and be rotated with the line or horizontal

1.5
1.0
1.0

1.5

2.0

Start

Middle

You can use the drop-down box to specify a column as
input for any of the values. You can also leave some as
constants and use a column for others. For example,
consider the following y1 and y2 values where we want our
lines to show the change between

Middle gap (W

ith Line)

Middle - gap (Horizontal)

Line Types
By default, the line is drawn straight between the x,y
coordinates. The Line type menu gives you a lot of
options for how the points are connected. Choose from
'Steps, 'Curved', or ‘Straight'

The drawing command would be set as follows to use the
data in the columns

Now we have four lines drawn

To the right of the Line type menu other options will be
available that depend on the type chosen. For example,
curved lines have a Style menu for changing the direction
of the curve (i.e., X or Y). Stepped lines have several
options for how the step is oriented. These options are
illustrated below

4
3
2
1
1

2
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Stock
Straight

The Stocks command can be used to visualize stocks
using two different styles, Candlestick and OHLC (open
high, low close). For more information on Candlestick
charts see https://en.wikipedia.org/wiki/Candlestick_chart

Up Side Half Height
X direction
Half Side
Side Up

Y direction

Copy and paste the data, or import from a le. A typical
data set will have columns similar to the following example.

Specifying end caps
There are several ways to draw the end caps. Each is
listed below and demonstrated in the following gure
When the Date and Volume are not understood as
numerical columns, these can be converted using the
gear menu. Since the data is in one of the standard date
formats, DataGraph will suggest the right format for the
conversion.

1. None — Straight line, with sharp ends
2. Flat — End caps at the beginning and end,
perpendicular to the line. Useful when you are
indicating length
3. Arrow — An arrowhead at the (x2,y2) point
4. Arrows — Arrowheads at both the start and the end
5. Round — Rounded edge, this is only visible once the
line width is a few pixels

Although the Volume is technically not needed for the
Candlestick graph, you may want to use this in another
graph. To convert Volume to a numerical value is a little bit
trickier since 'M' is used to denote the volume in millions.
You can convert this to a numerical column, but it will not
be understood immediately because of the M. You can
use nd and replace to either remove the M or replace it
with *10^6 or *1E6. One option is to de ne 'M' as a
variable as 10^6.
This works
because DataGraph
interprets 26.64M as 26.64*M

None
Flat
Arrow
Arrows
Round

Once the data is converted, create a Stocks command
using the Command menu. Select the columns from the
table as shown below.

Using Color Schemes
The example graph shown below uses the Connect
command to create vertical lines where the color and
location of the arrows is determined by the direction of the
data. This requires the use of a Color Scheme variable,
as described in the Variables Chapter

Below is an example using the Candlestick option.
120
115
110
105

Negative/Positive

22

29

6

5
0

13
20
Dec - 2015
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You can also choose the OHLC option.
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.
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For the Candlestick, you can change the ll colors. By
default the width of the marker is one day. If the Date
column is a date column, this is the proper width, but if the
Date column is a list of days (e.g., 1,2,3,…) the width will
be much to wide, since Day is 24*3600 seconds. In that
case switch the marker width to either speci ed
(coordinate) or pixels (graphical).

fi

fi
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click/control-click) to copy the gure. You can also copy a
particular drawing element from the graph

Exporting dat
In addition to exporting data graphically as a gure or a
movie, DataGraph can also export the values from the
data table. Copying data from the table is the simplest way
to get data from DataGraph for use in other program;
however, this assumes that the external program accepts
data through the clipboard and that the data is not too
large. Some programs might not handle a few tens of
megabytes of data through the clipboard. For that purpose,
you can use the Export Data menu entry in the File menu
The Export Data method will export only the data
displayed in the data table. If you select speci c rows or
columns, only the selected data is exported. In each case,
the column headers are included in the rst row

Export to a le

To begin the export, select Export Data from the File
menu. You can export the data as text, either tab delimited
or comma separated. You can also export the data as an
Excel document (xlsx). Any notes you have in your
DataGraph le will be placed in a separate Note sheet in
Excel

You can export the graph using multiple formats.

In the File, menu you can export the graph as a le.

Data is exported in the background, so you can work on
other DataGraph documents in the meantime. A progress
bar will show the status of the export; however, this
operation is typically very fast, so unless your data set is a
few hundred megabytes or saved on a slow disk, you will
not see a progress bar.

Exporting gures

The rst section of output formats are all vector graphics
(PDF, EPS, SVG, DTG). The second section of output
formats are bitmap or pixel based formats (PNG, TIFF,
JPG)

Copy
In the edit menu you can select from three copy options.
The top option copies the gure as a pdf and bitmap,
allowing the program you paste into to pick the preferred
format. Programs such as KeyNote will use the pdf
version

For bitmaps you can also specify the resolution. The
default (screen resolution) is 72dpi. Note that the EPS le
format does not support semi-transparent objects. What
DataGraph does is to automatically replace the transparent
color by an opaque one that will show up the same based
on a white background. PDF does support transparent lls,
but if you are printing on laser printers, they will typically
draw that region using a low resolution bitmap so quality
will suffer. PDF does not however support semitransparent gradients, and DataGraph automatically
adjusts the gradient colors so that they will look the same

You can also copy the gure as bitmap only, with or without
transparency. You can also use the context menu (right

.
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on a white background. This is done since otherwise the
EPS/PDF le that gets generated cannot be opened.
The SVG format is a vector graphics format that is
intended for web pages, and is an xml le. The limitation
here is that you cannot use an external gure (using the
Graphic command) or a textured ll since that is
implemented with a bitmap. DTG is a graphic le that is
unique to DataGraph and DataTank. This format keeps all
of the information, since it is just a le version of the
graphic that DataGraph uses internally. The main use of
this option is if you want to save a graphic that you intend
to include in a different DataGraph le

Movie
You can set up animations in DataGraph to create MP4
les. This is done through the animation variable is called
't'. You can change the name of the variable and used in
any numerical eld such as cropping regions, line
thicknesses, masking rules, etc.

The bitmaps don’t have any of these limitations, but for
high resolutions they will take a lot more disk space than
the vector graphic version. PNG and TIFF can be semitransparent, which is typically called an alpha channel.
Note that even though Mac applications tend to all handle
alpha channels properly, some applications do not

The variable is a slider, so you can set the range and if it is
restricted to be an integer. Then you set the duration in
seconds and can click the small play button to animate the
variable on screen. Once you have set up an animation
that you like, click the small Film button circled or use the
File menu

Exporting multiple graphs
The standard Export graph menu only exports the
selected graph. If you name and ag the graphs you can
then export all of them at the same time by using the
'Export Flagged Graphs...' option.

This will open the movie interface. You can create movies
in retina format. Click the "Create MP4" button, to create
the movie le. While this is running you can continue to
use DataGraph.

This brings up a dialog box to ask you for the folder where
the images should be saved

Sharing Figures
You can easily share graphics via Mail or several social
media wed sites. These options are available under the
File > Share Graph. First you must have the graph you
would like to share as the selected graph. Also, you must
already have an account con gured on sites such as
Twitter for this to work. These are con gured in your
overall System preferences under Internet accounts
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Appendi
Function Referenc
The following built-in functions are available in DataGraph
Name

Description

sin

sin in radians

cos

cos in radians

tan

tan(x) = sin(x)/cos(x) in radians

asin

inverse of sin(x)

acos

inverse of cos(x)

atan

inverse of tan(x)

angle

angle(x,y) = the angle that the line (0,0) to (x,y) makes with the positive x axis. The angle is in radians.
That means that angle(cos(x),sin(x)) = x for x from -π,π. angle(-1,0) is π. This is better than using the
inverse of tan because it will deal with the sign properly.

sinh

hyperbolic sin, sinh(x) = (exp(x)-exp(-x))/2

cosh

hyperbolic cos, cosh(x) = (exp(x)+exp(-x))/2

tanh

hyberbolic tan, tanh(x) = sinh(x)/cosh(x)

sqrt

square root of a number

cbrt

cube root of a number

gamma

the Gamma function, https://en.wikipedia.org/wiki/Gamma_function

loggamma

loggamma(x) = log(gamma(x)), needed because the gamma function increases rapidly

exp

exponent of a number, exp(x) = e^x.

log

natural logarithm, the inverse of exp(x)

log1p

log1p(x) = log(1+x)

log10

base 10 logarithm, inverse of 10^x

log2

base 2 logarithm, inverse of 2^x

erf

Error function, integral of exp(-t^2) from 0 to in nity, scaled so that the asymptotes at +/- ∞ are +/- 1.
https://en.wikipedia.org/wiki/Error_function

erfc

Complementary error function erfc(x) = 1.0-erf(x). So erfc(x) is very close to 0 if x is large, and is more
accurate than using 1.0-erf(x).

abs

absolute value of a number. abs(x) = x if x is positive, abs(x) = -x if x is negative.

.
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Name

Description

oor

oor(x) is the largest integer value less than or equal to x.
oor(4.5) = 4
oor(-4.5) = -5;

ceil

ceil(x) is the smallest integer value greater than or equal to x.
ceil(4.5) = 5
ceil(-4.5) = -4;

round

Rounds to the a speci ed value. The decimal is the second input argument. If no decimal is speci ed, the
number is rounded to an integer. Half points are rounded away from zero.
round(4.532) = 5 or round(-4.532) = -5; round(4.532, 1) = 4.5 or round(4.532, 2) = 4.53.

fact

Factorial of the number. Returns NAN if the argument is not an integer. Note that fact(n) = gamma(n+1),
so far large values you can compute log(fact(n)) by using loggamma(n+1). So if you want to compute n!/
( (n-k)! * k!) when n is too large, you can use exp( loggamma(n+1) - loggamma(n-k+1) - loggamma(k+1))

min

minimum of two or more arguments. So min(3,5,1) = 1

max

maximum of two or more arguments, so max(3,5) = 5, max(3,5,1) = 5

norm

norm of a vector, norm(3,5) = sqrt(3^2 + 5^2), norm(3,5,1) = sqrt(3^2 + 5^2 + 1^2)

signswitch

Takes three or four arguments. For three arguments signswitch(a,b,c) is b if a<0 and c otherwise. For
four arguments, signswitch(a,b,c,d) is b if a is negative, c if a is zero and d if a is positive. Use to create a
piecewise de ned function.

if

if(a,b,c) where it returns b if a is non-zero and c if a is zero. Example: if(x<3,valueIfTrue,valueIfFalse)

isnan

(a) where it returns 1 when a is NaN, where 0 when a is nite.

is nite

is nte(a) where it returns 1 when a is nite (number), where 0 when a is NaN.

mod

Remainder after division. mod(9,4) = 1 because 9 = 4*2 + 1. Works also for fractions, mod(9.2,0.5) = 0.2,
because 9.2 = n*0.5 + 0.2 where n is 18.

j0

One of the Bessel functions - https://en.wikipedia.org/wiki/Bessel_function. j0(x) = Bessel function of the
rst kind of order 0 of x.

j1

Bessel function of the rst kind of order 1.

jn

jn(n,x) = Bessel function of the rst kind of order n of x.

y0

Bessel function of the second kind of order 0 of x.

y1

Bessel function of the second kind of order 1 of x.

yn

yn(n,x) = Bessel function of the second kind of order n of x.

sinc

sinc(x) = sin(x)/x when x≠0, and 1 when x==0.

rect

rect(x) = 1 if (|x|<0.5, 0.5 if x=+/- 0.5 and 0 if |x|>0.5

tri

tri(x) = 0 if |x|>1, tri(x) = 1-|x| if |x|≤1.

H

H(x) = 0 if x<0, H(0) = 0.5, H(x) = 1 if x>0

sgn

sgn(x) is the sign of x. sgn(x) = -1 if x<0, sgn(0) = 0, and sgn(x) = 1 if x>0.

ternaryX

ternaryX(a,b,c) = x location for a ternary diagram centered at 0,0

ternaryY

ternaryY(a,b,c) = y location for a ternary diagram centered at 0,0

fi

fi

fi

fi

fi
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Name

Description

seconds

Related to dates. This function has a variable number of arguments and converts a calendar date to
seconds since Jan 1st 1970. This is sometimes called POSIX time (https://en.wikipedia.org/wiki/
Unix_time) and is used internally by DataGraph for dates.
For midnight at the start of a given day, the form is: seconds(year,month,day)
For a speci c time, you can use: seconds(year,month,day,hour,minute)
or seconds(year,month,day,hour,minute,seconds).
NOTE: hour is from 0 to 24 (24 means the next day).

year

The argument is a POSIX time, and what is returned is the year for that date

month

The argument is a POSIX time, and what is returned is the month for that date

day

The argument is a POSIX time, and what is returned is the day for that date

dayofweek

The argument is a POSIX time. Returns 1 for a Monday, 7 for Sunday

dayofyear

The argument is a POSIX time, and what is returned is the day in that year, with Jan 1st equal to 1.

week

The input is a POSIX time Week number - see https://en.wikipedia.org/wiki/ISO_week_date

weekyear

Input is a POSIX time. Computes the year for the week, to match with the week(x) functionality.

hour

Input is a POSIX time, returns the hour

minute

Input is a POSIX time, returns the minute

second

Input is a POSIX time, returns the second. Same as mod(x,60)

isAM

Input is a POSIX time, returns 1 if the hour is <12, 0 otherwise.

isPM

Input is a POSIX time, returns 1 if the hour is ≥12, 0 otherwise.

The standard operators such as +,-,*,/ are all de ned as well as the following operators
Syntax

Meaning

a^b

a raised to the power of b

a == b

1 if a is equal to b, 0 otherwise

a != b

1 if a is not equal to b

a<b

1 if a is strictly less than a

a <= b
a≤b

1 if a is less than or equal to b

a>b

1 if a is strictly greater than b

a >= b
a≥b

1 if a is greater than or equal to b

a && b

1 if a and b are non zero

a || b

1 if a or b are non zero

.
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De ned Constant
These constants are used in the unit conversion in the Extra Axis command. For more information, see the Extra Axis/
Symbolic Constants section of the Drawing Commands Chapter
key

value

Description

A

1

Current

acre, acres

4046.8564224

Area

atm

101325

Pressure (standard atmosphere)

Å,å

1E-10

Length

at

98066.5

Pressure (technical atmosphere)

bar, bars

1E+05

Pressure

barye

0.1

Pressure
1 barye = 0.1 Pa = 1 g·cm−1s−2

biot,biots

3.33564E-10

Electromagnetic (cgs units)

BTU

1054.615

Work, British thermal unit

C, coulomb, coulombs

1

SI unit of electric charge, A*sec

centimeter, centimeters, centimetre

0.01

Length

cfs

0.028316846592

cubic feet per second

cm

0.01

centimeter

cuft

0.028316846592

cubic feet

cuin

1.6387064E-05

cubic inches

cukm

1E+09

cubic kilometers

cum

1

cubic meters

cumiles

4168181825.44058

Volume, cubic miles

cuyd

0.764554857984

volume, cubic yards

cwt

45.359237

hundredweight

day, days

86400

in seconds

deg, degree, degrees

0.0174532925199433

Angle in radians

dyn,dyne

1E-05

cgs unit of force
1 dyne = 1 g·cm/s2

erg

1E-07

cgs unit of wor
1 erg = 1 dyne cm = 1 g·cm2/s2

feet, ft, foot

0.3048

Length

2.957353E-05

Volume

fm

1E-15

femtometer

furlong

201.168

Length

g, gr, gram, grams

0.001

Mass

oz

.
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key

value

Description

gal, gallon, gallons

0.003785411784

Volume

G, gauss

0.0001

Gauss, strength of magnetic eld

grain, grains

6.479891E-05

Mass

h, hr, hour, hours

3600

in seconds

H

1

henry, SI unit of electrical inductance

hectare, hectares

10000

area

hp

745.6998715822702

Horsepower

imperialgallon, imperialgallons

0.00454609

Volume

in,inch,inches

0.0254

Length

J

1

Joule

kayser, kaysers

100

wavenumber, formerly called the kayser

kg, kilo, kilos, kilogram, kilograms

1

Mass

mph

0.2777777…

Length/Time

kip,kips

4448.2216

Imperial unit of force

km

1000

Length, kilometers

kN

1000

kiloNewtons

knot,knots

0.514434666…

Length/Time

kPa

1000

kiloPascals

kW

1000

kiloWatt

L, l, liter, liters, litre

0.001

Volume

lb,lbs

0.45359237

Weight

league, leagues

4828.032

Length

mach,Mach

340.4014189333333

Length/Time

mA, ms, mV, mW, mΩ

0.001

1/thousand of an SI unit

maxwell

1E-07

derived CGS unit of magnetic ux

m, meters, meter, metre

1

Length, meter

mg

1E-06

milligram

mi,mile,miles

1609.344

Length

min, minute, minutes

60

Time

ml

1E-06

Volume

mm

0.001

Length, millimeter

MMBtu, mmBTU

1054615000

One million British Thermal Units (BTU)

mmHg

133.322

Pressure

N_A

6.02214085774E+23

Avogadro’s Number

fl
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key

value

Description

MPa

10^6

Pressure

mph

0.44704

speed

nA,nm,ns,nV,nΩ

1E-09

1/billionth of SI unit

N

1

Newtons

Oe, oersted

79.577

Auxiliary magnetic eld H in the CGS units

oz

0.0283493

Weight

Pa

1

Pressure, SI unit, Pascal

pdl

0.138255

Force, English units, poundal

pt, pint, pints

0.0004731

Volume

pm, pV, pΩ

1E-12

pico conversion

poise

0.1

dynamic viscosity cgs units

pound,pounds

0.4535888

Weight

psi

6894.76

Pressure

quart

0.000946352946

Volume

s, sec, second, seconds

1

Time

sqft

0.09290304

Area, square feet

sqkm

10^6

Area, square kilometers

sqm

1

Area, square meters

sqmile, sqmiles

2589988.110336

Area, square miles

sqyd

0.836127

Area, square yards

statC, statcoulomb, esu, Fr

3.33564E-10

cgs, electrostatic unit of charge

statH

898800000000

unit of inductance in cgs

statV, statvolt,, statvolts

299.792458

Unit of electromotive force (EMF) or potential difference in cgs

stone,stones

6.3502432

Weight, English units

T

1

Tesla, strength of magnetic eld

torr

133.322

pressure

uk oz

2.8413E-05

UK Fluid Ounces

ukgal, ukgals, ukgallon

0.00454608

UK Gallon

ukpint, ukpints, ukpt

0.00056826

UK Pint

ukquart

0.001136

UK quart

V

1

Volt, derived SI unit for electric potential

W

1

Watt

Wb,weber

1

SI unit of magnetic ux

week, weeks

604800

time

fi
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key

value

Description

yard,yards,yd

0.9144

Length

º

0.0174532925199433

1 degree in radians

µA,µg,µm,µs,µV,µW,µΩ

1E-06

micro conversion

Ω

1

Electrical resistance, Ohm

X	
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same arguments. It will not open any windows, and it
doesn't matter if you already have a copy of DataGraph
running. When it is nished this instance of DataGraph
quits

Command Lin
DataGraph works with a command line utility called dgraph
that allows you to generate graphs. This is intended for
automation and shell scripts and assumes some
knowledge of unix commands and working in the terminal

For The Mac App Store version
The Mac App store version is pretty much identical to the
version downloaded from the web site, except that the Mac
App store version is running in a sandbox (google Mac OS
Sandbox for more detail). This means that access to the
le system is severely restricted and is limited to les and
folders that you either drag in or open directly. Because
the command line utility refers to les by path names this
leads to a problem. But starting in DataGraph 4.4 there is
a workaround

If you are using the Mac App store version you need to
download dgraph separately, since it cannot be included in
the application. To download it, use the following
command
curl https://www.visualdatatools.com/DataGraph/dgraph -o dgrap

If you are using the version downloaded from the Visual
Data Tools web site, you can use the above command or
just get to it inside the DataGraph application wrapper. Go
to the DataGraph.app/Contents/Library/ subfolder

If you go into the Preferences panel in DataGraph there is
a way to explicitly add read or read/write access to
particular directories or les. This has to be done once and
is then saved in the preferences. You can pick what folders
you give access to. The non Mac App Store version has
access to every le you can navigate to in the Finder, and
you can of course do that here as well. But a more
common approach would be to allow access to a more
limited portion of your home directory.

If you run the dgraph utility that is inside the application
wrapper, it will launch that application. If the dgraph utility
is outside the application wrapper it assumes that the
DataGraph application is inside the /Applications folder

Running dgraph
There are three crucial parts to the argument list. The rst
is the DataGraph le that you want to use as a template.
The second is the data le that you want to import into the
table. The third is the output that you want to create
dgraph action.dgraph file.txt out.pd
Note that typically one or more of those les will have full
path names, so the argument list will be a lot longer.
What this does is to open action.dgraph and then overwrite
the table with le.txt. This is done non-graphically, but what
happens is exactly the same as if you select all of the
visible columns in the table and then import le.txt. The
output graph is saved in out.pdf. Only the current gure
(the one selected when you saved the DataGraph le) is
saved
You can overwrite variables, change sizes, etc by using
command line arguments. To get further explanation, use
the -help ag
dgraph -hel

How dgraph works
What happens when you use the dgraph application is that
the underlying DataGraph application is launched with the

.
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